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IMPORTANT: Do not become distracted from driving safely if operating a motor vehicle while using Device Soft-
ware.

Operating certain parts of this Device requires user attention. Diverting attention away from the road while driv-
ing can possibly cause an accident or other serious consequences. Even occasional, short diversions of attention 
can be dangerous if your attention is diverted away from your driving task at a critical time. Do not change sys-
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General Operation
Voice Command Control: Many of the functions of the Device Software can be accomplished using only voice 
commands. Using voice commands while driving allows you to initiate the command with a button and then 
operate the Device mostly without removing your hands from the wheel.

Prolonged Views of Screen: If you are driving, do not access any function requiring a prolonged view of the 
screen. Pull over in a safe and legal manner before attempting to access a function of the system requiring pro-
longed attention. Even occasional short scans to the screen may be hazardous if your attention has been diverted 
away from your driving task at a critical time.

Volume Setting: Do not raise the volume excessively. Keep the volume at a level where you can still hear outside 
traffic and emergency signals while driving. Driving while unable to hear these sounds could cause an accident.

Let Your Judgment Prevail: The Device Software is only an aid. Make your driving decisions based on your 
observations of local conditions and existing traffic regulations. The Device Software is not a substitute for your 
personal judgment. 

Use of Speech Recognition Functions: Speech recognition software is inherently a statistical process which is 
subject to errors. It is your responsibility to monitor the speech recognition functions and address any errors.
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Welcome to Sprint

Sprint and Nextel have come together, offering you more choice and flexibility to do 
whatever you want, whenever you want.

This powerful combination brings you access to more products, more services, 
and more of what you need to do more of what you want. Welcome to a future 
full of possibility. Welcome to the new Sprint.

Welcome and thank you for choosing Sprint.
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How to Use This Guide

We know you’re eager to start using your device right away, and the sections of 
this guide are designed to help you do just that.

Section 1: Setting Up Your Smart Device and Your Computer guides you through the 
process of setting up your new Treo™ 700wx smart device, your Sprint PCS 
Service, and your computer. 

� Section 2: Your Treo™ 700wx Smart Device shows you the basics of your device and 
service with quick, easy-to-follow instructions. This section also describes the 
features of your device’s phone and shows you how to use Sprint PCS service 
features such as voicemail and call waiting.

� Section 3: Using Sprint PCS Vision and Other Wireless Connections shows you how 
to use Web browsing, messaging, and email. It also describes other types of 
wireless connections such as Bluetooth® wireless technology.

� Section 4: Your Portable Media Device shows you how to use your device’s camera 
and how to transfer and listen to music files on your device.

� Section 5: Your Mobile Organizer guides you through the process of using the 
built-in, full-featured, organizer that gives you instant access to your Contacts, 
Calendar, Tasks, Memos, Calculator, and more.

� Section 6: Managing Your Information and Settings describes the tools for 
managing files and applications and the preferences that enable you to 
customize your device.



iii

� Section 7: Resources answers frequently asked questions and shows you what to 
do if something goes wrong. It also includes a helpful glossary of terms.

� Section 8: Safety and Specifications outlines recommended safety 
and maintenance guidelines and displays the technical specifications for your 
Treo700wx smart device.

WARNING: Please refer to “Important Safety Information” on page 361 to learn 
about information that will help you safely use your phone. Failure to 
read and follow the Important Safety Information in this phone guide 
may result in serious bodily injury, death, or property damage.
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and Your Computer
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Sec tion 1A

Setting Up Your Treo™ 700wx Smart Device

In This Section

� What You Need

� Your New Treo 700wx Smart Device

� Inserting the Battery

� Charging the Battery
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What You Need

Your Treo™ 700wx smart device box contains the following:

Hardware
� Treo device.

� Rechargeable battery.

� AC charger.

� USB sync cable.

� Stereo headset.

� Sprint® charger adapter.

Documentation
� Read This First setup poster.

� Welcome to Sprint pamphlet.

� Getting Started Guide.

� Setting Up Email on Your Sprint Mobile Broadband Smart Device Treo™ 700wx 
booklet. 

� Terms & Conditions.

� Warranty.

� Software License Agreement.

� Audible insert.
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Software
� Getting Started CD (includes desktop synchronization software and bonus 

software for your device)

You’ll also need the following items to complete the installation and activation:

� An activated Sprint PCS service plan

� A location with wireless coverage for your device

� An electrical outlet

� The computer with which you will synchronize your personal information
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Your New Treo 700wx Smart Device

Your Device’s Features: Front View

1. Indicator Light (phone 
and charge indicator) 3. 5-way Navigator

6. Power/End Button

8. Start Button

9. Phone/Talk Button

10. Side Button

5. OK Button

11. Volume Button

4. Left Softkey

4. Right Softkey

7. Center Button

2. Earpiece
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1. Indicator Light provides status information for your device based on the 
color of the light and the blink state.

2. Earpiece serves as the speaker on your device when you are not using the 
speakerphone feature or a headset.

3. 5-way Navigator gives you one-handed access to moving around the device 
screen and selecting options. See “Moving Around the Screen” on page 40 
for instructions.

4. Right and Left Softkeys give you quick access to tasks that you can do on the 
current screen. 

5. OK Button accepts the information you entered on a screen and returns to 
the previous screen.

6. Power/End Button turns the device’s phone on and off, wakes up and turns 
off the screen, and hangs up calls.

7. Center Button selects an option or menu item. After highlighting an item 
with the 5-way, you can select or activate it by pressing Center .

8. Start Button opens the Start menu to access all the applications on your 
smart device. 

9. Phone/Talk Button opens the Phone application, dials when a phone 
number is selected or entered, and answers an incoming phone call.

10. Side Button launches the Windows Media Player application by default. You 
can also reassign this button to open your favorite application.

11. Volume Button adjusts the earpiece, speaker, and ringer volume levels.
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Your Device’s Features: Back View

12. Camera Lens enables you to take pictures using the built-in camera (if 
included). There are two models of the Treo700wx smart device: One comes 
with a camera and the other does not. The packaging for your device 
identifies whether a camera is included.

13. Self-Portrait Mirror enables you to take a picture of yourself (if your device 
includes a camera).

14. Battery Door Release opens the battery compartment.

12. Camera Lens 
(camera
 version 
only)

14. Battery Door 
Release

16. Multi-connector

18. Speaker

13. Self-Portrait 
Mirror

15. Headset 
Jack

17. Microphone
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15. Headset Jack enables you to connect a hands-free headset. Use only 
headsets that are compatible with your device.

16. Multi-connector enables you to attach the USB sync cable and AC charger to 
your device. You can connect the charger either to the sync cable connector 
or directly to the charger jack on the Multi-connector.

17. Microphone serves as the mouthpiece on your device’s phone.

18. Speaker plays ringtones and alarms, and serves as the speaker for the 
speakerphone feature.

Note: The Treo700wx smart device speaker includes a large magnet, so be sure to 
keep your device away from credit cards or other items that could become 
demagnetized.
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Your Device’s Features: Top View

19. Ringer Switch controls the ringer setting. The ringer switch silences all 
sounds, including music, when you need quiet. There is no need to navigate 
menus. See “System Sound Settings” on page 278 for details on changing 
the settings.

20. Infrared (IR) Port uses infrared technology to transmit information to and 
receive information from other infrared-enabled devices that use 
compatible software.

21. Antenna receives and sends wireless communication signals. The antenna 
does not telescope out of your device.

22. Expansion Card Slot allows you to expand the capabilities of your device 
using a MultiMediaCard, SD, or SDIO card. 

23. Stylus allows you to tap options on your device’s screen. To use the stylus, 
slide it out of the slot and hold it as you would a pen or pencil.

21. Antenna

23. Stylus 22. Expansion Card Slot

20. Infrared (IR) Port19. Ringer Switch
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Inserting the Battery

1. Use one hand to press the Battery Door Release, and use your other hand to 
slide the battery door downward to remove it from your device.

2. Align the battery contacts with the battery compartment contacts. 

WARNING: Use only Palm-approved or manufacturer-approved batteries and 
chargers with your device. The failure to use a Palm-approved or 
manufacturer-approved battery and charger may increase the risk that 
your device will overheat, catch fire, or explode, resulting in serious bodily 
injury, death, or property damage.

Reset Button

Battery 
Contacts

Battery 
Compartment
Contacts

Battery Door Release
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3. Insert the battery into the compartment at a 45-degree angle, and then 
press it into place.

4. Slide the battery door onto the back of the smart device until it clicks into 
place. Your smart device screen turns on and the Treo screen appears. 
Wait for the progress bar on the Treo screen to fill and the Windows Mobile® 
screen to appear.

5. Follow the onscreen instructions to finish the installation.

Note: If your smart device does not turn on after you insert the battery, you 
need to charge it by connecting it to the AC charger. If it still doesn’t start, 
do a soft reset. See “Resetting Your Smart Device” on page 320

Tip: Buy an extra battery as a spare for long trips or heavy data use. Visit 
www.palm.com to purchase batteries that are approved by Sprint and 
that are compatible with your device.

http://www.palm.com
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Charging the Battery

The battery comes with a sufficient charge to complete the setup process and 
activate your phone. After activation, we recommend charging your smartphone 
for 3.5 hours (or until the indicator light is solid green) to give it a full charge. See 
“Maximizing Battery Life” on page 15 for tips on maximizing the life of your 
device’s battery. 

1. Plug the AC charger into a wall outlet. 

2. Connect the charger cable to the charger jack on the bottom of the device. 
Make sure the arrow on the connector is facing up, toward your Treo device 
screen. 

3. To confirm that your device is charging, check the indicator light. 

� Solid red indicates that your device is charging.
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� Solid green indicates that your device is fully charged. 

If the indicator light does not turn on when you connect your smart device to the 
AC charger, double-check the cable connection and the electrical outlet to which 
it is connected.

 

The onscreen battery icon displays the power status:

� Solid lightning bolt : Battery is connected to a wall outlet and is charging.

� Shaded lightning bolt : Battery is connected to a wall outlet and is fully 

charged.

Tip: If the battery is fully drained, it may take a few moments for the indicator 
light to turn on while charging.

Indicator 
Light
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� Partial battery icon : A partial battery without a lightning bolt indicates 

that the battery is not connected to a wall outlet and it has some power.

� Exclamation point : Battery needs to be charged immediately.

Battery Life

Battery consumption varies based on personal usage. Consumption factors 
include signal strength, speakerphone usage, and the type of calls you make 
(data or voice).

Maximizing Battery Life

You can increase your smart device’s battery life by following a few easy 
guidelines. Remember that battery life depends on how you use your smart 
device.

� Charge your smart device whenever you’re at your desk, or charge 
it overnight each day. The battery in your smart device has a much longer 
useful life when it is topped off frequently, versus charging it after it is fully 
drained.

� If you spend a lot of time using the camera (if included), games, media 
players, eBooks, or other applications, keep an eye on the battery icon and 
charge when necessary.

� Your smart device’s wireless features (phone, email, messaging, Web, and 
any applications that use a Sprint PCS Vision® connection) generally consume 
more power than the organizer features. If you don’t plan to use the wireless 

Tip: Tapping  the battery icon opens a window showing a percentage level of 
charge left in the battery.
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features on your smart device for a while, turn off your wireless services (see 
“Turning Wireless Services On/Off” on page 302). You can forward calls to a 
different number or let all calls be picked up by voicemail (see “Forwarding 
Calls” on page 76). To see if your wireless services are on, tap the Phone-off 

icon , and then select Wireless Manager.

� Turn off your smart device’s Bluetooth® wireless technology feature when you 
do not need to make a Bluetooth connection.

� As with any wireless phone, if you are in an area with no wireless coverage, 
your smart device searches for a signal, which consumes power. If you cannot 
move to an area of better coverage, temporarily turn off your phone (see 
“Turning Your Phone On and Off” on page 18). 

� Turn down the screen brightness (see “Adjusting the Brightness” on 
page 281).

� Set your screen to turn off automatically after a shorter period of inactivity 
(see “Viewing and Optimizing Power Settings” on page 300). 

� Keep your battery away from direct sunlight and other sources of heat. 
Temperatures over 120 degrees Farenheit (50 degrees Celsius) can 
permanently reduce the capacity and life span of any lithium-ion battery.

� If you are using Direct Push technology (MSFP) for email, set your device to 
sync every 30 minutes or more. Email synchronization can quickly consume 
battery power. 
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Sec t ion 1B

Setting Up Service

In This Section

� Turning Your Smart Device On/Off

� Making Your First Call

� Setting Up Your Voicemail

� Creating Sprint PCS Account Passwords

Setting up service on your new Treo™ 700wx smart device is quick and easy. This 
section walks you through the necessary steps to unlock your device, set up your 
voicemail, establish passwords, and contact Sprint for assistance with your 
Sprint PCS service. 
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Turning Your Smart Device On/Off

The phone and the screen of your Treo XXX smart device can be turned off and on 
separately. This means you can wake up the screen to use just the organizer 
features of your device without turning on the phone. Also, when the screen is 
turned off, the phone can be on and ready for you to receive and make calls.

Turning Your Phone On and Off

When you turn on your phone, it connects to a wireless network so that you can 
make and receive phone calls and use other wireless services.

1. If you are not on a call and your screen is off, briefly press Power/End  to 
wake up the screen.

2. Press Center  on the 5-way to turn off Keyguard.

3. Press and hold Power/End  to turn on your phone. (When your smart 

device locates a signal, “Sprint” and the signal-strength icon  appear at 
the top of the screen, indicating that you can use the phone and Internet 
features, if supported by the local network.)

4. Press and hold Power/End  again to turn off your phone. (When your 

phone is off, “Phone Off” and the phone-off icon  appear at the top of the 

Note: Throughout this guide the term device is used to describe your Treo smart 
device and its physical aspects. The term phone is used to describe the 
feature of your smart device that enables you to connect to the Nationwide 
Sprint PCS Network.
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screen. Your smart device is not connected to any wireless network, but you 
can still use the organizer and other features.)

If Sound Mode is on, you hear a series of tones when you turn your phone on and 
off. For more information on Sound Mode see “Setting the Ringer Switch” on 
page 278.

Waking Up the Screen and Turning It Off

Wake up the screen and leave the phone turned off when you want to use only 
the organizer features of your smart device, for example, when you’re on a plane 
and want to look at your calendar. You can also turn off your smart device’s 
screen without turning off your smart device’s wireless features.

1. Press Power/End  to wake up the screen, and then press Center  to 
turn off Keyguard.

2. Briefly press Power/End  to turn off the screen.

Did You 
Know?

If you’re outside a coverage area, the indicator light flashes amber and 
the signal-strength icon is not displayed.

Tip: You can set how long the screen stays on during a period of inactivity. 
Press Start, select Settings, select the System tab, and then select Power. 
Select the Advanced tab, and then adjust the On battery power setting.



20 Section 1B: Setting Up Service

Making Your First Call

If you received your device in the mail or purchased it at a Sprint Store, it probably 
has already been activated. If your phone is not activated, please call Sprint at 1-
888-211-4PCS (4727).

The battery comes with a sufficient charge to complete the setup process and 
activate your Treo700wx smart device. After activation, we recommend charging 
your smartphone for 3.5 hours (or until the indicator light is solid green) to give it 
a full charge.

1. Turn on your phone (see “Turning Your Phone On 
and Off” on page 18).

2. If you do not see your Today screen, press 

Phone/Talk .

3. Enter your four-digit lock code. (For security 
purposes, the code is not visible as you type.)

4. If you have not activated your phone, follow these steps to do so:

� Use the number pad on the keyboard to enter *2 (these numbers appear 
on the letter keys).

Note: If you can’t recall your lock code, try using the last four digits of either your 
Social Security number or  wireless phone number, or try 0000. If none of these 
works, call  Sprint Customer Service at 1-888-211-4PCS (4727). See “Where to 
Learn More” on page 55 for other ways to get help from Sprint if you are 
having trouble with your service.
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� Press Phone/Talk  to dial.

� Follow the voice prompts to activate your phone. (A service provisioning 
message appears.) 

� Wait a few minutes until you see the Programming Successful! 
message, and then press Dismiss  (left softkey).

5. Use the number pad on the keyboard to enter 
the number you want to call. 

6. Press Phone/Talk  to dial.

7. When your call is complete, press Power/End  
to end the call.

Adjusting Call Volume

While a call is in progress, press the Volume button on the side of your smart 
device to adjust call volume.
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What’s My Number?
1. Make sure your phone is on (see “Turning Your 

Phone On and Off” on page 18). 

2. If you do not see your Today screen, press 

Phone/Talk .

3. Press Menu  (right softkey).

4. Select Preferences > Phone Settings.

5. On the Phone tab, look for your phone number 
below the title bar.

6. Press OK .

Volume Button

Look Here for Your 
Phone Number
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Tip: If your phone number doesn’t appear on the Phone Settings screen, press 
OK, and then turn your phone off and back on again. Repeat steps 2–6. If 
your phone number still doesn’t appear, your phone has not been 
activated. Turn your phone off, wait a few hours, and then repeat these 
steps. If your phone number still does not appear, please contact Sprint 
for assistance.
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Setting Up Your Voicemail

All unanswered calls to your device’s phone are automatically transferred to your 
voicemail, even if your phone is in use or turned off. 

To set up your voicemail:

1. Go to your Today screen.

2. Press and hold 1 on the keyboard to dial
Sprint’s voicemail system.

3. Follow the voice prompts to:

� Create your password. 

� Record your name announcement. 

� Record your greeting. 

� Choose whether to activate Skip Pass Code (a feature that lets you 
access your voicemail simply by pressing and holding 1, bypassing the 
need for you to enter your password). (If you do not activate Skip Pass 
Code, your device uses the Voicemail Pass Code feature, which requires 
you to enter your password each time you want to access your 
voicemail.)

For more information about using your voicemail, see “Using Voicemail” on 
page 69.

Note: If you are concerned about unauthorized access to your voicemail account, we 
recommend that you use the Voicemail Pass Code feature.



Section 1B: Setting Up Service 25

Settin
g U

p Service

Creating Sprint PCS Account Passwords

As a Sprint PCS customer, you enjoy unlimited access to your personal account 
information, your voicemail account, and your Sprint PCS Vision® account. To 
ensure that no one else has access to your information, you will need to create 
passwords to protect your privacy.

Account Password

If you are the account owner, you’ll have an account password to sign on to 
www.sprint.com and to use when calling Sprint Customer Service. Your default 
account password is the last four digits of your Social Security number. If you are not 
the account owner (if someone else pays for your Sprint PCS service), you can get 
a sub-account password at www.sprint.com.

Voicemail Password

You’ll create your voicemail password when you set up your voicemail. See 
“Setting Up Your Voicemail” on page 24.

Sprint PCS Vision or Sprint Power Vision Password

With your Treo700wx smart device, you may elect to set up a Sprint PCS Vision or 
Sprint Power Vision password. This optional password can be used to authorize 
the purchase of Premium Services content and to protect personal information 
on multi-phone accounts.

For more information or to change your passwords, sign on to www.sprint.com or 
call Sprint Customer Service at 1-888-211-4PCS (4727).

http://www.sprint.com
http://www.sprint.com
http://www.sprint.com
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Sect ion 1C

Synchronizing Information—The Basics 

In This Section

� Synchronization Methods

� Installing the Desktop Synchronization Software

� Connecting Your Treo Device to Your Computer (USB)

� Synchronizing With a USB Connection

� Synchronizing With Third-Party Applications

You can enter or change information on your smart device or in Microsoft Office 
Outlook on your computer, and then synchronize to update the information in 
both places; there’s no need to enter the information twice. You can also 
wirelessly synchronize the email, contacts, and other information on your smart 
device with a Microsoft Exchange Server.

We strongly recommend that you synchronize your smart device and your 
computer frequently to keep your information up-to-date (and backed up) in 
both locations.
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Synchronization Methods

Use the ActiveSync software to synchronize your smart device with a computer or 
with a corporate server.

Synchronizing Your Device With a Computer

To synchronize the information between your Treo700wx smart device and your 
computer, install the ActiveSync desktop software and connect your device to 
your computer using one of the following methods:

� Connect using a USB sync cable: When you connect 
your device to your computer using the sync 
cable, synchronization begins automatically. (See 
“Connecting Your Treo Device to Your Computer 
(USB)” on page 33 and “Synchronizing With a USB 
Connection” on page 35.)

� Connect using Bluetooth wireless technology: You 
must first set up the Bluetooth connection. (See 
“Synchronizing Over a Bluetooth Connection” on 
page 165.)

� Connect using an Infrared (IR) technology: You must first set up your computer 
to receive infrared beams. (See “Synchronizing Over an Infrared Connection” 
on page 169.)

Note: Even if you have already installed a previous version of the ActiveSync 
software, you must install the software that came with your smart 
device on the Getting Started CD. See “Installing the Desktop 
Synchronization Software” on page 31 for instructions.
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Synchronizing Your Device With a Microsoft Exchange Server

You can synchronize the email, contacts, and other information on your smart 
device with a Microsoft Exchange Server using ActiveSync.

� Enter the server details in the ActiveSync application on your device. (See 
“Setting Up an Exchange Server Account” on page 141.)

� Once the server information is entered on your device, your information 
synchronizes with an Exchange Server based on your sync schedule. (See 
“Setting a Sync Schedule With an Exchange Server” on page 144).

� By default, your smart device wirelessly synchronizes with the Exchange 
Server over the Sprint PCS Network when you press Sync in the ActiveSync 
application. You can also synchronize your smart device with the Exchange 
Server when the device is connected to your computer using a USB, IR, or 
Bluetooth connection. (When a server source is configured, your device 
synchronizes with the server using the connection you choose.)

Note: Even if you already installed a previous version of the ActiveSync 
software, you must install the software that came with your smart 
device on the Getting Started CD. See “Installing the Desktop 
Synchronization Software” on page 31 for instructions.

Tip: Your device also includes GoodLink, an application that provides more 
options for synchronizing your smart device with a corporate server. See 
“Using GoodLink™ Wireless Messaging” on page 135 for more 
information.
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What Information is Synchronized by Default?

By default, the information in the following applications is updated each time 
you synchronize:

 

Changing the Synchronization Settings

To change the information and applications that are synchronized, see “Setting 
Synchronization Options” on page 262. That section also includes information on 
the following subjects:

� Selecting Which Information to Sync.

� Synchronizing With Exchange Server.

� Synchronizing With Two Computers.

� Starting and Stopping Synchronization.

� Setting the Synchronization Schedule.
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Installing the Desktop Synchronization Software

Before you synchronize your smart device with your computer or with an 
Exchange Server, you must install the ActiveSync® desktop synchronization 
software. The ActiveSync software is already installed on your device.

System Requirements

Your computer should meet the following minimum system requirements:

� Windows 2000 or XP (later versions may also be supported).

� 32MB of available memory (RAM).

� 170MB of free hard disk space.

� CD drive.

� Available USB port.

� USB sync cable (included with your Treo700wx smart device).

Windows Media Player Requirements

Before you install the desktop synchronization software on the Getting Started 
CD, you must have Windows Media Player 10 or later installed on your computer. 
This ensures that the media synchronization will work properly.

If you are installing the software on a computer at work, make sure your 
company allows you to install new software. Contact your company’s IT 
department for help.
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Installing the Desktop Synchronization Software
1. Close any applications that are currently running on your computer, 

including those running in the background. (Your computer needs to have 
all its resources available to install the software.)

2. Insert the Getting Started CD into the CD drive on your computer.

3. Follow the onscreen instructions during the installation. (The Install 
program prompts you to synchronize for the first time.)

Tip: Need additional help installing the desktop software? See “Trouble 
Installing the Desktop Software?” on page 319.
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Connecting Your Treo Device to Your Computer (USB)

This section includes instructions for connecting your smart device and your 
computer using a USB sync cable. 

1. Plug the AC charger into a wall outlet. If necessary, connect an 
adapter.

2. Plug the USB sync cable into an available USB port or into a powered USB 
hub on your computer.

USB Sync 
Cable

This Button Has No 
Function With Your 
Treo 700wx Smart 
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3. With the USB cable on the left, connect the sync cable to the bottom of your 
smart device.

4. Connect the charger cable to the connector on the sync cable.

Tip: For best performance, plug your sync cable directly into a USB port on 
your computer. If your computer has USB ports on both the front and 
back, we suggest using the back port. If you use a USB hub, make sure it is 
a powered hub.

Note: If you’re switching from a previous Windows Mobile® device or from a 
Palm OS® device, you can learn more about how to move content, such as 
pictures, music, and files, to your device by going http://www.palm.com/
us/support/treo700wxsprint.

http://www.palm.com/us/support/treo700wxsprint
http://www.palm.com/us/support/treo700wxsprint.
http://www.palm.com/us/support/treo700wxsprint.


Section 1C: Synchronizing Information—The Basics 35

Syn
ch

ron
izin

g B
asics

Synchronizing With a USB Connection 

1. Install the ActiveSync desktop synchronization software as described in 
“Installing the Desktop Synchronization Software” on page 31.

2. Connect your smart device to your 
computer. (You should hear the 
ActiveSync® tone.)

3. Look for the ActiveSync icon  at the top 
of your smart device’s screen and the 

ActiveSync icon  in the taskbar on your 
computer.

� If you don’t see the ActiveSync icon, 
make sure the desktop 
synchronization software that came 
with your smart device is running on 
your computer. 

� If you have any problems synchronizing, see “Synchronization 
(ActiveSync® Software)” on page 334 for troubleshooting suggestions.

Tip: We recommend that you install a backup and restore application. A 
backup and restore application preserves your data and settings if your 
smart device is ever lost or stolen, and it protects your data during a hard 
reset. See http://www.palm.com/us/support/downloads/spritebackup/
index.html for more information. 

This Button Has No 
Function With Your 
Treo 700wx Smart 

http://www.palm.com/us/support/downloads/spritebackup/index.html
http://www.palm.com/us/support/downloads/spritebackup/index.html
http://www.palm.com/us/support/downloads/spritebackup/index.html
http://www.palm.com/us/support/downloads/spritebackup/index.html
http://www.palm.com/us/support/downloads/spritebackup/index.html
http://www.palm.com/us/support/downloads/spritebackup/index.html
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Synchronizing With Third-Party Applications

If you want to synchronize with a personal information manager (PIM) other 
than Microsoft Office Outlook, you must install a third-party solution. Contact 
the PIM’s author or vendor to learn if software is available for your Treo device.
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Sec tion 2A

Learning the Basics of Your Smart Device

In This Section

� Moving Around the Screen

� Using the Keyboard

� Opening and Closing Applications

� Using Your Today Screen

� Where to Learn More
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Moving Around the Screen

To move around the Treo700wx smart device screen, you can use the 5-way 
navigator or you can tap items on the screen with the stylus. As you become 
familiar with your smart device, you’ll find your own favorite way to scroll, 
highlight, and select items.

The 5-way includes the Right , Left , Up , Down , and Center  buttons.

Tip: Some third-party applications may not work with the 5-way navigator, 
and you must use the stylus instead.

Tip: The arrow icons that indicate directions on the 5-way are different from 
the onscreen scroll arrows and the arrows that indicate a list is available 
(see “Selecting Options in a List” on page 46). 

Up

RightLeft

Down

Center
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Scrolling Through Screens

As on a computer, on your smart device you scroll to move from field to field or 
page to page, or in some cases to highlight an item or option in a list. There are 
several methods of scrolling:

� Press the 5-way on the front of your smart device. (Press Right , Left , 
Up , or Down  to move to the next field, button, or action in that 
direction.)

� Press and hold Option  while pressing Up  or Down  to scroll one screen 
at a time. (These keys work just like the Page Up and Page Down keys on your 
computer keyboard.)

� Press and hold Option  while pressing Left  or Right  to jump to the top or 
bottom of the current screen.

� When viewing a screen with tabs, such as 
when adding a contact, press Down  to 

scroll to the tabs, and then press Left  or 

Right  to move between tabs.

� When inside a text field, press Right  or 

Left  to move to the next character, and 
press Up  or Down  to move between 
lines. 

� When inside a list, press and hold Up  or 
Down  to rapidly scroll through the list.

� Tap an onscreen scroll arrow.

Scroll Arrows

Scroll Arrows
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� Tap and drag the slider of an onscreen scroll bar.

Closing Screens

To accept the information you entered on a screen and to return to the previous 
screen, do one of the following:

� Press OK .

� Use the stylus to tap  or  in the upper-right corner of the screen.

Highlighting and Selecting Items

On most screens, one item—a button, a list entry, or a check box—is highlighted 
by default. The highlight identifies which item is affected by your next action. 
Use the 5-way to move the highlight from one item to another before opening or 
selecting it. 

The highlight can take one of two forms, depending on what is highlighted:

� Border glow: This rectangular border highlights items 
such as an onscreen button (OK, Dismiss, or Hide), a 
check box, an option, or a Web link. 

Note: When you close a screen, the application still runs in memory. See 
“Viewing Memory Usage” on page 299 for instructions to view the 
amount of memory in use versus the available memory. See “The 
Applications Are Running Slower Than Usual” on page 325 for 
instructions to close applications and free up memory.
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� Reverse type (light text on a dark background): 
This highlights items such as a phone 
number, an email address, text, or an item 
in a list.

After highlighting an item with the 5-way, you can select or activate it by pressing 
Center  or by tapping the item with the stylus. 

Highlighting Text

You can use the stylus to highlight text on the screen:

� Tap and drag the stylus across the text you want to highlight. To highlight a 
word, double-tap it. (To highlight a paragraph, triple-tap it.)

Using the Softkeys

The left and right softkeys give you quick access to tasks that you can do on the 
current screen, so the softkey items vary from application to application and from 
screen to screen. Look on the screen directly above the softkey to see the action 
that it does in the current context. In some contexts, these keys may do nothing 
at all. In most cases the right softkey  opens the menu, and the left softkey 

 activates a specific command, such as New or Edit. Remember that softkey 

Tip: The best way to learn to use the 5-way is to experiment. Press the 5-way 
buttons and as you do, follow the movement of the border glow around 
the screen. The behavior of the 5-way varies slightly in each application.

Tip: When text is highlighted, you can press Backspace to delete the 
highlighted text.
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functions vary from screen to screen, so be sure to check the onscreen label 
before pressing the softkeys. 

Selecting Menu Items

In many applications, a menu provides access to additional features. The menu is 
hidden until you press Menu  (right softkey). To get the most out of your 
smart device, it’s a good idea to familiarize yourself with the additional features 
available through the menu in various applications.

Did You
Know?

You can use keyboard shortcuts to select most menu items. To quickly 
access a menu item, press Menu followed by the underlined letter in the 
menu item’s name. 

Left Softkey Right Softkey

Left Softkey Activates 
This Command

Right Softkey Activates 
This Command
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1. Press Menu  (right softkey) to display an 
application’s menu.

2. Press Up  or Down  to highlight a menu item.

3. If an arrow appears next to a menu item, press 

Center  or Right  to display additional 
options for that item, and then press Up  or 
Down  to highlight a menu item. (To return to 
the main menu without making a selection, 

press Left .)

4. Press Center  to select the menu item, or press Left  or Menu  
(right softkey) to close the menu and cancel your selection.

Selecting Options in a Shortcut Menu

Most applications also provide access to context-sensitive, shortcut menus—
similar to the right-click menus on a computer. The shortcut menu options vary 
based on the highlighted selection.

1. Highlight the item you want to open 
the shortcut menu for.

2. Press and hold Center  to open the shortcut 
menu.

3. Press Up  or Down  to highlight a menu 
item.

4. Press Center  to select the menu item or 

press Left  to cancel your selection.
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Selecting Options in a List

Lists let you select from a range of options. You can identify whether a list is 
available when you select the field. If a rectangle appears around the field along 
with a downward-pointing arrow, a list is available. 

Lists are different from the menus described earlier in 
this section. 

To select from a list, do any of the following:

� Use the 5-way to highlight the field, and then 
press Center  to display the items in the list. 
Press Up  or Down  to highlight the item you 
want, and then press Center  to make your 
selection.

� Use your stylus to tap the arrow, and then tap 
the item in the list.

� In fields where you see a downward-pointing 
arrow but no rectangle, you must tap the arrow 
with the stylus to expand the field.

� To exit the list and cancel your selection, press 
Left .

Tip: When selecting fields you might not see the downward-pointing arrow 
until you press Center on the 5-way. 
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Using the Keyboard

When using the keyboard, most people find it easiest to hold the smart device 
with two hands and to use the tips of both thumbs to press the keys.

Understanding the Keyboard Backlight

Your smart device includes a keyboard backlight for low light conditions. The 
keyboard backlight activates automatically when the screen turns on. The 
backlight turns off automatically when the screen turns off or when you are on a 
call or playing music in the background for longer than the time specified in 
Backlight Settings. You can set different time intervals depending on whether the 
device is operating on battery power or is connected to an external power source. 
The backlight also turns off when an application’s power-saving features turn it 
off. 

Left Softkey Right Softkey
Phone/Talk

Start

Power/End

OK

Backspace

Option

Shift

Space

Return

Shift

Alt
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Entering Lowercase and Uppercase Letters

By default, the first letter of each sentence or field is capitalized and the 
remaining text you enter is lowercase. To enter other uppercase letters, do one of 
the following: 

� Press Shift , and then enter a letter. (You don’t need to press and hold 
Shift while entering a letter.)

� Press Shift  twice to turn on Caps Lock, and then enter a series of letters. 
(When Caps Lock is on, this symbol appears at the bottom of the screen: . 
To turn off Caps Lock, press Shift  again.)

Entering Numbers, Punctuation, and Symbols 

Numbers, punctuation, and symbols appear above the letters on the keys. To 
enter these characters, do one of the following: 

� Press Option , and then press the key of the desired character. (You don’t 
need to hold Option while pressing the key.)

Tip: You can change the backlight shut-off interval. Press Start and select 
Settings. Select the System tab, and then select Backlight. Set the time 
interval on the Battery Power tab and on the External Power tab. The 
backlight also turns off when an application’s power-saving features turn 
it off.

Tip: You can turn off the first-letter capitalization setting. For details see 
“Setting Input Options” on page 287.
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� Press Option  twice to turn on Option Lock, and then press the desired keys 
to enter a series of characters. (When Option Lock is on, this symbol appears 

at the bottom of the screen: . To turn off Option Lock, press Option  
again.) 

Entering Other Symbols and Accented Characters

You can enter symbols and accented characters that don't appear on the keys by 
using the alternate characters list.

1. Press Alt  to display the alternate characters list.

2. Narrow the list by pressing the key that corresponds to the character you 
want. (For example, to enter an é, press E. See the table on the next page for 
a list of corresponding characters.)

3. Press Up  or Down  to highlight the desired character.

4. Press Center  to insert the character.

If you don’t know which key to press to narrow the list when entering a symbol, 
you can scroll through the full list until you find the character you want.

 
Tip: The alternate characters are grouped according to their similarity to the 

corresponding key. For example, the alternate characters available for the 
e key are é, è, ë, and ê. If you press the wrong key, press Backspace to return 
to the full list of alternate characters. You can then press another key.
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Symbols and Accented Characters 
Press Alt  
and enter… to select…

Press Alt  
and enter… to select…

a á à ä â ã å æ S ß ŠS §

A Á À Ä Â Ã Å Æ t or T ™

b or B ß u ú ù ü û

c ç ¢ © U Ú Ù Ü Û

C Ç ¢ © x or X x ¤

e é è ë ê y ý ÿ 

E É È Ë Ê Y Ý Ÿ

i í ì ï î 0 °

I Í Ì Ï Î 1 1 ¼ ½

l or L £ 2 2

n ñ 3 3 ¾

N Ñ f ƒ

o ó ò ö ô œ õ F ƒ

O Ó Ò Ö Ô Œ Õ $  £ ¥ ¢

p or P ¶ ! ¡

r or R ® ? ¿

s ß šs § ; :-) :-( ;-)
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Opening and Closing Applications

Opening Applications

You can access all the applications on your smart device through the Start menu:

1. Press Start  to open the Start 
menu. 

2. Use the 5-way navigator to 
highlight the application you 
want to use. (To view additional 
applications, select Programs.)

3. Press Center  to open the 
highlighted application.

4. (Optional) Press OK  to return 
to Programs and open another application. (The current application 
continues to run in the background.)

Tip: With the Start menu open, you can press the letter underlined in the 
application’s name to open the application. For example, press H to open 
Help. You can also select the shortcut icons at the top of the Start menu to 
open recently used applications.

Did You 
Know?

You can open applications by pressing Option and then pressing Phone/
Talk, Start, or OK. You can customize the applications assigned to these 
button combinations; see “Reassigning Buttons” on page 284 for details.
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Closing Applications

You can have several applications open at once, so you don’t need to exit an 
application to open another one. In most cases, applications close automatically 
when available memory is low, but you can also close applications manually.

1. Press and hold OK  to open Memory Settings. 

2. On the Running Programs tab, do one of the following:

� Select the application you want to close, and then select Stop to close it. 

� Select Stop All to close all your open applications.

Note: If you press OK to return to Programs, the current application continues to 
run in the background.
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Using Your Today Screen

Your Today screen is your home base. From your Today screen you can quickly look 
up a contact, dial a phone number or speed dial button, see your latest calendar 
appointments, see the number of unread email messages, and even search the 
Web. 

� To access your Today screen, press Phone/Talk . 

� Title Bar and Status Information: See “Checking Signal Strength and Phone 
Status” on page 99 to learn about the icons that appear in this area.

� Dial Lookup Field: Begin typing the name you want to look up. See “Dialing by 
Contact Name” on page 61 for more information. 

� Web Search Field: Enter a word you want to find on the Internet, and press 
Center  to begin the search (data services connection required).

Title Bar and Status 
Information Dial Lookup Field

Web Search Field

Speed Dial 
Entries
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� Speed Dial Entries: Select the picture or button you want to dial. If you press 
Center  while a speed dial is highlighted, your smart device dials the 
number. 

You can select a picture for your Today screen background and select which items 
appear in the Today screen. See “Today Screen Settings” on page 276 for details. 
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Where to Learn More

For a Quick Introduction
� Quick Tour: The Quick Tour highlights many of your smart device’s features. 

It is already installed on your smart device, and you can open it at any time. 

Press Start , select Programs, and then select Quick Tour .

While Using Your Smart Device
� Help: Many of the built-in applications include on-device Help, so that you can 

learn about the tasks you can perform in that application. To access Help, go 

to the application or screen you want help with, press Start , and select 
Help.

� Online support from Palm: For up-to-date downloads, troubleshooting, 
and support information, check out www.palm.com/us/support/
treo700wxsprint.

If You Need More Information
� Books: Many books on Windows Mobile® devices are available in local or 

online book retailers (look in the computers section), or visit
www.palm.com/us/support.

� Online forums: Consult online Treo device user discussion groups to swap 
information and learn about topics you may find nowhere else. Visit
www.palm.com/us/support for details.

� Sprint Customer Service: For questions about your account or features 
available on the network, contact Sprint or visit www.sprint.com for the latest 
information and help.

http://www.palm.com/us/support/treo700wxsprint
http://www.sprint.com
http://www.palm.com/support
http://www.palm.com/support
http://www.palm.com/us/support/


56 Section 2A: Learning the Basics of Your Smart Device

Visiting the Sprint Web Site

You can get up-to-date information on Sprint PCS services and options by signing 
on to the Sprint Web site at www.sprint.com. 

When you visit Sprint online, you can

� Review coverage maps.

� Learn how to use voicemail.

� Access your account information.

� Purchase accessories.

� Add additional options to your service plan.

� Check out frequently asked questions.

� And more.

Reaching Sprint Customer Service

You can reach Sprint Customer Service many different ways:

� On your Treo700wx smart device, go to your Today screen, enter *2, and then 

press Phone/Talk  to dial.

� Sign on to your account at www.sprint.com.

� Call toll-free at 1-888-211-4PCS (4727) (Consumer customers), 
–or– 
1-888-788-4727 (Business customers).

� Write to Sprint Customer Service, P.O. Box 8077, London, KY 40742.

Receiving Automated Invoicing Information

For your convenience, your phone gives you access to invoicing information on 
your Sprint PCS account. This information includes balance due, payment 

http://www.sprint.com
http://www.sprint.com


Section 2A: Learning the Basics of Your Smart Device 57

D
evice B

asics

received, invoicing cycle, and the number of minutes used since your last 
invoicing cycle. (Normal airtime usage will apply.)

� Go to your Today screen, enter *4, and then press Phone/Talk  to dial.

Sprint 411

You have access to a variety of services and information through Sprint 411, 
including residential, business, and government listings; assistance with local or 
long-distance calls; movie listings; and hotel, restaurant, shopping, and major 
local event information. There is a per-call charge and you will be billed for 
airtime.

� Go to your Today screen, enter 411, and then press Phone/Talk  to dial.

Sprint PCS Operator Services

Sprint PCS Operator Services provides assistance with placing collect calls or with 
placing calls billed to a local telephone calling card or third party.

� Go to your Today screen, enter 0, and then press Phone/Talk  to dial.

For more information or to see the latest in products and services, visit Sprint 
online at www.sprint.com.

Note: This service may not be available in all Affiliate areas.

Note: Short numbers, such as 411, may conflict with a contact name. If this 
occurs, press Option to avoid starting a contact lookup. 

http://www.sprint.com
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Sec t ion 2B

Using Your Device’s Phone Features

In This Section

� Phone Overview

� Making Calls

� Receiving Calls

� Using Voicemail

� Managing Active Calls

� More Ways to Manage Calls

� Using Sprint PCS Voice Command

� Defining Speed Dial Buttons

� Using a Phone Headset

� Customizing Phone Settings

� Controlling Your Roaming Experience

� Checking Signal Strength and Phone Status
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Phone Overview

You can make and receive calls and store speed dial entries right from your Today 
screen. Be sure you know how to turn on your phone before reading this section 
(see “Turning Your Phone On and Off” on page 18).

Accessing Your Today Screen

� Press Phone/Talk .

Important! Depending on where you are on a network and certain coverage 
conditions, you might experience interruptions with your phone 
operation while using a Wi-Fi card (you must purchase and install a third-
party Wi-Fi card to use this feature). Palm recommends that you turn off 
the phone radio when using any Wi-Fi card or remove the Wi-Fi card 
when not in use to ensure that you can always make and receive phone 
calls. For EMERGENCY calls, always remove the card from your smart 
device to ensure optimal connectivity.
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Making Calls

Your smart device offers several ways to make phone calls. Try them all and you’ll 
discover which methods you prefer.

Dialing With the Number Pad
1. Go to your Today screen (see “Accessing 

Your Today Screen” on page 60).

2. Using the numbered keys on the 
keyboard, enter a phone number. 

3. Press Phone/Talk  to dial.

You do not need to press Option to access the 
numbers on the keyboard. However, when 
dialing short numbers, such as 411, the number may conflict with a contact 

name. If this occurs, press Option  to avoid starting a contact lookup. You can 
always dial 911 without pressing Option first.

Dialing by Contact Name

You can look up contacts quickly by entering just a few letters of a contact’s 
name directly from your Today screen. Before you can dial a call by contact name, 
you must create some contacts (see “Adding a Contact” on page 202) or import 

Before You 
Begin:

Make sure your phone is on (see “Turning Your Phone On and Off” on 
page 18) and that you’re inside a coverage area.
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them by synchronizing (see “Synchronizing Information—The Basics” on 
page 27). 

1. Go to your Today screen (see “Accessing Your Today Screen” on page 60). 

2. Using the keyboard, begin entering one of the 
following for the contact you want to call:

� First name (JOH for John)

� Last name (SMI for Smith)

� First initial, a space, and then last initial (J S 
for John Smith)

� First name and last name 
(JOH SMI for John Smith)

(For example, entering SM finds both Smilla 
Anderson and John Smith. Entering SM A finds only Smilla Anderson.)

3. Select the number you want to dial.

4. Press Phone/Talk  to dial.

After you look up a contact, you can select how you want to communicate with 
that person. Press and hold Center  on the 5-way, and then select the 
communication method you want to use. 

Tip: To see a contact’s address, company, and other details, highlight the 
name and press Center on the 5-way.
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Dialing With a Speed Dial Button 

Before you can use a speed dial button, you must 
create some speed dial entries. See “Defining Speed 
Dial Buttons” on page 80. 

You can make a call with your speed dial buttons by 
doing any of the following:

� Highlight a speed dial button with the 5-way, and 
then press Center .

� Tap a speed dial button with the stylus. 

� Press and hold a Quick Key that you assigned to the speed dial button.

To see more speed dial buttons, highlight the picture speed dial area and press 

Right  or Left  repeatedly, or highlight the text speed dial area and press Up , 

Down , Right , or Left .

You can hide your speed dial buttons on your Today screen and still use your 
Quick Keys to call a speed dial number.

Did You 
Know?

You can dial an alternate number for a contact with a speed dial button. 
Highlight the speed dial button, press and hold Center on the 5-way, and 
then select a number from the shortcut menu. 
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Dialing by Company Name

1. Press Start  and select Contacts.

2. Press Menu  (right softkey) and select View 
By > Company.

3. Press Phone/Talk  to go to your Today screen.

4. Using the keyboard, begin entering the first few 
letters of the company name.

5. Select the number you want to dial.

6. Press Phone/Talk  to dial.

Dialing From a Web Page or Message

Your smart device recognizes most phone numbers 
that appear on Web pages or in messages (text or 
email). 

1. Use the 5-way to highlight the phone number 
you want to dial on the Web page or in the 
message.

2. Press Center  to open the Phone dialog box, 
and then select Yes to dial.
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Redialing a Recently Called Number
� To dial the last number you called: Go to your 

Today screen, and then press and hold 

Phone/Talk .

� To select from your most recently dialed numbers: 

Go to your Today screen, press Phone/Talk , 
highlight the number or contact name you want 

to call, and then press Phone/Talk  to dial. (If 
more than one number is associated with a 

contact, highlight the contact and press Right  
to access any alternate numbers for that 
contact.)

� To select from a chronological list of calls: Go to 

your Today screen, press Phone/Talk , and 
then select Call Log. (Highlight the number you 
want to call, and then press Call  (left 
softkey) to dial.) 

Tip: If you can’t dial a phone number directly from a Web page or a message, 
then highlight the number, press and hold Center on the 5-way, and select 
Copy. Open the Dial Pad, and then press and hold Center on the 5-way to 
Paste. Press Phone/Talk to dial.

Tip: You can also access the Call Log and Dial Pad from the Today screen by 
pressing Menu (right softkey) and selecting Call Log or Dial Pad. 
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Dialing Using the Onscreen Dial Pad

The onscreen Dial Pad provides large numbers that you can tap with your finger 
or stylus. The numbers also include the corresponding letters so you can dial 
numbers that are expressed as letters. 

1. Go to your Today screen.

2. Press Phone/Talk , and then select Dial Pad 
from the menu.

3. Tap the onscreen Dial Pad to enter the number.

4. Press Phone/Talk  to dial.

Did You 
Know?

You can paste numbers directly into the Dial Pad. Copy a number from 
another application, switch to Dial Pad, and then press and hold Center on 
the 5-way to paste the number.



Section 2B: Using Your Device’s Phone Features 67

U
sin

g You
r Ph

on
e

Receiving Calls

To receive calls, your phone must be on. 

To answer a call, do one of the following:

� Press Phone/Talk .

� Press Answer  (left softkey).

� If the headset is attached, press the headset button.

To ignore a call and send it to voicemail, do one of the following:

� Press Power/End .

� Press Menu  (right softkey) and select Ignore.

To silence the ringer while your device is ringing:

� Press any key on your smart device except Phone/Talk, Power/End, Start, OK, 
Alt, or the 5-way. You can also use the Volume button to turn the ringer 
sound all the way down.

Tip: See a picture of the person calling you. Learn how to assign a caller ID 
picture in “Assigning a Picture and Ringtone ID to a Contact” on page 89.

Tip You can also ignore a call and send a text message. Press Menu (right 
softkey) and select Ignore with text message. During a voice call you can 
send text messages, but you cannot use data features such as Web 
browsing and email.



68 Section 2B: Using Your Device’s Phone Features

� To immediately silence all system sounds including the ringer, slide the 
Ringer switch to Sound Mode Off . (All sounds remain off until you slide 

the Ringer switch back to Sound Mode On .)

When you silence the ringer, you can either answer the call or let it ring through 
to voicemail. 

Tip: If music is playing when a call arrives, the audio pauses as soon as the 
device starts ringing and remains paused during your call. Music 
playback resumes automatically when the call ends or the ringing stops. 
The Windows Media Player screen remains on if the call is not answered, 
but is closed if the call is answered. When playback resumes, the 
Windows Media Player screen remains in the background.

Did you 
know?

When you are on a plane, you can turn off your phone and all wireless 
services using Wireless Manager (see “Turning Wireless Services On/Off” 
on page 302). But you can still wake up the screen and use any 
application that doesn’t require wireless services, like your smart device’s 
calendar, music player, and games.
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Using Voicemail

Your voicemail number is preset when you activate your device. The first time 
you call voicemail, you are prompted to enter your voicemail password. If 
necessary, please contact Sprint for your password and enter it as prompted.

Setting Up Voicemail
1. Go to your Today screen.

2. Press and hold 1 on the keyboard to dial
Sprint’s voicemail system. (You can also
tap the Voicemail speed dial button with your
stylus.)

3. Follow the voice prompts to set up 
your voicemail.

Voicemail Notification

When you have a new voicemail message, 
a notification screen appears. To hear your message 
now, press Listen  (left softkey). To retrieve your 
message later, press Dismiss  (right softkey). 
When you have unretrieved voicemail messages, a 
Voicemail icon  appears at the top of your screen and the left softkey is labeled 
Voicemail. 

Tip: When a Voicemail icon appears at the top of the screen, you can tap this 
icon to retrieve your voicemail.
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Retrieving Voicemail Messages
1. Go to your Today screen.

2. Press and hold 1 on the keyboard to dial Sprint’s voicemail system.

3. Enter your voicemail password using the keyboard, or press Extra Digits 
 (left softkey) if you defined this option (see “Creating a Speed Dial 

Button” on page 80 for details).

4. Select Play  to listen to your messages.

You do not need to press Option to enter numbers, *, or # while on an active call.

Clearing the Voicemail Icon

After retrieving your voicemail messages, the Voicemail icon at the top of your 
screen should disappear. Sometimes, retrieving your voicemail messages doesn’t 
always clear the Voicemail icon. You can do this manually.

1. Press Start  and select Settings.

2. On the Personal tab, select Phone .

3. Select the Services tab.

4. Select Clear Voicemail Icon, and then press 
Center .

Tip: If you have trouble accessing a voicemail system, try changing the 
Dial Pad tone setting. See “Selecting Your Call Settings” on page 90.
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Managing Active Calls

When you make or receive a call, the active call information appears on your 
Today screen. 

During a call, you can do any of the following:

� Put the call on hold: Press Hold  (left softkey). (To take the call off hold, 
press Off Hold  (left softkey).)

� Use the built-in speakerphone: Select Speakerphone . (To turn off the 
Speakerphone, select .) 

� Mute the microphone so you can’t be heard: Select Mute . (To turn the 
microphone back on, select Mute .)

� Switch to another application: Press Start  and select the application.

Tip: When a call lasts longer than one minute, the screen dims. Press any key, 
except Power/End, to wake up the screen.

Current Duration Of Call

Caller’s Name and Number
Mute
Speakerphone
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Ending a Call

Do one of the following:

� Press Power/End. .

� Press the headset button (if the headset is attached and has a button on it). 
(Some headsets do not have a button.)

Returning to an Active Call From Another Application

You can use many other applications on your smart device while holding a phone 
conversation, including the organizer and Messaging features. You cannot 
browse the Web or send and receive email while on a voice call.

� From any application, press Phone/Talk  to return to your Today screen.

Saving Phone Numbers

After you complete a call, you are prompted to add the number if it is not already 
in your Contacts list. 

� To create a new contact for this number, select Create New Contact.

� To add this number to an existing contact, select Copy and Add, and then 
select a contact name.

� To decline adding the number, press Dismiss  (left softkey).

� To permanently disable the Add Contact prompt, select Don’t show this 
again.

Did You 
Know?

You can send and receive text messages during a call. This is a great way 
to stay connected with colleagues during a long call. 
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If you don’t add a number right away, follow these steps to add it later: 

1. Go to the Call Log (see “Redialing a Recently Called Number” on page 65). 

2. Highlight the number you want to save. 

3. Press and hold Center  to open the shortcut menu, and then select Save 
to Contacts.

4. Enter the information for the entry.

5. Press OK .

Did You 
Know?

If an incoming call uses caller ID blocking, you do not see the Add Contact 
prompt.

Tip: You can re-enable the Add Contact prompt even if you chose Don’t show 
this again. See “Selecting Your Call Settings” on page 90 for more 
information.

Tip: You can also save contact information from other applications, such as 
Messaging.
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More Ways to Manage Calls

Your Treo device offers many advanced telephone features, including call waiting 
and three-way calling,. 

Making a Second Call 

You can make a second call while your first call is still 
active. 

1. Press Hold  (left softkey) to put the first call 
on hold. 

2. To dial a second number, use any of the methods 
described in “Making Calls” on page 61. (If you’re 
dialing by contact name or with the keyboard, 
you must first use the 5-way to select the Dial 
Lookup field.)

When two calls are active, your Today screen includes two call status sections, 
each representing one of the calls. 

Did You 
Know?

When the second call is outgoing, you can conference the two calls, but 
you cannot swap between them.

When the second call is incoming, you can swap between the two calls, 
but you cannot conference them.

When two calls are active and you press Power/End, you hang up both 
calls. To return to the first call, wait for the person on the second call to 
hang up.
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Answering a Second Call (Call Waiting)

When you’re on a call and you receive a second call, the call-waiting notification 
appears. You can do any of the following:

� Place the current call on hold and answer the new call: Press Answer  (left 

softkey) or Phone/Talk .

� Send the new caller a text message: Press Menu  (right softkey) and select 
Ignore with text message.

� Hang up the first call: Press Power/End . (The second call becomes an 
incoming call alert, which you can choose to answer or ignore.)

� Send the new call to voicemail: Press Menu  (right softkey) and select 
Ignore.

Making a Conference Call

When the second call is outgoing, you can join two calls in a conference session. 
Additional charges may apply and minutes in your account may be deducted for 
each active call. Please contact Sprint for more information.

1. Put the first call on hold, and then place a second 
call.

2. Press Conference  (left softkey); this joins 
the two active calls in a conference.

3. When you’re done, press End Conference  
(left softkey); this ends the second call and 
returns you to the first call. (If you’re ready to 

hang up both calls, press Power/End  instead.)
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Using Flash Mode During an Active Call 
Flash mode is an alternate way to manually manage your calls while one or more 
calls are active. The preferred methods are described in “Making a Second Call” on 
page 74, “Answering a Second Call (Call Waiting)” on page 75, and “Making a 
Conference Call” on page 75. This mode is often used during a conference call 
when one of the calls has ended but the other remains connected. 

1. Press Phone/Talk  from the Active Call screen.

2. Select Send Key (Flash) to enter Flash mode.

3. Depending on the state of your active call, pressing the Flash (left 
softkey) does one of the following:

� If you have two active calls, you can swap between them if the second 
call is an incoming call.

� If you have one active call, you can dial another number. You can press 
Flash  (left softkey) again to set up a conference call.

� If you have two calls in conference, press Flash  (left softkey) to 
hang up the second call, and then dial another number.

4. Press Power/End  to exit Flash mode and end all calls.

Forwarding Calls

You can forward calls to another phone number. Please check with Sprint about 
availability and pricing of forwarded calls; additional charges may apply.

1. Go to your Today screen.

2. Dial *72 followed by the number where you want to forward your calls. (For 
example: *72 415-555-1234.)
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3. Press Phone/Talk  to dial.

4. When you’re ready to turn off call forwarding, dial *720, and then press 

Phone/Talk .

Tip: If *72 and *720 do not turn call forwarding on and off, please contact 
Sprint to obtain the forwarding codes for your area.

After you turn on call forwarding, call your smart device to confirm that 
call forwarding is active.
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Using Sprint PCS Voice Command

If you subscribe to the Sprint PCS Voice Command
 
service, you can call a number 

by just saying a name. (There is a monthly charge for this service.)

To activate Sprint PCS Voice Command, you must speak to a Sprint Customer 
Service representative:

1. Go to your Today screen.

2. Press * (Option  + Z), and then press 2. 

3. Press Phone/Talk  to contact Sprint Customer Service and sign up.

Setting Up Your Personal Address Book

To use Sprint PCS Voice Command, you must first set up your personal address 
book.

1. Go to your Today screen.

2. Press * (Option  + Z). 

3. Press Phone/Talk .

4. Follow the system prompts. (You’ll hear a tone, followed by the prompt 
“Ready.”)

5. Say “Add Name” to begin setting up your personal address book, and then 
follow the voice prompts.
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Making a Call With Sprint PCS Voice Command
1. Go to your Today screen.

2. Press * (Option  + Z). 

3. Press Phone/Talk . (You’ll hear a tone followed by the prompt “Ready.”)

4. After the prompt, say “Call” and the name you’ve assigned to the number 
you want to call. (Your request will be repeated and you will be asked to 
verify it.) 

5. Say “Yes” to dial the call. (Say “No” to cancel.)

Note: Sprint PCS Voice Command service cannot be used with wireless 
headsets that are enabled with Bluetooth wireless technology.

Did You 
Know?

You can also use voice commands to execute some commands on the 
Start menu and the Programs menu. See “Setting Up Voice Commands” 
and “Using Voice Commands” on page 286.
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Defining Speed Dial Buttons

Your smart device lets you create both picture and text speed dial buttons so that 
you can select a button on the Today screen to quickly dial a number.

Creating a Speed Dial Button

You can create up to 20 picture buttons and 50 text buttons. 

1. Go to your Today screen.

2. Press Menu  (right softkey) and select New 
Speed Dial. 

3. Do one of the following:

� Select Link to contact, select the contact you 
want to link to this button, and then select 
the number you want to dial with this 
button.

� Select Label and enter a name for this button, 
and then select Number and enter the phone number you want to dial 
with this button.

� (Optional) Enter a Quick Key. When the Today screen is displayed, you 
can press and hold the Quick Key to instantly dial this number. (Quick 
Keys can be letters or numbers, but you can’t use both the letter and 
number for the same key. For example, the voicemail Quick Key is 1. The 
letter equivalent for that key is E, so you cannot assign E as a Quick Key 
to another speed dial button. You can create up to 50 Quick Keys for 
speed dial buttons and 20 Quick Keys for picture speed dial buttons.)
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4. If this button is linked to a contact entry with a picture, select either Text 
Speed Dial or Picture Speed Dial to indicate which type of button you want to 
create. (If this button is not linked to a contact or the contact doesn’t have a 
picture, the Picture Speed Dial option is not available.)

5. (Optional) Select the Advanced tab and set any of 
the following options:

� Extra Digits: Defines additional numbers to 
dial, such as a password or extension. (In 
addition to numbers, you can enter the 
following symbols: star (*) and pound (#). You 
can enter a comma (,) to insert a one-second 
pause.) 

� Dial extra digits automatically: Dials 
predefined extra digits immediately after dialing the phone number. (If 
you do not check this box, you need to press Extra Digits  (left 
softkey) to dial these digits.)

Tip: You can add a special ringtone to a contact associated with the speed-
dial button. See “Adding a Contact” on page 202.
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� Show voice mail buttons: Displays the voicemail playback controls after 
you dial this speed dial number. (When this option is checked, you can 
enter numbers below each control to tailor the controls to your 
voicemail system. You cannot select these controls with a stylus.)

 Plays the previous message.
 Saves the current message.
 Plays the current message.
 Deletes the current message.
 Repeats the current message.
 Plays the next message.

6. Press OK . 

Editing a Speed Dial Button
1. Go to your Today screen.

2. Highlight the speed dial button you want to edit.

3. Press and hold Center  to open the shortcut menu, and then select Edit 
Speed Dial. 

4. Make the desired changes.

5. Press OK . 

Tip: The playback controls for the Sprint Voicemail speed dial button are 
already set up for the Sprint voicemail system.

Tip: You can also edit a speed dial button by pressing Menu and selecting 
Speed Dial Options, and then selecting the button you want to edit.
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Deleting a Speed Dial Button
1. Go to your Today screen.

2. Highlight the speed dial button you want to delete.

3. Press and hold Center  to open the shortcut menu, and then select Edit 
Speed Dial. 

4. Press Delete .

5. Select Yes to confirm deletion.

Arranging Your Speed Dial Buttons
1. Go to your Today screen.

2. Press Menu  (right softkey) and select Speed 
Dial Options.

3. Highlight the button you want to move.

4. Press Option  + Up , Down , Right , or 

Left  to move the button in that direction.
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Using a Phone Headset

You can connect a phone headset for hands-free operation. If you need to use 
your device while driving and this is permitted in your area, we recommend using 
the phone headset included with your device, or a hands-free car kit (sold 
separately).

The headset button is context sensitive, and it performs various actions based on 
the situation. You can press the headset button to perform any of the following 
tasks:

� Answer an incoming call.

� Respond to call waiting.

� Hang up all calls.

� Swap between calls if the second call is an incoming call.

� Create a conference call if the second call is an outgoing call.

Microphone

Speaker

Headset Button
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Headset Specifications

You can use the headset that came with your smart device or compatible third-
party headsets. Here are tips for using a headset:

� Your smart device works with headsets that have a 2.5mm, 3-pin connector. 

� When in doubt, ask the third-party headset manufacturer if the product is 
compatible with your Treo700wx smart device. (If you hear a headset buzz or 
poor microphone performance, your headset may be incompatible with your 
smart device.)

� The headset designed for Treo 180/270/300 smart devices is not compatible 
with the Treo700wx smart device.

Using a Hands-Free Device With Bluetooth Wireless Technology

Your Treo device is also compatible with many headsets and car kits enabled with 
Bluetooth wireless technology version 1.1 or 1.2. Please note, however, that you 
cannot use a Bluetooth headset to listen to MP3 files on your smart device. 

For a list of compatible hands-free devices with Bluetooth wireless technology, 
go to www.palm.com.

To learn how to set up and connect to Bluetooth devices, see “Connecting to 
Devices With Bluetooth® Wireless Technology” on page 160. 

Tip: The stereo headset included with your device allows you to listen to 
music in stereo. You do not need to use a stereo adapter. For more 
information on compatible audio accessories, visit www.palm.com/us/
support/treo700wxsprint.

http://www.palm.com/us/support/treo700wxsprint
http://www.palm.com/us/support/treo700wxsprint
http://www.palm.com/us/support
http://www.palm.com/us/support
http://www.palm.com/us/support
http://www.palm.com/us/support
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Here are tips for working with a Bluetooth hands-free device:

� To transfer a call from the handset to a Bluetooth hands-free device during a 
call, press Menu  (right softkey) and select Connect Bluetooth. (To 
transfer the call back to the headset, press Menu  (right softkey) and 
select Cancel Bluetooth.)

� To transfer a call from a wired headset to a Bluetooth headset or car kit that is 
within range and with which you’ve previously set up a partnership 
(Bluetooth headset or car kit required, sold separately), unplug the wired 
headset and press the button on the Bluetooth headset or car kit. 

� If you have both a compatible Bluetooth headset and car kit, the one you 
connected to your smart device last becomes the active device.

Tip: To find out how to transfer your contacts from your device to your car kit, 
go to www.palm.com/us/support/bluetooth

http://www.palm.com/us/support/bluetooth
http://www.palm.com/us/support/bluetooth
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Customizing Phone Settings

Selecting Ringtones and Vibrate Settings

You can set different tones for different types of incoming phone calls and 
notifications.

1. Press Start  and select Settings.

2. On the Personal tab, select Sounds & Notifications .

3. Select the Notifications tab.

Before You 
Begin:

Turn on your phone to access your phone settings. See “Turning Your 
Phone On and Off” on page 18.

Did You 
Know?

You can download MP3, MIDI, QCELP, WAV, and WMA ringtones directly 
to your smart device (see “Downloading Files and Images From a Web 
Page” on page 155). You can also download ringtones to your computer 
and then email them to your phone. Your device also supports video 
ringtone formats WMV and 3GP, 3G2 (video files recorded from your 
smart device camera).
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4. Select the Event list, and then select which type of call or notification you 
want to set the ringtone for:

� Phone: Known Caller: An incoming call from 
someone in your Contacts list or Speed Dial 
list.

� Phone: Missed call: A call you did not answer.

� Phone: Roaming: A call that comes in when 
you’re outside the Nationwide Sprint PCS 
Network.

� Phone: Unknown Caller: An incoming call from 
someone identified by caller ID who is not in 
your Contacts list or Speed Dial list. 

� Phone: Voice mail: A new voicemail.

5. Select the Ring type list, and then select the ring style for the selected type 
of call.

6. Select the Ring tone list, and then select the sound for the selected type of 
call.

7. (Optional) Select Play  to preview the sound.

8. Check the Vibrate when… boxes to turn the vibrate feature on/off based on 
the ringer switch setting.

9. Repeat steps 4–7 to select ringtones for other types of calls. 

Tip: For the Missed call and Voice mail options, select sound and display 
options instead of ring type and ring tone.



Section 2B: Using Your Device’s Phone Features 89

U
sin

g You
r Ph

on
e

10. Press OK .

Adjusting Volume Settings
� Call volume: While a call is in progress, press the Volume button (on the side of 

your smart device) to adjust the call volume. 

� Music/Video volume: While playing music or a video, press the Volume button 
to adjust the music/video volume.

� Ringer volume: When a call is not in progress and you are not playing music or 
a video, press the Volume button to adjust ringer volume.

Assigning a Picture and Ringtone ID to a Contact

1. Press Start  and select Contacts.

2. Highlight the contact that you want to give a picture caller ID, and 
then press Center .

3. Highlight the contact’s name, and press Edit  (left softkey).

4. Select Picture.

Tip: To record, preview, delete, and send sounds on your smart device, select 
the Manage tab. To record a sound, press Menu and select New Sound. To 
play a sound, select it. To delete a sound, highlight it and press Backspace. 
To send a sound, highlight it, press Menu, and select Send Sound.

Did You 
Know?

You can also set sounds for messaging notifications and calendar 
reminders. See “Selecting Sounds & Notifications” on page 279.
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5. Select Camera to take a picture and add it to this contact entry (if your smart 
device includes a camera), or select an existing picture for this contact 
entry.

6. Select Ring tone and then select a tone for this contact entry.

Selecting Your Call Settings

1. Press Start  and select Settings.

2. On the Personal tab, select Phone .

3. On the Phone tab, set any of the following 
options:

� Dialpad: Sets the style for the dialpad tones 
(DTMF) in the Phone application. 

� Short tones: Tones sound briefly as you 
dial.

� Long tones: Tones continue to sound until you release the key.

� TTY/TDD: Lets you configure your smart device for use with a TTY/TDD 
device for people who are deaf or hard of hearing. (See “TTY Use With 
Sprint PCS Service” on page 93 for more information.)

� After calls from numbers that are not in Contacts, ask if I want to add them: 
Indicates whether you are prompted to add contact entries for numbers 
that are not already in your Contacts list.

4. Press OK  to finish.

Tip: If you have trouble accessing a voicemail system, try changing the 
Dialpad tone setting.
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Setting Your Dialing Preferences

Dialing preferences let you assign a prefix to your phone numbers. For example, 
you can automatically dial a 1 before all 10-digit phone numbers. You can add a 
different prefix based on the length of the phone number. 

1. Press Start  and select Settings.

2. On the Personal tab, select Phone .

3. On the Dialing tab, set any of the following options:

� Dialing from North America: Formats phone 
numbers using North American conventions 
(XXX-XXX-XXXX).

� Always dial 1 in front of the area code: Adds a 
1 in front of 10-digit phone numbers. This 
option is available only when North 
American Dialing is enabled.

� International Dialing Prefix: Adds the 
specified number in front of International 
phone numbers. (When an international number beginning with “+” is 
dialed, the “+” is replaced with the number in this field.)

4. Press OK .
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Setting Your Abbreviated Dialing Preferences

Abbreviated dialing is used to automatically dial a complete phone number when 
you enter a shortened version of that number. Shortened phone numbers are 
typically used in corporate phone systems that allow internal users to dial an 
extension number rather than the complete number. 

For example, if your co-worker’s phone number is 1-555-222-1234, you may need 
to dial only the last five digits of that number from an internal phone. In that 
case, you would dial 21234. If that shortened five-digit internal number is 
entered in your contact list or in a corporate Global Address List (GAL), your Treo 
device device will attempt to dial an incomplete number because it is not on the 
internal phone network. 

If that is the case, use the abbreviated dialing settings to automatically complete 
shortened numbers. For example, if all the phone numbers in your office begin 
with 1-555-22, followed by a five-digit extension, set your smartphone to auto-
matically enter 1-555-22 as the prefix before any five-digit number. When you 
enter your colleague’s five-digit extension, your device automatically dials 
1-555-22 plus the 5-digit extension. The complete number is 1-555-222-1234
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1. Press Start  and select Settings.

2. On the Personal tab, select Phone . 

3. On the Dialing tab, select Abbreviated Dialing, 
and then check the box that corresponds to the 
number of digits you want your smartphone to 
dial (3, 4, 5, 6, or 7). Selecting the option adds a 
prefix to numbers with the specified number of 
digits.

� Press OK .

TTY Use With Sprint PCS Service

A TTY (also known as a TDD or Text Telephone) is a telecommunications device 
that allows people who are deaf or hard of hearing, or who have speech or 
language disabilities, to communicate by telephone.

Your device is compatible with select TTY devices. You can connect a TTY/TDD 
machine, headset, or hands-free kit to your device through the headset jack 
while this mode is enabled. Please check with the manufacturer of your TTY 
device for connectivity information and to ensure that the TTY device supports 
digital wireless transmission.

See “Selecting Your Call Settings” on page 90 for instructions to turn on the TTY/
TDD feature.

When establishing your Sprint PCS service, please call Sprint Customer Service via 
the state Telecommunications Relay Service (TRS) by first pressing 711, and then 

pressing Phone/Talk  to dial. Then provide the state TRS with this number: 
866-727-4889.
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Selecting Your Data Settings

1. Press Start  and select Settings.

2. On the Personal tab, select Phone .

3. Select the Services tab and then select Data 
Settings.

4. Indicate whether you want to allow a voice call to 
interrupt a data session. SMS messages will not 
be received on the device during any data 
session.

5. Press OK  to return to Phone Settings.

6. Press OK  to finish.

WARNING 911 Emergency Calling

Sprint recommends that TTY users make emergency calls by other 
means, including Telecommunications Relay Services (TRS), analog 
cellular, and landline communications. Wireless TTY calls to 911 may be 
corrupted when received by public safety answering points (PSAPs), 
rendering some communications unintelligible. The problem 
encountered appears related to TTY equipment or software used by 
PSAPs. This matter has been brought to the attention of the FCC, and the 
wireless industry and PSAP community are currently working to resolve 
this.
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Selecting Your Privacy Settings

1. Press Start  and select Settings.

2. On the Personal tab, select Phone .

3. Select the Services tab and set any of the 
following options:

� Voice Privacy: Prevents over-the-air 
eavesdropping when this option is turned on 
and this feature is available on the Sprint 
network.

� Location Privacy: Indicates whether your smart device broadcasts your 
location at all times, or only during a 911 call.

4. Press OK  to return to Phone Settings.

5. Press OK  to finish.

Tip: For quick access to the Location Privacy setting, tap the Location Privacy 
icon on your Today screen.
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Controlling Your Roaming Experience

Your device is digital dual-band, which means you can make and receive calls 
while on the Nationwide Sprint PCS Network and you can also roam on other 
digital networks where Sprint has implemented roaming agreements with other 
carriers.

When you roam outside the Nationwide Sprint PCS Network, the Roaming 

icon  appears at the top of the screen. Additional charges may apply if you use 
your Treo700wx smart device while roaming.

To learn more about roaming, visit www.sprint.com.

Feature Availability
� You can make and receive calls while roaming.

� You can access voicemail while roaming.

� Other features that are standard on the Nationwide Sprint PCS Network, such 
as call waiting, Sprint PCS Voice Command, and Sprint PCS Vision, may be 
available depending upon your roaming network.

� Data services may not be available when you are roaming on partner 
networks.

http://www.sprint.com
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Setting Roaming Preferences

Use Roaming Preferences to set specific options for using your phone while 
roaming. For example, you can set options to be notified that you are roaming 
before placing a call or making a data connection, so that you are aware that you 
might incur extra charges.

1. Press Start  and select Settings.

2. On the Personal tab, select Phone .

3. Select the Services tab, and then select Roaming.

4. Select the Network Selection pick list and select 
the networks with which you want to allow your 
phone to make a connection:

� Allow roaming enables your phone to 
determine the best network—either home or 
roaming—with which to connect.

� Home network only allows your phone to connect only to your home 
networks.

� Roaming networks only allows your phone to 
connect to roaming networks only.

5. Check the boxes to enable either or both of the 
following roaming warning options:

� Before outgoing calls causes an alert to appear, 
warning you that you are on a roaming network 
when you attempt to dial an outgoing call.
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� Before data connections prevents a data connection while roaming. (An 
alert appears warning you that you are on a roaming network when you 
attempt to make a data connection. To dismiss the warning and make 
the data connection, select the Don’t show this again. Always connect 
when roaming checkbox. You must then attempt to make a data 
connection again.)

6. Press OK .
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Checking Signal Strength and Phone Status

You can monitor the status of your device’s signal strength and several other 
items, using icons at the top of your Today screen:

0

Sprint Your phone is on and you’re inside the Nationwide Sprint PCS 
Network. If you are outside a coverage area, No Service or 
Roaming appears instead. No Service means that there is no 
coverage at all and Roaming means that another wireless 
service provider’s network is available. When you turn off your 
phone, Phone Off appears.

0

You missed an incoming call.

0

You have a voicemail message.

0

You have a new email or text message.

0

An error occurred during synchronization.

0

You have more than one of the conditions listed above.

0

Your phone is on. The bars display the signal strength. 
The stronger the signal, the more bars appear. If you are 
outside a coverage area, no bars appear.

0

Your phone is off.

0

You are outside a Sprint coverage area and roaming on 
another wireless service provider’s network.
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0

A voice call is in progress.

0

You are in an area that supports Sprint PCS Vision (1xRTT) data 
services. 1xRTT (Single carrier [1x] radio transmission 
technology) is a wireless technology that can provide fast data 
transfer and Internet access with average speeds of 60-80Kbps 
and bursts up to 144Kbps. 

0

You are in an area that supports mobile broadband (EVDO) 
data services.

EVDO (Evolution Data Optimized) is a wireless broadband 
technology that is designed for very high-speed data transfer 
with average download speeds of 400-600Kbps, capable of 
reaching speeds up to1.8Mbps, and upload speeds up to 
156Kbps.

0

A Sprint PCS Vision data call is in progress. You can make calls, 
but you cannot receive calls; any incoming calls go 
to voicemail. When you make a call, the data transmission is 
automatically interrupted.

0

A mobile broadband data call is in progress. You can still make 
or receive calls. When you make or receive a call, the data 
transmission is automatically interrupted.

0

Your phone is connected to a Sprint PCS Vision network, but 
you are not actively transmitting data. You can still make or 
receive calls.
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0

Your phone is connected to a mobile broadband network, but 
you are not actively transmitting data. You can still make or 
receive calls.

0

Your Treo700wx smart device is connected to a computer or 
network that is providing a data connection.

0

A data connection is not available or your phone is off.

0
ActiveSync is currently synchronizing with the Exchange 
Server. 

0

Your smart device’s battery is low.

0

Your smart device’s battery is charging.

0

Your smart device is connected to a power outlet and 
the battery is fully charged.

0
Voice privacy is preventing over-the-air eavesdropping. Appears 
during a call when this option is turned on and available on 
the Sprint network.

0

Location privacy setting is set to Location On. Your location is 
available to the Sprint network and other applications. The 
icon appears with a red slash when the 911 only option has 
been selected. See “Selecting Your Privacy Settings” on 
page 95 for information.
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0

The Bluetooth® wireless technology status indicator appears in 
gray when this feature is off, in blue when this feature is on, 
and in reverse blue when your smart device is communicating 
with another Bluetooth device. To quickly turn the Bluetooth 
feature on and off, tap the Bluetooth icon to access the 
Bluetooth Settings screen.

0 A call is in progress and your smart device is connected to a 
Bluetooth headset or car kit. 
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� Accessing Sprint PCS Vision

� Personalizing Your Service With On Demand

� Using Your Device’s Phone as a Modem
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Getting Started With Sprint PCS Vision

Sprint PCS Vision provides wireless access to the Internet anywhere on the 
Nationwide Sprint PCS Network. To sign up for Sprint PCS Vision services or to 
access complete instructions, visit www.sprint.com. For information on charges 
associated with features that use a Sprint PCS Vision connection, refer to your 
Sprint PCS service plan.

Enabling Sprint PCS Vision
1. Make sure your device’s phone is turned on, as described in “Turning Your 

Phone On and Off” on page 18.

2. Press Start  and select Internet Explorer to open your device’s Web 
browser and make a Sprint PCS Vision connection. 

� If you have not already done so, select Now when the Preparing Vision 
Services dialog box appears. (This initiates a one-time process to 
configure your Sprint PCS Vision services. At the end of this two-minute 
process, your device connects to the Sprint PCS Vision home page.) 

� If you want to cancel the connection, select No.

3. Use the 5-way navigator to scroll around and select from a variety of online 
services. 

4. Press OK  to close Internet Explorer Mobile and end your session.

Tip: To bypass the Connect to the Internet dialog box in the future, check the 
Don’t ask me again box. 

http://www.sprint.com
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Accessing Sprint PCS Vision

Once your device is activated, you are signed in and ready to connect to 
Sprint PCS Vision services at any time. 

Sprint PCS Vision User Name

Your Sprint PCS Vision User Name is automatically assigned to you. Your user 
name, which resembles an email address (for example, name@sprint.com), is 
used with Sprint PCS Mail and Messaging services. Your Sprint PCS Vision User 
Name is simply an additional address that identifies your Sprint PCS Account. 
When your device is enabled with Sprint PCS Vision services, your user name 
automatically appears on the About screen. 

To find your user name:

1. Press Start  and select Settings.

2. Select the System tab, and then select About .

3. Select the Phone tab, and then scroll down to Data user name. 

Sprint PCS Vision Symbols on Your Screen

When you are connected to Sprint PCS Vision services, a data connection icon 
appears at the top of the Today screen. See “Checking Signal Strength and Phone 
Status” on page 99 for a description of the various data connection icons.

Sprint PCS Vision Billing Information

See your service plan for details on Sprint PCS Vision billing.
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Personalizing Your Service With On Demand

With Sprint’s On Demand feature, you can personalize your device’s data services 
to suit your needs. The On Demand feature makes it easier than ever to retrieve 
the most popular Web information and categories instantly. On Demand uses the 
ZIP code you provide to customize the content you receive, so you can get the 
information you want, when you want it.

On Demand acts like a computer browser’s customized home page, displaying a 
variety of top categories such as News, Sports, Weather, Stocks, Showbiz, and 
more. This information is updated throughout the day, so you’ll always be up-to-
date. In addition to presenting a number of fixed categories, On Demand also 
offers optional categories (for an additional monthly charge) that allow faster 
access to even more information.

Initializing Your On Demand Service

1. Press Start  and select Programs.

2. Select On Demand . 

3. Enter your preferred ZIP code and press 
Next  (right softkey). (The On Demand 
service customizes itself to your selected 
location, and the On Demand menu screen is 
displayed. This process can take a few minutes to 
complete.) 
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Accessing On Demand Information

Finding the information you’re looking for with On Demand is as easy as 
navigating a Web browser on your computer. (The following examples illustrate 
how to access News and Movies information.)

To access News information using On Demand:

1. Press Start  and select Programs.

2. Select On Demand . (The On Demand menu 
screen is displayed.)

3. Highlight News (the button name changes to 
Late Breaking News & Photos), and then press 
Center .

4. Depending on which category you select, you see 
a menu with additional options (for this 
example, you would be able to select from such 
subcategories as “Top Stories,” “US News,” “World News,” and “Politics”).

5. Select a subcategory, and then select an article you would like to view. (The 
article is displayed.)

6. Navigate the content as follows:

� Press Up  or Down  to scroll through the article.

� If there is a link to a related article or picture, press Left  to select the 
link.

� Press Right  to access the options at the bottom of the screen.
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To access Movies information using On Demand:

1. Press Start  and select Programs.

2. Select On Demand . (The On Demand menu screen will be displayed.)

3. Highlight Showbiz (the button name changes to Hollywood News & 
Showtimes), and press Center . (A list of media options is displayed.)

4. Highlight Movie Showtimes & Reviews, and press Center . (A list of current 
movie titles is displayed.)

5. Select a movie title. 

6. From the Movie Title display, select an option and 
follow the onscreen instructions. Options 
available may include:

� Shows for Date to select a date for the movie. 

� <Theater listing> to view the movie’s 
showtimes at a number of selected movie 
theaters in your area. (Follow the onscreen 
instructions to purchase will-call tickets, 
which may not be available for all theaters or for all showtimes.)

� Details to view the movie’s details, which may include cast, running 
time, plot synopsis, MPAA rating, reviews, and so on.

Additional fixed On Demand categories such as Stocks (which features a 
customizable stock ticker [delayed 20 minutes]), Weather, and Sports (which 
allows you to select your top teams), along with optional categories such as Maps 
and TV Guide, bring the information you want right to your screen—all without 
having to go through a traditional Web search.
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Using Your Device’s Phone as a Modem

Your device’s data capabilities enable you to use your device’s phone as a modem 
for your laptop computer anywhere on the Sprint advanced wireless high-speed 
data network. You’ll be able to send and receive email, browse the Internet, and 
access your company’s network anywhere on the Nationwide Sprint PCS 
Network.

Setting Up a Data Connection With Your Computer

In order to use your phone as a modem, you’ll first need to load the Sprint PCS 
Connection Manager software on your computer, and then use the sync cable to 
connect your device to your computer.

To set up your phone-to-computer data connection:

1. Insert the Getting Started CD that came with your device into your 
computer’s CD drive and select the link to download and install the Sprint 
PCS Connection Manager software and drivers.

2. Make sure your device’s phone is turned on (see “Turning Your Phone On 

and Off” on page 18) and that one of the mobile broadband icons (  or 

)   appears at the top of the screen.

Note: To use this service, you may be required to sign up on a Sprint PCS Vision with 
Phone as Modem plan. Go to www.sprint.com or visit a Sprint Store for 
Phone as Modem plan details and more information.

http://www.sprint.com
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3. On your smart device press Start  and select 
Programs. 

4. Select Modem Link .

5. Press OK  to dismiss the message Modem Link.

6. Select the Connection list, and then select USB. 

7. Press Activate  (left softkey).

8. Once the Sprint PCS Connection Manager 
software has been fully installed on your PC, and 
the Modem Link application is activated on your smart device, connect your 
device to your computer using the sync cable. (When your computer detects 
the connection, an icon  is displayed in the taskbar in the lower-right 
corner of your computer screen.) 

9. On your computer, open the Sprint PCS Connection Manager software, select 
your device name, and then click Connect.

10. Once the connection is established, launch an Internet session, check your 
email, or do anything else you would do using a traditional Internet 
connection.

11. When you’re ready to terminate the Internet connection, double-click the 
Sprint PCS Connection Manager icon  in the taskbar in the lower-right 
corner of your computer screen, and then click Disconnect to end the 
session. 

Note: If neither icon appears, you cannot use your device as a modem with Sprint PCS 
Connection Manager.
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Note: While your mobile broadband data connection is active, you can receive 
incoming calls and place outgoing calls; however, doing either of these 
suspends the data connection until you hang up the call.

Sprint PCS Vision services are available on the Sprint Nationwide PCS Network. 
Sprint mobile broadband services work anywhere on the Sprint Nationwide 
PCS Network, but broadband-like download speeds are available only in areas 
with high-speed data coverage.
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Sec t ion 3B

Using Email and Messaging

In This Section

� About Email and Messaging

� Getting Started With Email

� Setting Up an IMAP or POP Email Account

� Sending and Receiving Email

� Sending and Receiving Text Messages

� Managing Your Messages

� Customizing Your Messaging Settings

� Using GoodLink™ Wireless Messaging

� Using Pocket MSN
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About Email and Messaging

Use the Messaging application to exchange email and brief text messages (SMS) 
with other wireless devices and email addresses that support these forms of 
messaging. You can also exchange instant messages (IM) with Pocket MSN. 
Before you use your smart device to send or receive messages, consult Sprint for 
pricing and availability of email, text, and data services.

This chapter describes the various messaging options and walks you through 
setting them up, so that you can use your device to send and receive text and 
email messages. 

Before You 
Begin:

Make sure your phone is on before you send or receive messages. 
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Getting Started With Email

You have several options for reading and sending email on your Treo™ 700wx 
smart device. Just like on your computer, you can choose from various email 
applications to manage your email. (Additional fees may apply for email 
services.) 

Your Treo700wx smart device comes with five email application options: 

If you want to, you can set up more than one application to work with separate 
email accounts.

IMAP or POP 
(Outlook)

Exchange 
Server

GoodLink™ 

Wireless 
Messaging

Hotmail 
(Pocket MSN)

Web browser

Enables you 
to send and 
receive email 
messages 
with a 
corporate 
email account 
or an account 
you have with 
an Internet 
service 
provider (ISP).

Enables you to 
wirelessly 
synchronize 
your email and 
other 
information 
directly with 
the 
information 
stored on a 
Microsoft 
Exchange 
2003 Server. 

Provides real-
time access to 
your Microsoft 
Outlook email, 
calendar, 
contacts, 
tasks, and 
notes. 

Enables you to 
send and 
receive email 
messages with 
an MSN 
Hotmail 
account.

Enables you to 
access Web-
based email.
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Which Email Application Should I Use?

If I want to … I can use …

Outlook Exchange 
Server

GoodLink Hotmail Web 
browser

Check email from a POP or IMAP 
account

Access email from multiple email 
accounts

Check fee-based Internet mail, 
such as Yahoo! Mail Plus or AOL

Sync my email and organizer 
information with my company’s 
Exchange server

Use the Advanced Encryption 
Standard (AES) while sending and 
receiving messages

Check my Hotmail account

Check other free Web mail, such as 
Gmail or Yahoo!
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Tip: You can receive email messages in various formats, including HTML, RTF, 
and plain text.

Did You 
Know?

If your email account requires a VPN connection to establish a secure 
connection, VPN servers may require that you install specific VPN 
software (sold separately) on your smart device before you can access 
your email. See “Connecting to a VPN” on page 310 for more information.
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Setting Up an IMAP or POP Email Account

You can send and receive email messages with an email account that you have 
with an Internet service provider (ISP), an email account that you access using a 
VPN server connection (such as a work account), or any other IMAP (Internet 
Message Access Protocol) or POP email account.

How Do I Get Started?
Work with your system administrator to gather the following information:

� Account type (POP3 or IMAP).

� Mail server name for receiving mail.

� Mail server name for sending mail.

� Your username and password.

� Domain name.

� Any special security requirements.

If you have problems configuring your account, go to www.palm.com/emailsetup 
for more information.

Note: If you have multiple email accounts, you must enter settings for each 
email account.

http://www.palm.com/emailsetup


Section 3B: Using Email and Messaging 121

M
essagin

g

Setting Up Email to Work With Common Providers
1. Go to your Today screen.

2. Press Messaging  (left softkey).

3. Press Menu  (right softkey) and select 
Tools > New Account.

4. Enter the email address that you want to set 
up, and then press Next  (right softkey).

5. Wait until the Status box displays Completed, 
and then press Next  (right softkey).

6. Enter your name, username, and password.

7. If you want to enter your password each time 
you access this account, do not check the Save 
password box. (If you want your password 
entered automatically, check this box.)
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8. Press Next  (right softkey).

9. Select the Account type list, and then select POP3 
or IMAP.

10. Enter a name for this account, and then press 
Next  (right softkey). (For example, if this is 
your work email account, enter “Work” or your 
company’s name.)

11. Enter the name of the Incoming mail and 
Outgoing mail servers. (Do not enter anything in 
Domain. It is not needed for POP3 or IMAP 
accounts.)

12. (Optional) Select Options to select download 
settings for this account.

13. Press Finish  (right softkey).

Tip: To set up additional email accounts, press Menu, select Tools, and then 
select New Account. Enter the account information in the 
E-Mail Setup wizard.

Tip: To delete an email account, press Menu and select Tools > Options. 
Highlight the account you want to delete. Press and hold Center on the
5-way, and then select Delete.
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Sending and Receiving Email

Creating and Sending an Email Message

You can receive plain text and HTML messages.

1. Go to your Today screen.

2. Press Messaging  (left softkey).

3. Press Left  to cycle through your Messaging accounts until you see the 
email account you want to use in the title bar.

4. Press New  (left softkey).

5. Do one of the following to address the 
message:

� If the recipient’s name and email address 
are in your Contacts list, enter the first few 
letters of the recipient’s first or last name, 
and then select the recipient’s name.

� If the recipient’s name is in an online 
address book, you can find the name and 
add it. (For more information, see “Using an 
On-line Address Book” on page 145.)

� If the recipient’s name and email address are not in your Contacts list, 
enter the full email address. 

Tip: You can also access the Messaging application from the Start menu.
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6. Select Subject and enter a title for the message.

7. Enter your message, or press Menu  (right softkey), select My Text, and 
then select a predefined phrase you want to insert. 

8. (Optional) Do any of the following:

� Press Menu  (right softkey) and select Insert. (Select the type of 
item you want to attach, and then select the file or record a voice note.) 

� Press Menu  (right softkey) and select Spell Check.

� Press Menu  (right softkey) and select Message Options. Select the 

Priority list, select a setting for the message, and then press OK .

9. Press Send  (right softkey).

Synchronizing Your Default Email Account

To send and receive messages for your default email account, simply synchronize 
your smart device with your computer. See “Setting the Synchronization 
Schedule” on page 265 for details. During synchronization, new messages are 
copied to your smart device’s Inbox, and messages in the smart device’s Outbox 
are sent.

Tip: Not ready to send that message yet? You can save it without sending it. 
While creating a message, press Menu and select Save to Drafts. To access 
the draft, select the Show list in the upper-left, and then select Drafts. 

Did You 
Know?

If you are out of a coverage area or if your phone is off, your outgoing 
messages go into the Outbox. When you return to a coverage area, your 
pending messages are sent automatically and transferred to the Sent 
folder.
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Synchronizing Your Other Email Accounts

To send and receive email messages for additional email accounts, such as an 
Internet Service Provider (ISP) account or an account that you access using a VPN 
server connection (typically a work account), follow these steps:

1. Go to your Today screen.

2. Press Messaging  (left softkey).

3. Press Left  to cycle through your Messaging accounts until you see the 
account you want to download in the title bar.

4. Press Menu  (right softkey) and select Send/Receive to synchronize 
your smart device with your email server.

Receiving Attachments

You can receive and open attachments in a number of different formats, 
including Word, Excel, PPT, and PDF. To receive and open attachments, do the 
following:

1. Select the attachment (below the subject) to mark it for download.

2. Synchronize the email account that contains the message as described in 
the previous sections.

3. Select the attachment to open it.

Tip: Your computer must be connected to the Internet when you sync your 
email.
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If you have a Microsoft Office Outlook email account and want to download 
attachments automatically, do the following: 

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu  (right softkey) and select Options. 

4. Select E-mail, and then select Settings.

5. Check the Include file attachments box. 

6. Press OK .

To automatically download attachments from an IMAP4 email account (typically 
an ISP account) or an account that you access using a VPN server connection 
(typically a work account), do the following: 

1. Go to your Today screen.

2. Press Messaging  (left softkey).

3. Close any open messages.

4. Press Menu  (right softkey) and select Tools > Options.

Did You 
Know?

Embedded images and objects cannot be received as attachments, 
unless you have an IMAP4 email account with TNEF disabled. Note that 
TNEF must be enabled to receive meeting requests.

Tip: To store attachments on an expansion card, press Menu, select Tools > 
Options. Select Storage and then check the Store attachments on a storage 
card box.
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5. On the Accounts tab, select the IMAP4 account name. 

6. Press Next  (right softkey) until you reach Server information, and then 
select Options. 

7. Press Next  (right softkey) twice, and then select Get full copy of 
messages and When getting full copy, get attachments. 

Using Links in Messages

When you receive a text or email message that contains a telephone number, 
email address, or URL, you can dial the number, send an email message, or go to 
the Web page immediately. Your smart device automatically opens the 
appropriate application from the link.

1. Select a message in the list.

2. Select the phone number, email address, or URL (appears as underlined blue 
text).

Forwarding a Message
1. Open the text or email message you want to forward.

2. Press Menu  (right softkey) and select Forward.

3. Address the message and enter any text you want to add.

4. Press Send  (right softkey).
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Sending and Receiving Text Messages

Creating and Sending a Text Message

Each text message can hold up to 160 characters. To save time, you can select 
from predefined My Text phrases, such as “Call me” or “On my way.” You can add 
your own My Text phrases, and if you prefer, you can enter the full message text 
too.

1. Go to your Today screen.

2. Press Messaging  (left softkey).

3. Press Left  until you see Text Messages in the title bar.

4. Press New  (left softkey).

5. Do one of the following to address the 
message:

� If the recipient’s name and wireless number 
are in your Contacts list, type the first few 
letters of the first or last name or simply 
enter the first initial, followed by a space, 
and then the last initial to find a name. (You 
can enter the first few numbers of a 
contact’s wireless phone number.)

� If the recipient’s name is in an online address book, press Center , 
enter the name, press Menu  (right softkey), and then select Find 
Online. (Select the name, and then select to use either the phone 
number or email address. For more information, see “Using an On-line 
Address Book” on page 145.)
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� If the recipient’s name and wireless number are not in your Contacts list, 
enter the full wireless number or email address. 

� To address a message to multiple recipients, separate the addresses 
with a semicolon (;). (If you address a single text message to three 
people, you are billed for three messages.)

6. Enter your message, or press Menu  (right softkey), select My Text, and 
then select a predefined phrase you want to insert. 

7. (Optional) Press Menu  (right softkey) and select Spell Check.

8. (Optional) Press Menu  (right softkey) and select Message Options. 

Enter a callback number and then press OK .

9. Press Send  (left softkey).

Receiving Text Messages

When your phone is on and you are in a wireless coverage area, you automatically 
receive new text messages. You can also set your smart device to notify you when 
a new text message arrives.

The new message notification may include either of the following options:

� Reply: Opens a message addressed to the sender’s phone number.

Did You 
Know?

You can send and receive text messages even while you are on a phone 
call. This is easiest when using a hands-free headset or the 
speakerphone.

Tip: Some symbols can’t be used in text messages. Invalid characters are 
automatically replaced by the Messaging application.
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� Menu: Opens a menu where you can select other options.

Did You 
Know?

When you respond to a text message from the SMS list view, you can 
change the phone number before sending the response. Open the text 
message and edit the phone number, or add an area code or country 
code. Enter your reply text and select Send to send the message.

Did You 
Know?

When viewing a message, you can press Right on the 5-way to move to 
the next message in that account, or press Left on the 5-way to move to 
the previous message in that account.
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Managing Your Messages

The status icons that appear next to each message in the Inbox and Outbox 
indicate the following:

 An unread text message.

 A read text message.

An unread email message.

A read email message.

 An urgent message. (This icon appears below the message size on the right 

side of the screen.)

You can rearrange the messages in any folder or account. 

1. Go to the Messaging account you want to arrange.

2. Select the Sort by list in the upper-right, and then select the sort method 
you want to use.

You can delete several messages at once from any folder.

1. Go to the Messaging account you want to delete the messages from.

2. Highlight the message(s) you want to delete. (To select multiple messages, 
tap and drag the stylus across the messages.) 

Tip: Unread messages appear in bold. Messages you’ve read appear in 
plain text. 
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3. Press Menu  (right softkey) and select Delete.

Adding a Signature to Your Messages

You can use a different signature with each Messaging account.

1. Go to the Messaging list.

2. Press Menu  (right softkey) and select Tools > Options.

3. On the Accounts tab, select Signatures.

4. Select the account you want to create a signature 
for.

5. Check the box to add this signature to new 
messages you create with this account.

6. (Optional) Check the box to add this signature to 
messages you reply to or forward with this 
account.

7. Select the default signature text and enter the 
signature text you want to use.

8. Press OK .

Tip: To permanently remove messages from the Deleted Items folder, press 
Menu and select Tools > Empty Deleted Items.

Did You 
Know?

If you are working offline, messages that you deleted from the server are 
deleted from your smart device the next time you connect, or according 
to the options you selected.
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Customizing Your Messaging Settings

1. Go to the Messaging list.

2. Press Menu  (right softkey) and select Tools 
> Options.

3. Select the Message tab and set any of the 
following options:

� When replying to e-mail, include body: 
Indicates if the body of a message you 
received appears in your response to that 
message.

� Keep copies of sent items in Sent folder: Indicates if messages you send are 
stored in the Sent folder.

� After deleting or moving a message: Specifies what you want to appear 
after you delete or move a text or email message.

4. Select the Address tab and set any of the following options:

� In Contacts, get e-mail addresses from: 
Indicates whether you want to check 
Contacts in addition to any directory services 
for email addresses.

� Verify names using these address books: 
Indicates which directory services you want 
to check for email addresses.

� Add: Lets you add directory services to the 
list of online address books.
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5. Select the Storage tab and set any of the following options:

� Store attachments on storage card: Indicates 
that you want to automatically store email 
attachments on an expansion card.

� Empty deleted items: Indicates whether you 
want to automatically empty the Deleted 
Items folder, and when you want this to 
occur.

6. Press OK .
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Using GoodLink™ Wireless Messaging

You can install the optional GoodLink software for secure, access to your Microsoft 
Outlook email, calendar, contacts, tasks, and notes. GoodLink offers push 
synchronization of email and personal information; as messages are received on 
the server, they are automatically downloaded to your device.

 For more information and to sign up, visit www.good.com.

1. Press Start  and select Programs.

2. Select Get Good .

3. Follow the onscreen instructions to download and install the software. 

After you install GoodLink on your device:

1. Press Start  and select Programs.

2. Select GoodLink  to open the application.

Before You 
Begin:

To use the optional Goodlink software, you must activate Sprint PCS 
Vision data services. See “Enabling Sprint PCS Vision” on page 106 for 
more information.

http://www.good.com
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Using Pocket MSN

Pocket MSN provides quick access to the following:

� MSN Hotmail: Lets you read, write, send, and delete email. You can also 
manage your Hotmail folders.

� MSN Messenger Contacts list: Lets you see who’s online and exchange instant 
messages (IM). Subscribe to status updates for selected contacts so you’re 
notified when they’re online.

� Options: Lets you customize your Pocket MSN experience.

Before You 
Begin:

To use Pocket MSN, you must activate Sprint PCS Vision data services. See 
“Enabling Sprint PCS Vision” on page 106 for more information.

Did You 
Know?

To add Pocket MSN to your Today screen, see “Selecting Which Items 
Appear on Your Today Screen” on page 276.

Tip: When you set up a Pocket MSN Hotmail account, you can access that 
account in the Messaging application. To access your instant messages, 
use the MSN application or the MSN plug-in on the Today screen.
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Signing In to Pocket MSN

1. Press Start  and select Programs.

2. Select Pocket MSN.

3. Select MSN Mobile Home.

4. Select Sign in.

5. Enter the email address and password for your 
Passport account or your Hotmail account. 

� To create a Passport (IM) account, go to 
www.passport.com.

To create a Hotmail account, go to www.hotmail.com.

http://www.passport.com
http://www.hotmail.com
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Sect ion 3C

Using Exchange ActiveSync 

In This Section

� Setting Up an Exchange Server Account

� Setting a Sync Schedule With an Exchange Server

� Using an On-line Address Book

You can wirelessly synchronize the email, contacts, and other information on 
your smart device with a Microsoft Exchange Server by using ActiveSync® 
synchronization software. 
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Before You Begin
� To wirelessly synchronize your device with a Microsoft Exchange Server, you 

must activate Sprint PCS Vision data services. See “Enabling Sprint PCS 
Vision” on page 106 for more information.

� Install the ActiveSync software from the Getting Started CD. See “Installing 
the Desktop Synchronization Software” on page 31 for more information.

� Work with your system administrator to gather the following information: 

� Exchange Server address and domain name.

� Your username and password.

Direct Push Technology

Direct Push Technology uses an Internet Protocol (IP)-based methodology rather 
than SMS-based methodology, resulting in lower network overhead, lower costs, 
and more efficient communications. These features include Global Address 
List (GAL), Tasks Over The Air (OTA), and IP-based push updating of Outlook 
information (Email, Calendar, Contacts, and Tasks). 

For delivery of Outlook email using Direct Push Technology, make sure that your 
Exchange Server 2003 is upgraded to Service Pack 2. Ask your system 
administrator if these synchronization features are enabled.
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Setting Up an Exchange Server Account

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu  (right softkey) and select Add Server Source. 

4. Enter the Server address, and then press Next  (right softkey). 

5. Enter your username, password, and domain. The password is case-
sensitive. (Your password can use numbers and text. Check if your Caps Lock 
and Option Lock are active because that can affect the password you are 
entering. See “Entering Lowercase and Uppercase Letters” on page 48 and 
“Entering Numbers, Punctuation, and Symbols” on page 48.)

6. If you want to enter your password each time you access this account, do 
not check the Save password box. (If you want your password entered 
automatically, check this box.)

Tip: If you already set up an Exchange Server account, Add Server Source does 
not appear on the menu; Configure Server appears on the menu instead.

Tip: The Exchange Server settings are case-sensitive. Be sure to enter 
uppercase and lowercase letters properly.
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7. (Optional) Select Advanced to set the rules for 
fixing sync conflicts.

8. Press Next  (right softkey) and check the 
boxes for the types of information you want 
to synchronize with Exchange Server. 

9. (Optional) Highlight one of the items and 
select Settings to change the synchronization 
settings for that type of information. 

10. Press Finish  (right softkey). 

11. Set your sync schedule. (See “Setting a Sync Schedule With an Exchange 
Server” on page 144.)

Tip: Ask your system administrator if it is OK to store your corporate email 
password on your smart device. You may need to enter your password 
each time you access your email for increased security.
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Note: Settings are not available for all items. If you want to download more 
than the email message header, select E-mail in step 9 and increase the 
KB setting. If you don’t increase this setting, you can manually download 
the rest of the message at your convenience.
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Setting a Sync Schedule With an Exchange Server

Follow these steps to set your sync schedule:

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu  (right softkey) and select 
Schedule.

4. Set your schedule for peak and off-peak times. 
(To conserve power it is recommended to 
change your settings to synchronize every 30 
or 60 minutes instead of as items arrive.)

5. Set your roaming preference. (If roaming charges are not a concern, select 
Use above settings when roaming.)

6. Press OK .

Before You 
Begin:

Set up an Exchange Server email account. See “Setting Up an Exchange 
Server Account” on page 141.
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Using an On-line Address Book

Adding an Online Address Book

Many email servers, including servers running Exchange Server, can verify names 
with an online address book, also called a directory service or a Global Address 
List. After you enter settings for an email account, Messaging checks your contact 
list and then the directory service to verify names that you enter in the To, Cc, and 
Bcc fields. 

1. In the message list, press Menu  (right softkey) and select Tools > 
Options.

2. Select the Address tab. 

3. Select the address book you want to check for email addresses, and then 
select Add. 

4. Enter the name of the Directory service.

5. Enter the Server name.

6. If your server requires authentication, check the box, and then enter your 
username and password. 

Before You 
Begin:

Do the following:
� Ask your system administrator for the name of the directory service 

and the server, and whether authentication is required for accessing 
an online address book.

� If your company is using an Exchange Server 2003 upgraded to 
Service Pack 2, you must first synchronize with the Exchange Server 
to enable the Global Address List to find a Contact.
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7. (Optional) Check the Check name against this server box to enable this 
directory service.

8. Press OK .

Using an Online Address Book

You can access contact information, such as an email address or phone number, 
from your organization’s online address book or Global Address List (GAL). To 
access a GAL, make sure you are accessing an Exchange Server 2003 upgraded to 
Service Pack 2. This feature is useful only if you know the exact name as it 
appears in the directory. 

1. In a new message, tap the To box. 

2. Press Menu  (right softkey), and select Add Recipient.

3. Press Menu  (right softkey), and select Find Online. 

4. Enter the contact name as it appears in the directory and tap Find. (You 
must spell the contact name correctly.)

If your organization’s GAL uses abbreviated extension numbers, you can set your 
device to automatically dial the complete number. See “Setting Your Abbreviated 
Dialing Preferences” on page 92 for more information.

Optional: To delete a directory service, highlight it, press and hold Center on the 
5-way, and then select Delete.

Did You 
Know?

You can use the Global Address List to find a contact. In Contacts, press 
Menu, and then select Find Online. When sending a meeting request, 
select Attendees, press Menu, and then select Find Online. 
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Tip: When you sync your Microsoft Office Outlook email account, disable 
your online address books to avoid errors. Press Menu and select Tools > 
Options. Select Address and uncheck the Check name against this server 
box. 
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Sec t ion 3D

Browsing the Web

In This Section

� Viewing a Web Page

� Working With Favorites

� Working With Web Pages

� Customizing Your Internet Explorer Mobile Settings

Internet Explorer Mobile provides quick and easy access to Web pages. You can 
view most sites you use on your computer, including those with security and 
advanced features, such as JavaScript and frames. 

To browse the Web, you must activate Sprint PCS Vision data services. (See 
“Enabling Sprint PCS Vision” on page 106.) Internet Explorer Mobile supports 
JavaScript, Secure Sockets Layer (SSL), and cookies, but does not support plug-ins 
(Flash, Shockwave, etc.) or Java applets.
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Viewing a Web Page

By default, Internet Explorer Mobile scales Web page content to fit your smart 
device screen so that you can view most of the information without scrolling left 
or right.

1. Make sure your phone is on (see “Turning Your Phone On and Off” on 
page 18).

2. Press Start  and select Internet Explorer.

3. Highlight the address line, enter the address of 
the Web page you want to view, and then press 
Center . (If you browse to a secure Web page, 
the Lock icon in the address line appears closed 
instead of open.)

4. Press Menu  (right softkey), select View, 
and then select any of the following:

� One Column: Arranges Web pages into one 
column that is as wide as the screen, so that 
you don’t have to scroll horizontally. 

� Default: Maintains a layout similar to what you see on a desktop 
computer, but it makes items smaller and arranges the content so that 
you can see most of it without scrolling horizontally. 

Did You 
Know?

You can also start a Web search from your Today screen by selecting the 
Web Search field, entering the item you want to find, and then pressing 
Center on the 5-way. 



Section 3D: Browsing the Web 151

B
row

sin
g th

e W
eb

� Desktop: Keeps the same layout and size as on a desktop computer, 
which requires both horizontal and vertical scrolling.

� Full Screen: Hides the status and navigation areas and fills the entire 
screen with the Web page. (To exit full screen mode, press  (right 
softkey) or  (left softkey). You can also tap and hold anywhere on 
the screen and uncheck Full Screen.)

� Show Pictures: Shows or hides pictures on Web pages. (Hiding pictures 
speeds up the time it takes to load pages.)

5. Do any of the following:

� To view the previous page, press Back  (left softkey) or 

Backspace .

� To refresh the page with the latest content from the Internet, press 
Menu  (right softkey) and select Refresh.

� To scroll through the page in One Column view or Default view, press 

Up  or Down . (In Desktop view, press Up , Down , Left , or Right 

 to scroll in all directions.)

� To follow a link to another Web page, press Up  or Down  to 
highlight the link, and then press Center  to go to the selected page. 
(You can also tap the link on the screen with your stylus.)

� To adjust the size of the text on Web pages, press Menu  (right 
softkey), select Zoom, and then select the size you want.

Tip: To send a link, press Menu and select Tools > Send Link via E-mail. Select the 
Messaging account you want to use to send the link.
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� To view a Web page’s properties, press Menu  (right softkey) and 
select Tools > Properties.

� To view each item in a list, tap the list with your stylus.

� In a list, press Down  or Left  to cycle between items, and press 
Center  to accept the change.

� In a form, such as a browser search field, press Center  to interact 
with the form, and then press Center  to stop interacting with the 
form.

6. Press OK  to close Internet Explorer Mobile.

Did You 
Know?

You can send email from a Web page. Email addresses appear as links on 
Web pages. After you configure an email application on your smart 
device, you can select an email link to create a message to that address.

Tip: To return to a recently viewed page, select the address line list, and then 
press Down. Use the 5-way to select a Web address from the list.

Did You 
Know?

The security certificates and 128-bit SSL strong encryption let you browse 
secure sites, such as online shopping, banking, and email. Remember, 
some secure sites also require specific browsers and may not work with 
Internet Explorer Mobile. Ask the organization for an alternate access 
point that is compatible with Internet Explorer Mobile.
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Working With Favorites

Favorites lets you bookmark a Web page so that you can instantly access it 
without entering the Web address. 

Creating a Favorite
1. Go to the page you want to mark as a favorite. 

2. Press Menu  (right softkey) and select Add 
to Favorites.

3. (Optional) Select Name and enter a different 
description.

4. (Optional) Select the folder where you want to 
create the favorite.

5. Select Add.

Viewing a Favorite

1. Press Start  and select Internet Explorer.

2. Select Favorites  (left softkey).

3. Press Down  to highlight the page you want to view in the list, and then 
press Center  to go to the selected page.

Tip: Create the folders where you want to store your favorites first. Once you 
create a favorite, you can’t move it to another folder.
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Organizing Your Favorites

You can create folders to organize your favorites. For example, you can store 
travel links in one folder, stock links in another, and business links in a third folder.

1. Press Start  and select Internet Explorer.

2. Select Favorites  (left softkey).

3. Select the Add/Delete tab.

4. Select New Folder.

5. Enter a name for this folder, and then select Add. 

6. Press OK .

Tip: To delete a favorite or folder, select Favorites (left softkey). Select the Add/
Delete tab, highlight the item you want to delete, and then select Delete. 
Select Yes to confirm the deletion, and then press OK.
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Working With Web Pages

Downloading Files and Images From a Web Page

You can download files that are usable on your smart device, such as new 
applications, MIDI ringtones, or pictures that are specifically tagged for 
download. 

1. Go to the page that contains the link to the file you want to download.

2. Press Left  or Right  to highlight the link to the file.

3. Press and hold Center , and then select Save As to download a file, or tap 
and hold, and then select Save Image to download an image.

4. Select Name and enter a new name for the file. 

5. Select the Location list, and then select where you want to store the file: 
Main memory or Storage card. 

6. Select the Folder list, and then select the folder where you want to save the 
file. 

7. Press OK .
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Copying Text From a Web Page

You can copy text from a Web page and paste it in other applications. 

1. Use the stylus to highlight the text you want to copy.

2. Press Menu  (right softkey) and select Edit > Copy. 

3. Go to the application in which you want to paste, and then position the 
cursor where you want to paste the text.

4. Press Menu  (right softkey) and select Edit > Paste. 

Using the History List

The History list stores the addresses of the pages you visited recently.

1. Press Menu  (right softkey) and select History. 

2. (Optional) Select the Show list in the upper-left, and then select how you 
want to sort the History list.

3. Select the Web page you want to view. 

Tip: You can copy the text from the entire Web page. Tap and hold on the 
page, and tap Select All Text. Tap and hold on the page again, and tap 
Copy.
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Customizing Your Internet Explorer Mobile Settings

1. Press Menu  (right softkey) and select Tools > Options. 

2. On the General tab, set any of the following 
options:

� Home Page: Sets the page that appears when 
you open Internet Explorer Mobile. (To use 
the page you were on when you opened the 
menu, select Use Current. To select the 
original Sprint PCS Vision home page, select 
Use Default.)

� Encoding: Sets the character set for the Web 
pages you view.

3. Select the Memory tab and set any of the 
following options:

� Save links to pages visited in the past: Sets how 
many days of activity the History list stores.

� Clear History: Empties the History list.

� Delete Files: Removes saved pages and Web 
files that you synchronized with your 
computer.
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4. Select the Security tab and set any of the following options:

� Allow cookies: Sets whether your smart 
device accepts cookies (small files containing 
information about your identity and 
preferences). (The page sends the file and 
stores it on your smart device.)

� Clear Cookies: Deletes any cookies stored on 
your smart device.

� Warn when changing to a page that is not 
secure: Sets whether a message appears 
when you switch from a secure page to one that is not secure.

� Warn when page content is blocked due to security settings: Sets whether a 
message appears when you attempt to open a page that does not meet 
your smart device’s security standards.

5. Press OK .
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Sec t ion 3E

Using Infrared and Bluetooth® Wireless Technology 

In This Section

� Connecting to Devices With Bluetooth® Wireless Technology

� Beaming Information With IR
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Connecting to Devices With Bluetooth® 
Wireless Technology

With your smart device’s built-in Bluetooth® wireless technology, you can connect 
to a number of Bluetooth devices such as a headset, hands-free car kit, or GPS 
receiver, as well as to other phones and handhelds. For a list of hands-free devices 
with Bluetooth wireless technology that are compatible with your smart device, 
go to www.palm.com/us/support/bluetooth.

If your computer is enabled with Bluetooth wireless technology, you can also 
synchronize wirelessly.

Did You 
Know?

If you’re using a hands-free Bluetooth device and it is within range, your 
smart device routes all calls to the hands-free device instead of to your 
smart device’s earpiece. Bluetooth range is up to 30 feet in optimum 
environmental conditions.

Tip: The Bluetooth icon on your Today screen indicates the status of your 
smart device’s Bluetooth feature: 
Gray = Bluetooth off.
Blue = Bluetooth on.
White = Connected to a Bluetooth device.
Headset = Call in progress with a Bluetooth headset or car kit.

Note: Sprint PCS Voice Command service cannot be used with wireless 
headsets that are enabled with Bluetooth.

http://www.palm.com/us/support/bluetooth
http://www.palm.com/us/support/bluetooth
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Setting Up a Bluetooth Connection

After you set up a connection with a Bluetooth device, you can communicate 
with that device whenever it is within range (about 30 feet) and your smart 
device’s Bluetooth feature is turned on. 

1. If necessary, prepare the device you want to 
connect with to accept a new connection. 
(Check the device’s documentation for 
details.)

2. Go to your Today screen, and then tap 

Bluetooth .

3. Check the Turn on Bluetooth box to turn on 
your smart device’s Bluetooth feature.

4. Select the Devices tab, and then select New 
Partnership.

5. Wait for your smart device to search for devices 
and to display the device list.

6. Select the device you want to connect with, and 
then press Next  (right softkey).

Tip: Your smart device supports only call audio with Bluetooth headsets. It 
does not support stereo music playback with Bluetooth headsets 
(enabled with Bluetooth A2DP profile).
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7. Enter an alphanumeric passkey between 1 and 16 characters long, and then 
press Next  (right softkey).

8. If the passkey is not built-in, enter the same 
passkey on the smart device and the other 
Bluetooth device, and then press Finish  
(right softkey).

9. If you’re connecting to a headset or hands-free 
car kit, check the Hands Free box, and then press 
Finish  (right softkey). 

10. If you’re connecting to a GPS device, press Finish  (right softkey), select 
the COM Ports tab, select the GPS device you selected in step 6, and then 
select New Outgoing Port. (Press Finish  (right softkey). After you set the 
partnership and COM port, you can configure the GPS settings (see “Setting 
Up a GPS Device” on page 298). Be sure to select the same port you have 
assigned for GPS here.)

11. Press OK .

You can now communicate with this device whenever it is within range (about 
30 feet) and your smart device’s Bluetooth feature is turned on (see steps 2 and 3 
earlier in this section).

Important: Some Bluetooth devices have a built-in passkey; others let you choose the 
passkey. See the documentation for the Bluetooth device for more 
information.
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Sending Information Over a Bluetooth Connection

You can send an individual entry or file.

1. Make sure the receiving device is ready to 
receive a Bluetooth connection.

2. Highlight the entry or file you want to send.

3. Press Menu  (right softkey) and select 
Beam… (the menu item changes names based 
on the type of item you highlighted). 

4. Select the receiving device in the list. (A red icon 
indicates an IR connection, and a blue icon 
indicates a Bluetooth connection.)

When the transmission is complete, “Done” appears next to the name of the 
receiving device.

Tip: To delete the established partnership with a device, go to the Bluetooth 
Settings screen and select Devices. Highlight the connection you want to 
remove, press and hold Center on the 5-way, and then select Delete. The 
deleted device can no longer automatically connect with your smart 
device.

Tip: Check your battery level before establishing a Bluetooth connection. If 
the battery level is low, you can’t make a Bluetooth connection.
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Receiving Information Over a Bluetooth Connection 

1. Go to your Today screen, and then tap Bluetooth .

2. Check the Turn on Bluetooth box to turn on your smart device’s Bluetooth 
feature.

3. Press OK .

4. If you have already set up a partnership with the transmitting device, your 
smart device is ready to receive the information. (If you haven’t set up a 
connection, check the Make this device discoverable to other devices box to let 
the device find your smart device and request a connection.)

5. When your smart device is receiving information, a notification tells you 
that a transmission is in progress. (To stop the transmission, press Cancel 

 [left softkey]; to close the notification, press Dismiss  [right 
softkey].)

Tip: If you have trouble receiving information over a Bluetooth connection, 
press Start and select Settings. Select the Connections tab, and then select 
Beam. Make sure the Receive all incoming beams box is checked.
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Synchronizing Over a Bluetooth Connection

1. Set up your computer for Bluetooth wireless communication. (See the 
documentation that came with your computer for details. In most cases 
your computer must support the Virtual Serial Port profile and this profile 
must be turned on.)

2. Set up ActiveSync on your computer for Bluetooth wireless communication. 
See ActiveSync Help on your computer for details.

3. Go to your Today screen, and then tap Bluetooth .

4. Check the Turn on Bluetooth box to turn on your smart device’s Bluetooth 
feature.

5. Press OK .

6. Press Start  and select Programs.

7. Select ActiveSync .

8. Press Menu  (right softkey) and select Connect via Bluetooth.

9. If this is the first time you’re making a Bluetooth connection to this 
computer, follow the onscreen prompts to set up a Bluetooth partnership 
with this computer. 

Before You 
Begin:

� Make sure your computer is equipped with Bluetooth wireless 
technology.

� Install the synchronization software from the CD that came with 
your smart device, if you have not already done so. See “Installing 
the Desktop Synchronization Software” on page 31.
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10. Select Sync.

11. When synchronization has finished, press Menu  (right softkey) and 
select Disconnect Bluetooth. 

Tip: Wi-Fi routers, microwaves, and wireless telephones using the 2.4GHz 
band may interfere with Bluetooth connections. For best results, move 
away from this equipment when making a Bluetooth connection. If you 
cannot move away, move the Bluetooth devices closer to improve the 
reception.
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Beaming Information With IR

Your smart device is equipped with an IR (infrared) port that lets you beam 
information to another device with an IR port. The IR port is located on the top of 
your smart device, between the antenna and the Ringer switch, behind the small 
dark shield. 



168 Section 3E: Bluetooth/IR

Beaming a Record
1. Highlight the entry or file you want to beam.

2. Press Menu  (right softkey) and select 
Beam… (the menu item changes names based 
on the type of item you highlighted).

3. Point the IR port on your smart device directly at 
the IR port of the receiving device.

4. When the name of the receiving device appears, 
select it to begin the transfer. (A red icon 
indicates an IR connection.)

5. Wait for “Done” to appear next to the name of the receiving device before 
you continue using your smart device.

Receiving Beamed Information
1. Turn on your screen.

2. Point your smart device’s IR port directly at the IR port of the transmitting 
device.

3. When the Receiving Data message appears, select Yes to receive the beam.

Tip: For best results, the path between the two devices must be clear of 
obstacles, and both devices kept stationary. If you have difficulty 
beaming, shorten the distance and avoid bright sunlight.

The type of information you can beam depends on the type of device you 
are beaming to. Windows Mobile® devices are always compatible with 
the Treo device.
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Synchronizing Over an Infrared Connection

1. Set up your computer to receive infrared beams. (See ActiveSync Help on 
your computer for details.)

2. Point your smart device’s IR port directly at the IR port on your computer.

3. On your smart device, press Start  and select Programs.

4. Select ActiveSync .

5. Press Menu  (right softkey) and select Connect via IR.

6. Select Sync.

Tip: If you can’t receive beamed information, press Start and select Settings. 
Select the Connections tab, and then select Beam. Make sure the Receive 
all incoming beams box is checked. If you still can’t receive information, try 
a soft reset (see “Resetting Your Smart Device” on page 320).
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Sec tion 4A

Working With Your Pictures and Videos

In This Section

� Taking Pictures and Videos

� Viewing a Picture or Video

� Sending a Picture or Video

� Creating a Video Ringtone

� Organizing Pictures and Videos

� Using a Picture as the Today Screen Background

� Editing a Picture

� Customizing Your Camera Settings

� Viewing Pictures and Videos on Your Computer
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Your Treo™ 700wx smart device comes with an easy-to-use, built-in, 1.3-
megapixel camera with 2x digital zoom (camera not included with all smart 
devices). You can use the camera to take and view pictures and videos and send 
them to your friends and family. To add a personal touch to your smart device, 
use your pictures as your Today screen background, and as caller ID images, or use 
your videos to create video ringtones.

Even if your smart device does not have a camera, you can still receive and view 
pictures and videos, and send pictures and videos as attachments. You can also 
personalize your smart device by using a picture as a background or by adding a 
picture to a contact; see “Assigning a Picture and Ringtone ID to a Contact” on 
page 89 for details. You can also move pictures and videos to a computer by 
synchronizing your smart device with your computer. 

Did You 
Know?

Pictures are captured and stored in 16-bit color, JPG format. Resolution 
settings range from 1280 x1024 to 160 x 120 pixels (1.3-megapixels to 
VGA). You can change the default setting. See “Customizing Your Camera 
Settings” on page 185 for details. 
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Taking Pictures and Videos

Taking a Picture

By default, pictures are stored in the My Pictures folder on your smart device. If 
you want to store your pictures on an expansion card, see “Customizing Your 
Camera Settings” on page 185 to change where pictures are stored. For 
information on accessing your pictures on your computer, see “Viewing Pictures 
and Videos on Your Computer” on page 187.

Your device has a self-portrait mirror next to the camera lens on the back of your 
device. Use the mirror when you’re taking a picture or video and you want to be 
in the picture too.

1. Press Start  and select Pictures & Videos. 

2. Select Camera .

3. Adjust the position of your smart device until you see the subject you want 
to photograph on the screen.

Tip: If you see a camcorder icon below the preview image, video mode is on. 
To turn on the still camera, press Menu and select Still Mode. 
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4. (Optional) Adjust any of the following: 

� Zoom: Press Up  to zoom in, or Down  to 
zoom out.

� Brightness: Press Right  to increase the 

brightness or Left  to decrease the 
brightness.

� Resolution: Press Menu  (right softkey) 
and select Resolution to change the image 
quality.

5. (Optional) Set a 5-second timer: Press Menu  (right softkey), select 
Mode, and then select Timer.

6. Press Center  to capture the picture or start the timer.

7. Hold your device still until the picture renders, and then do one of the 
following:

� Press Camera  (left softkey) to take another picture.

� Press OK  to return to the Thumbnails view. 

Tip: You can also adjust the zoom and brightness by pressing Menu and 
selecting Zoom or Brightness.

Did You 
Know?

After three minutes of inactivity when previewing an image, the camera 
goes into standby mode. Press any key or tap the screen to return to the 
image preview.
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Taking Pictures in Burst Mode

Burst mode takes five pictures in quick succession, with one button press. 

1. Press Start  and select Pictures & Videos. 

2. Press Camera  (left softkey).

3. Press Menu  (right softkey) and select Mode > Burst.

4. Press Center .

Recording a Video

Videos can be any length, provided you have ample storage space available. By 
default, videos are stored in the My Pictures folder on your smart device. If you 
want to store your videos on an expansion card, see “Customizing Your Camera 
Settings” on page 185 to change where videos are stored. For information on 
accessing your videos on your computer, see “Viewing Pictures and Videos on 
Your Computer” on page 187. Videos are captured and stored in 3G2 format. 
Video resolution settings range from 352 x 288 to 176 x 144 pixels.

1. Press Start  and select Pictures & Videos.

2. Select Camera .

3. Press Menu  (right softkey) and select Video Mode.

Before You 
Begin:

You must have QuickTime Player version 6.5 or later installed on your 
computer to play videos recorded by your smart device and downloaded 
from an expansion card or accessed by clicking the video thumbnail after 
syncing the files.
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4. Adjust the position of your smart device until you see the subject you want 
to record on the screen.

5. (Optional) Adjust any of the following:

� Brightness: Press Right  to increase the brightness or Left  to decrease 
the brightness.

� Resolution: Press Menu  and select 
Quality to change the video resolution.

6. Press Center  to start recording.

7. When you’ve finished recording, press 
Stop  (left softkey) or Center  to stop 
recording.

8. (Optional) To review the video in Windows 
Media Player Mobile, press Thumbnails  
(left softkey), highlight the video, and then 

press Center . (Press OK  to return to the Thumbnails view.) 

Tip: If you don’t like a video you recorded, delete it. See “Deleting a Picture or 
Video” on page 184 for details.

Did You 
Know?

If you pause your recording for more than three minutes, the recording is 
stopped and the video clip is automatically saved.
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Viewing a Picture or Video

1. Press Start  and select Pictures & Videos.

2. Select the picture or video you want to view. (For more information on 
viewing videos, see “Playing Media Files on Your Smart Device” on 
page 192.)

3. Press OK  to return to the Thumbnails view.

Viewing a Slide Show

1. Press Start  and select Pictures & Videos.

2. Press Menu  (right softkey) and select Play Slide Show. (The slide show 
will play automatically.)

3. Press Center  to display the slide show toolbar, which you can use to 

Rotate , Play , Pause , Reverse , Forward , and Stop  the slide 
show.

Tip: To view pictures or videos in a different folder, select the Show list in the 
upper-left, and then select the album you want to view. 

Tip: You can also press Right and Left on the 5-way to move forward or 
backward through the slides.
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Sending a Picture or Video

You can send a picture or video to other picture-enabled wireless devices or to an 
email address.

1. Press Start  and select Pictures & Videos.

2. Highlight the picture or video you want to send. 

3. Press Menu  (right softkey) and select Send.

4. Select the email account you want to use to send the picture or video.

5. Address and send the message. (See “Creating and Sending an Email 
Message” on page 123 for details.)

Did You 
Know?

You cannot send copyrighted pictures or videos that appear with a Lock 
icon in the Thumbnails view.
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Creating a Video Ringtone

You can save a video that you record as a ringtone. 

1. Press Start  and select Pictures & Videos.

2. Highlight the video you want to use as a ringtone. 

3. Press Menu  (right softkey) and select Save to Contact Ringtone.

4. Select the contact to whom you want to assign the ringtone.

Note: Your device also supports the WMV and 3GP file formats for video 
ringtones.
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Organizing Pictures and Videos

You can move or copy pictures and videos to other folders or between your smart 
device and an expansion card.

1. Press Start  and select Pictures & Videos.

2. Highlight the picture or video you want to move or copy. 

3. Do one of the following:

� To move the picture or video to another location, press Menu  
(right softkey) and select Edit > Cut.

� To keep the picture or video in two locations, press Menu  (right 
softkey) and select Edit > Copy.

4. Select the Show list in the upper-left, and select the location where you 
want to place the picture or video you selected in step 2.

5. Press Menu  (right softkey) and select Edit > Paste.

You can also view a specific folder or expansion card and arrange the pictures and 
videos by name, date, or size.

1. Press Start  and select Pictures & Videos.

2. Select the Show list in the upper-left, and then select the folder you want to 
view.

3. Select the Sort By list in the upper-right, and then select the sort method: 
Name, Date, or Size.
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Using a Picture as the Today Screen Background

1. Press Start  and select Pictures & Videos.

2. Select the picture you want to use.

3. Press Menu  (right softkey) and select Set as Today Background.

4. Select the Transparency Level list and select the appropriate level. (Use a 
higher percentage for a more transparent picture or a lower percentage for 
a more opaque picture.)

5. Press OK  to return to the Thumbnails view.
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Editing a Picture

1. Press Start  and select Pictures & Videos.

2. Select the picture you want to edit.

3. Press Menu  (right softkey) and select Edit.

4. Do any of the following: 

� To rotate a picture 90 degrees counterclockwise, press Rotate  (left 
softkey). 

� To crop a picture, press Menu  (right softkey) and select Crop. Tap 
and drag the stylus to highlight the area to crop. (Tap outside the box to 
stop cropping.) 

� To adjust the brightness and contrast levels of a picture, press 
Menu  (right softkey) and select AutoCorrect. 

5. Press OK  to save your changes.

Deleting a Picture or Video

1. Press Start  and select Pictures & Videos.

2. Highlight the picture or video you want to delete. 

3. Press Menu  (right softkey) and select Delete.

4. Select Yes. 

Tip: To undo an edit, press Menu and select Undo. To cancel all unsaved edits 
you made to the picture, select Revert to Saved.
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Customizing Your Camera Settings

You can customize the camera on your smart device as described in the following 
section. If your smart device does not have a built-in camera, the Camera and 
Video options do not apply to you.

1. Press Start  and select Pictures & Videos. 

2. Press Menu  (right softkey) and select 
Options.

3. On the General tab, set any of the following 
options:

� Use this picture size: Sets the size of pictures 
you send with the Messaging application.

� When rotating a picture, rotate 90 degrees: 
Sets the direction in which pictures rotate.

4. Select the Slide Show tab and set any of the 
following options:

� During slide shows, optimize for viewing: Sets 
whether pictures are optimized for portrait 
or landscape format during slide shows.

� Play screensaver when connected to my PC and 
idle for 2 minutes: Sets whether the pictures 
in your My Pictures folder are used as a 
screensaver when your smart device is 
connected to your computer and ActiveSync® 
software is not running.
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5. Select the Camera tab and set any of the 
following options:

� Save files to: Determines if pictures and videos 
are stored on your smart device or on an 
expansion card.

� Type filename prefix: Assigns a name to a 
series of pictures to be captured, such as 
Seattle001, Seattle002, and so on. 

� Still image compression level: Sets the default 
size for newly captured pictures.

6. Select the Video tab and set any of the following 
options:

� Include audio when recording video files: Turns 
the microphone on and off so that you can 
record videos with or without sound.

� Time limit for videos: Limits the length of 
videos you record. (You can also select the No 
limit option.) 

7. Press OK  to return to the Thumbnails view.
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Viewing Pictures and Videos on Your Computer

When you synchronize your smart device, your pictures and videos are copied to 
your desktop computer. You can view pictures in JPEG, GIF, BMP, and PNG format 
and videos in 3G2 and WMV format. You can also send them to friends using your 
desktop email application. 

When you use ActiveSync to synchronize pictures and videos, the files are stored 
in C:\Documents and Settings\<Username>\My Documents\Treo My 
Documents.

Did You 
Know?

You can also download animated GIF files and view them in Internet 
Explorer Mobile. 
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Sec t ion 4B

Windows Media Player Mobile

In This Section

� Transferring Media Files to Your Smart Device

� Playing Media Files on Your Smart Device

� Working With Libraries

� Working With Playlists

� Customizing Windows Media Player Mobile



190 Section 4B: Windows Media Player Mobile

Windows Media Player Mobile can play music, audio, and video files that are 
stored on your smart device or on an expansion card (sold separately) in any of 
the following file formats:

� WMA 

� WMV 

� MP3

� 3G2

You can listen to these music, audio, and video files through the speaker on the 
back of your smart device or through a stereo headphone (3.5mm stereo 
headphone adapter or 2.5mm stereo headphone required, sold separately).

Before You 
Begin:

Do the following:
� You must have Windows Media Player 10 or later installed on your 

computer. See “My Media Files Won’t Sync” on page 337.
� To sync media files with your computer, you must set the Media sync 

option. See “Selecting Which Information to Sync” on page 262.



Section 4B: Windows Media Player Mobile 191

W
in

dow
s M

edia 

Transferring Media Files to Your Smart Device

Use the Sync feature in the desktop version of Windows Media Player 10 to 
transfer digital music, audio, video, and playlist files from your computer to an 
expansion card or your smart device. Using Sync ensures that the files transfer 
correctly.

1. On your computer, open Windows Media Player 10.

2. (Optional) Insert a 32MB or larger expansion card into your smart device.

3. Connect your smart device to your computer with the USB sync cable. 

4. When the Device Setup Wizard opens on your computer, click Automatic. 

5. Check the Customize the playlists that will be synchronized box.

6. Select the playlists you want to sync.

7. Click Finish to begin the transfer. (The next time you connect your smart 
device to your computer while the desktop version of Windows Media 
Player 10 is running, synchronization starts automatically. Be patient; 
transferring media files to an expansion card can take several minutes.)

For tips on using the desktop version of Windows Media Player, go to the Help 
menu in Windows Media Player 10 on your computer.
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Playing Media Files on Your Smart Device

1. Press Start  and select Windows Media.

2. Press Menu  (right softkey) and select Library.

3. Select the Library list in the upper-left, and then select the library you want 
to use. 

4. Select the item you want to play (such as a song, album, or artist name).

5. Press Play  (left softkey).

6. Use any of the following onscreen controls during playback:

� Center  or  Plays the current file.

� Center  or  Pauses the current file.

� Left  or  Skips to the beginning of the current file or to the 
previous file.

� Right  or  Skips to the next file.

�  Sets the point from which playback begins. (Tap and drag the slider 
to change the current position.)

� Volume button or  Increases the volume level.

Tip: To play a file that is not in a library, go to the Library screen, press Menu, 
and select Open File. 

Tip: To repeat the current song, press Menu and select Repeat Song.
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� Volume button or  Decreases the volume level.

�  Turns the sound on or off.

�  Displays a video using the full screen.

�  Displays a Web site where you can find music and videos to play.

�  Indicates the rating of the current file. (Select the star to change the 
rating.)

7. Press Menu  (right softkey) and select any of the following during 
playback:

� Library: Displays the Library screen so you can select a different song to 
play.

� Shuffle/Repeat > Shuffle: Plays the Now Playing playlist in random order. 
(A check appears next to this command when it is on.)

� Shuffle/Repeat > Repeat: Plays the Now Playing playlist repeatedly. 
(A check appears next to this command when it is on.)

� Stop: Ends playback.

Did You 
Know?

If you close the Windows Media Player Mobile window, your music 
continues to play in the background.

Tip: To play a file from the Web, press Menu on the Library screen, and then 
select Open URL. Select URL and enter the Web site address, or select 
History and select a site you’ve visited before.
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Working With Libraries

A library represents each of the storage locations available to Windows Media 
Player Mobile, such as your Treo device or an optional expansion card (not 
included). Each library contains links to the media files in that location. Windows 
Media Player Mobile usually creates and updates the library automatically when 
you add media files for the first time. For example, when you add media files to 
your Treo device, the My Device library is created. When you insert an expansion 
card containing media files, the Storage Card library is created. When you update 
a library, it automatically updates video files (WMV and 3G2) and audio files 
(WMA, MP3, QCP, and WAV).

1. Press Start  and select Windows Media.

2. Press Menu  (right softkey) and select Library.

3. Press Menu  (right softkey) and select Update Library.

4. Wait for the files to be added, and then select Done. (If you don’t see a 
media file that you added, manually update the library.)

Tip: If you move files between your smart device and an expansion card, be 
sure to update your libraries, or you won’t be able to see the files in their 
new location.

Tip: To delete an item from a library: Highlight the item and then press and 
hold Center on the 5-way to open the shortcut menu. Then select Delete 
from Library. Select Yes to confirm the deletion.
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Working With Playlists

A playlist is a list of media files that play in a specific order. You can use playlists 
to group audio files together or video files together for convenient playback. For 
example, in the desktop player, you can create a playlist of upbeat songs for 
when you exercise and a playlist of soothing songs for a long flight. When you 
synchronize, your favorite playlists are automatically copied to your smart device. 
Your playlists appear in your libraries (in the My Playlists category). 

A temporary playlist, called Now Playing, appears on the Now Playing menu. It lists 
the currently playing file, as well as any files that are queued up to play next. You 
can add to, modify, or clear the files on the Now Playing playlist.

1. Go to the Now Playing screen: 

� If the Library screen is displayed, select the Now Playing category. 

� If the Playback screen is displayed, press Now Playing  (left softkey).

2. Do any of the following:

� To move a file up or down one slot, highlight 
the file, and then select Move Up  or Move 
Down .

� To add a file, select Add , press Menu  
(right softkey), and then select Queue Up.

� To delete a file from the playlist, highlight the 
file, and then select Remove .
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� To view more information about a file, highlight the file and select 

Properties .

� To remove all items from the Now Playing playlist, press Menu  
(right softkey) and select Clear Now Playing.

Did You 
Know?

You can also move a file in the Now Playing playlist by tapping and 
dragging it to a new position.
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Customizing Windows Media Player Mobile

1. If necessary, go to the Playback screen by pressing OK  to close the 
current screen.

2. Press Menu  (right softkey) and select Options.

3. On the Playback tab, set any of the following options:

� Show time as: Sets whether the time 
remaining or time elapsed appears on the 
Playback screen.

� Pause playback while using another program: 
Sets whether playback continues if you 
switch to another application.

� Resume playback after a phone call: Sets 
whether playback continues after you finish a 
phone call.

4. Select the Video tab and set any of the following options:

� Play video in full screen: Sets whether videos automatically play in full 
screen format.

� Scale to fit window: Sets whether videos are automatically scaled to fit 
the Playback screen.

5. Select the Network tab and set the following options:

� Protocol: Enables and disables the available protocols. (You must select 
at least one protocol. You can also set a UDP Port.)
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� Internet Connection Speed: Sets the speed of your network connection 
and whether you want the device to detect connection speed.

6. Select the Library tab and set whether you want to see the Library or Playback 
screen when you open Windows Media Player Mobile.

7. Select the Skins tab and select Previous or Next to set the player’s 
background.

8. Select the Buttons tab to change any of the 
available button settings:

� To assign a button, highlight the item you 
want to set, select Assign, and then press the 
button you want to use for that item.

� To restore an item’s factory setting, highlight 
the item and select Reset.

� To unassign an item, highlight the item and 
select None.

9. Press OK .

Did You 
Know?

Pressing and holding the Side button on the side of your smart device 
opens Windows Media Player Mobile. You can also assign a button to 
turn the screen off during music playback to preserve battery life (for 
instance “s”). See “Reassigning Buttons” on page 284 for details.
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Sec tion 5A

Using Your Device’s Organizer Features

In This Section

� Contacts

� Calendar

� Tasks

� Notes

� Calculator

Before You 
Begin:

Install the latest software from your Getting Started CD.
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Contacts

Adding a Contact

1. Press Start  and select Contacts.

2. Press New (left softkey).

3. Use the 5-way navigator to move between fields 
as you enter information.

4. To add a caller ID picture that appears when that 
person calls, select Picture, and then select 
Camera and take a picture, or select an existing 
picture from the Thumbnails view. 

5. To assign the entry to one or more categories, select Categories and then 
check the categories under which you want this entry to appear.

6. To add a note to an entry, select the Notes tab.

7. To assign a ringtone to the entry, select Ring tone and select a tone.

8. After you enter all the information, press OK . 

Tip: If you have many contacts to enter, it’s best to enter them in Microsoft 
Office Outlook on your computer and then sync. See “Synchronizing 
Information—The Basics” on page 27 for details.
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Viewing or Changing Contact Information

1. In the Contacts list (name view), begin entering one of the following for the 
contact you want to view or edit:

� First name.

� Last name.

� First initial and last initial separated by a space.

� Press Option , and then enter the phone number.

2. Select the entry you want to open.

3. Press Menu  (right softkey) and select Edit.

4. Make changes to the entry as necessary.

5. Press OK .

Tip: Be sure to enter wireless numbers and email addresses in the correct 
fields. Otherwise Messaging can’t find this information when you address 
a message and Calendar can’t find your contacts to invite them to 
meetings.

Tip: You can open Contacts from your Today screen. Press Menu and select 
Contacts.

Did You 
Know?

You can find a contact by company name. Press Menu and select View 
By > Company. Select a company name to see the contacts who work 
there.
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Deleting a Contact
1. In the Contacts list, highlight the contact you want to delete.

2. Press Menu  (right softkey) and select Delete Contact.

3. Select Yes.

Customizing Contacts
1. Go to the Contacts list.

2. Press Menu  (right softkey) and select Options.

3. Set any of the following options:

� Show alphabetical index: Displays the alphabet at the top of the Contacts 
list. You can use this index to find a contact.

� Show contact names only: Lets you fit more names on the Contacts list by 
hiding everything but the contact’s name.

� Area code: Sets the default area code for new contact entries.

4. Press OK .

Tip: To view a particular group of contacts, press Menu, select Filter, and then 
select the category you want to view.
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Finding a Contact in an Online Address Book

In addition to having contacts on your device, you can also access contact 
information from your organization’s online address book or Global Address List 
(GAL). For more information, see “Adding an Online Address Book” on page 145.

1. Press Start  and select Contacts.

2. Press Menu  (right softkey), and select Find Online. 

Before You 
Begin:

Make sure you are accessing an Exchange Server 2003 upgraded to 
Service Pack 2. Add access to the online address book to your device. See 
“Adding an Online Address Book” on page 145. After adding the online 
address book, you must synchronize with the Exchange Server in order 
for the Find Online option to appear.
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Calendar

Displaying Your Calendar

1. Press Start  and select Calendar.

2. Press Menu  (right softkey) and select View.

3. Select one of the following views:

� Agenda: Shows your daily schedule in list format. (Upcoming 
appointments are bold; past appointments are dimmed.)

� Day: Shows your daily schedule in day-planner format.

� Week: Shows your schedule for an entire week.

� Month: Shows your schedule for a whole month. 
 A morning appointment.
 An afternoon appointment.
 Both morning and evening appointments. 
 An all-day event.

� Year: Shows a calendar for a 6-month period.

4. Use the 5-way to move to another day, week, month, or year (based on the 
current view).
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Creating an Appointment

1. Press Start  and select Calendar.

2. Press Menu  (right softkey) and select New 
Appointment.

3. Enter a Subject (description) and a Location.

4. Select Starts and select the starting date and 
time.

5. Select Ends and select the ending date and time.

6. Press OK . 

Tip: If you have several appointments to enter, it’s most efficient to enter 
them in Microsoft Office Outlook on your computer and then 
synchronize your smart device with your computer. For more 
information, see “Synchronizing Information—The Basics” on page 27.

Tip: To pencil in an appointment, open the appointment, select Status, and 
then select Tentative.
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Creating an Untimed Event

An untimed event, such as a birthday, anniversary, or vacation, does not occur at a 
particular time. These events appear as banners at the top of your calendar; they 
don’t occupy blocks of time. For example, “Submit Final Draft” in the screenshot 
shown here is an untimed event.

1. Press Start  and select Calendar.

2. Press Menu  (right softkey) and select New 
Appointment.

3. Enter a subject (description).

4. Select the starting and ending dates.

5. Select All Day, and then select Yes.

6. Press OK . 

Scheduling a Repeating Appointment
1. Create an appointment or untimed event, and then select it.

2. Press Edit  (left softkey).

3. Select Occurs, and then select a repeat pattern. (To create a repeat pattern, 
select Edit pattern and follow the onscreen instructions.) 

4. Press OK .

Tip: To enter a birthday or an anniversary, create an untimed event that 
repeats every year.
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Adding an Alarm Reminder to an Event
1. Create an event, and then select it.

2. Press Edit  (left softkey).

3. Select Reminder, and then select Remind Me.

4. Enter the number of minutes, hours, days, or weeks before the event you 
would like to receive the alarm.

5. Press OK .

Sending a Meeting Request

You can email meeting invitations to contacts who use Microsoft® Office Outlook® 
or Outlook Mobile. 

1. Create an event, and then select it.

2. Press Edit  (left softkey). 

Tip: You can also add an alarm when you create the event. 

Type of Time Units

Number of Time Units
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3. Select Attendees, and then select the name of the contact you want to 
invite. (To invite other attendees, select Add and select the names.) 

4. Press OK .

The next time you synchronize, the meeting request is sent to the attendees. 
When attendees accept your meeting request, the meeting is automatically 
added to their schedules. When you receive their response, your calendar is 
updated as well.

Marking an Event as Sensitive

If other people have access to your Microsoft Office Outlook calendar on your 
computer and you don’t want them to see an appointment, you can mark that 
appointment as private to hide it from other Microsoft Office Outlook users.

1. Create an event, and then select it.

2. Press Edit  (left softkey).

3. Select Sensitivity, and then select one of the following:

� Private: Displays the event on your device and on your computer. 
(Meeting attendees or recipients see “Please treat this as Private” near 

Did You 
Know?

If you are using an Exchange 2003 Server with Service Pack 2, you can use 
your corporate Global Address List to find contact information for an 
attendee. Select Attendees, press Menu, and then select Find Online. Enter 
the name of the attendee and select Find.

Before You 
Begin:

Create contact entries with email addresses for the people you want to 
invite to a meeting. You can’t access contact entries without email 
addresses from your calendar.
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the top of an open appointment. If you sync with Exchange Server, other 
users who can access your folders can’t see your private events; they see 
private events as unavailable time slots.) 

� Personal: Displays the event on your device and on your computer. 
(Meeting attendees or recipients see “Please treat this as Personal” near 
the top of an open appointment.) 

� Confidential: Displays the event on your device and on your computer. 
(Meeting attendees or recipients see “Please treat this as Confidential” 
near the top of an open appointment.)

4. Press OK .

Organizing Your Schedule

Use categories to view different types of events. 

1. Create an event, and then select it.

2. Press Edit  (left softkey).

3. Select Category, and then check the categories 
that apply to this event. (To add a new category, 
press New  (left softkey), enter the 

category name, and then press OK .)

4. Press OK  two more times.

Tip: If you don’t see an option on the screen, press Down on the 
5-way to scroll to other options. For example, when editing an event, you 
don’t see the Sensitivity option until you scroll toward the bottom of the 
entry.
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5. After you assign events to categories, press Menu  (right softkey) and 
select Filter.

6. Select the type of events you want to view.

Deleting an Event
1. Highlight the event you want to delete.

2. Press Menu  (right softkey) and select Delete Appointment.

3. Select Yes.

Customizing Calendar
1. Press Menu  (right softkey) and select 

Options.

2. On the General tab, set any of the following 
options:

� 1st day of week: Sets Sunday or Monday as 
the first day of the week for all Calendar 
views.

� Week view: Sets whether five, six, or seven 
days appear in Week view.

� Show half hour slots: Sets whether time slots appear in one hour or half-
hour increments in Day view and Week view.

� Show week numbers: Sets whether week numbers (1–52) appear in 
Week view.



Section 5A: Using Your Device’s Organizer Features 213

Stayin
g O

rgan
ized

3. Select the Appointments tab and set any of the 
following options:

� Set reminders for new items: Sets whether a 
reminder is automatically added to new 
events and how long before the event the 
reminder appears. (You can override this 
setting for individual events.)

� Show icons: Sets which icons appear next to 
events. 

 The event has a reminder.

 The event repeats in a specified pattern.

 The event has a note attached.
 A location has been assigned to the event.
 The event is a meeting.
 The event is marked private.

� Send meeting requests via: Sets the Messaging method used to send 
meeting requests.

4. Press OK .

Tip: Not all icons appear in all Calendar views.
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Tasks 

You can use Tasks to remind you of tasks you need to complete and to keep a 
record of completed tasks. 

Adding a Task

1. Press Start  and select Programs.

2. Select Tasks .

3. Press New  (left softkey).

4. Enter a description of the task as the Subject.

5. Set any of the following: 

� Priority: Sets the priority level for this task. 
(Later you can arrange your tasks based on 
the importance of each task.)

� Status: Indicates whether the task is now 
completed.

� Starts: Specifies when the task begins.

� Due: Sets the due date for the task.

Did You 
Know?

If you want to use Tasks Over the Air (OTA) synchronization, install the 
software from your Getting Started CD. OTA features also require an 
Exchange Server 2003 upgrade to Service Pack 2. The option to 
synchronize tasks wirelessly in the ActiveSync application appears only if 
you have the appropriate server.
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� Occurs: Indicates if the task repeats at regular intervals and how often it 
repeats.

� Reminder: Sets an alarm for this task and indicates when you want to be 
reminded.

� Categories: Assigns the task to one or more categories.

� Sensitivity: Marks this task as Normal, Personal, Private, or Confidential.

� Notes: Lets you enter additional text for the task.

6. Press OK .

Checking Off a Task
1. Select the task you want to check off. Overdue 

tasks appear in red.

2. Press Edit  (left softkey).

3. Select Status and select Completed.

4. Press OK .

Tip: You can also add a task by selecting the Tasks entry bar at the top of the 
screen.

Tip: You can also mark a task complete by tapping the check box next to the 
task on the Tasks list.
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Organizing Your Tasks
1. In the Tasks list, press Menu  (right softkey) and select Filter.

2. Select which tasks you want to view: All Tasks, Recently Viewed, 
No Categories, Active Tasks, Completed Tasks, or a specific category, such as 
Business or Personal.

3. Press Menu  (right softkey) and select Sort By.

4. Select the sort method: Status, Priority, Subject, Start Date, or Due Date.

Deleting a Task
1. Highlight the task you want to delete.

2. Press Menu  (right softkey) and select Delete Task.

3. Select Yes.

Customizing Tasks
1. Go to the Tasks list.

2. Press Menu  (right softkey) and select Options.

3. Set any of the following options:

� Set reminders for new items: Automatically adds a reminder to new 
tasks. (The default reminder is set to 8:00 on the morning the task is 
due. You can override this setting for individual tasks.)

� Show start and due dates: Displays task start and due dates in the Tasks 
list.

� Show Tasks entry bar: Displays the Tasks entry bar at the top of the Tasks 
list.

4. Press OK .
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Notes

Notes are a great way to capture thoughts, questions, and meeting notes on your 
Treo700wx smart device. 

Creating a Note

1. Press Start  and select Programs. 

2. Select Notes .

3. Press New  (left softkey).

4. Do one of the following:

� Type the text with the keyboard. 

� Write the text with the stylus.

� Draw a sketch with the stylus, crossing at least three ruled lines.

5. Press OK .

Before You 
Begin:

Install the software from your Getting Started CD that came with your 
smart device. 

Did You 
Know?

You can add several voice notes within a single note.
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Recording a Voice Note

You can create a new voice note or add a recording to an existing note. 

1. Press Start  and select Programs.

2. Select Notes .

3. To add a recording to a note, open the note you 
want to add the recording to. (To create a new 
voice note, skip this step.)

4. Press Menu  (right softkey) and select View 
Recording Toolbar.

5. Select  to begin recording. 

6. Speak into your smart device's microphone or hold it close to another sound 
source.

7. When you have finished recording, select  to stop recording. (A Recording 
icon appears in the note or Notes list, depending on where you recorded the 
note.) 

8. Press OK .

Creating a Note From a Template
1. Go to the Notes list. 

2. Select the Show list in the upper-left, and then select Templates.

Tip: To play a recording, select the voice note in the Notes list or open the note 
containing the recording and select the Recording icon.
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3. Open the template you want to use.

4. Enter the information.

5. Press OK .

6. Rename the note and move it to the appropriate folder. (See “Organizing 
Your Notes” on page 219 for details.)

Organizing Your Notes

You can rename your notes, move notes to another folder, and move notes 
between your smart device and an expansion (storage) card.

1. Go to the Notes list and highlight a note you want to move.

2. Press Menu  (right softkey) and select Rename/Move.

3. Select Name, and then enter a new name for the note.

4. Select Folder, and then select the folder in which you want to store the note.

5. Select Location, and then select Main memory or Storage Card.

6. Press OK .

Tip: To create a new template, highlight the note you want to save as a 
template. Press Menu and select Rename/Move. Select Name, and then 
enter a name for the template. Select the Show list, and then select 
Templates. Press OK.

Tip: To create a new folder, go to the Notes list, select the Show list in the 
upper-left, and then select Add/Delete. Select New, enter a name for 
the folder, and then press OK.
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7. Select the Show list in the upper-left, and then select the folder you want to 
view.

8. Select the Sort By list in the upper-right, and then select whether you want 
to sort your notes by Name, Date, Size, or Type.

Deleting a Note
1. Go to the Notes list and highlight the note you want to delete.

2. Press Menu  (right softkey) and select Delete.

3. Select Yes.

Customizing Notes
1. Go to the Notes list.

2. Press Menu  (right softkey) and select Options.

3. Set any of the following options:

� Default mode: Sets the default entry mode to Writing or Typing.

� Default template: Sets the default template for new notes.

� Save to: Sets the default location where new notes are stored.

� Record button action: Sets whether the Side button opens the Notes 
application or stays in the current application.

4. Press OK .
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Calculator

You can use Calculator for basic arithmetic 
calculations, such as addition, subtraction, 
multiplication, and division. 

You can tap the screen or use the keyboard to input 
numbers.

Performing Calculations

1. Press Start  and select Programs.

2. Select Calculator .

3. Enter numbers and perform calculations, including the following:
 Clears the last digit.
 Clears the current calculation or the displayed number.
 Calculates the reciprocal of a number.
 Calculates percentage.
 Calculates the square root of a number.
 Switches a number between negative and positive.

Tip: To copy a number, press Edit and select Copy. You can paste the copied 
number in another application. To paste a number you copied in another 
application, press Edit and select Paste.
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Using the Calculator Memory
� To store a number, select the box to the left of the entry box. (An M appears 

in the box.) 

� To add the displayed number to the number stored in memory, select . 

� To display the number stored in memory, select . 

� To clear the memory, select . 

� When you store a number in memory, it replaces the number that was 
previously stored.

Tip: For more advanced calculations, use Excel Mobile. See “Excel Mobile” on 
page 236 for details.
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Sec t ion 5B

Increasing Your Productivity

In This Section

� Word Mobile

� PowerPoint Mobile

� Excel Mobile
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Word Mobile

You can create and edit documents and templates and save them as DOC, RTF, 
TXT, and DOT files. You can also edit Microsoft® Office Word® documents and 
templates that you create on your computer. However, keep in mind that some of 
the information and formatting may be lost when you save the document on 
your smart device.

The following features are not supported in Word Mobile:

� Backgrounds.

� Bidirectional text.

� Document protection.

� Metafiles.

� Artistic page borders (lined page borders are supported).

� Password-protected files (remove password protection on your computer 
before opening the file on your smart device).

� Shapes and text boxes.

� Smart tags.
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The following features are partially supported in Word Mobile: 

� Picture bullets (regular bullets are supported).

� Revision marks (documents appear as though all revisions were accepted; if 
the document is saved, revision marks are lost). 

� Table styles (some or all of the formatting is lost if the document is saved).

� Underline styles (unsupported styles are mapped to one of the four 
supported styles: regular, dotted, wavy, or thick/bold/wide).

� Legacy Pocket Word files (you can open PSW files, but if you edit a file, you 
need to save it in DOC, RTF, TXT, or DOT format). 

The following features are not supported on your smart device, but they remain 
in the file so that when you open the file on your computer, they appear as 
expected: 

� Fonts and font sizes (original fonts are listed on your smart device but are 
mapped to the closest font available). 

� Footnotes, endnotes, headers, footers.

� Lists (indented lists are mapped to the closest indentation level supported by 
Word Mobile).

� Page breaks (although undisplayed, all page breaks, except a break placed at 
the end of a document, are retained in the document). 

Tip: To copy a file from your computer to your device, open My Computer or 
Windows Explorer on your computer, copy the file into the Mobile Device 
folder, and then sync.
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Creating a Document

1. Press Start  and select Programs.

2. Select Word Mobile .

3. Press New  (left softkey).

4. Enter the text of the document.

5. Press OK  to save the file.

Opening an Existing Document

1. Press Start  and select Programs.

2. Select Word Mobile .

3. In the document list, select the document you want to open.

Creating a Document From a Template
1. Go to the document list. 

2. Select the Folder list in the upper-left, and then select Templates.

3. Open the template you want to use, and enter the information.

Did You 
Know?

When you save a new document, it is automatically named after the first 
several words in the file.

Tip: If you don’t see Templates in the Folder list, select More Folders to access 
this folder.
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4. Press OK .

5. Rename the document and move it to the appropriate folder. 
See “Organizing Your Documents” on page 231 for details.

Finding or Replacing Text in a Document
1. Open the document containing the text you want to find.

2. Press Menu  (right softkey) and select Edit > Find/Replace.

3. Select Find what and enter the text you want to find.

4. (Optional) Check the Match case box to find text that matches 
the capitalization in the text you entered in step 3.

5. (Optional) Check the Match whole words only box to find only full words that 
match the text you entered in step 3.

6. Select Find to locate the first instance of the text you entered in step 3, or 
select Replace and enter the replacement text.

7. Select Next to find the next instance of the text, or select Replace to replace 
it. (To replace all instances of the text, select Replace All.) 

8. When you see a message that the search is done, press OK .

Tip: To create a new template, highlight the document you want to save as a 
template. Press Menu and select Rename/Move. Select Name, and then 
enter a name for the template. Select the Folder list, and then select 
Templates. Press OK.
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Moving or Copying Text
1. Open the document containing the text you want to move or copy.

2. Highlight the text you want to move or copy.

3. Press Menu  (right softkey) and select Copy to copy the text, or select 
Cut to move the text.

4. Open the document where you want to insert the text, and position the 
insertion point where you want the text to appear.

5. Press Menu  (right softkey) and select Paste.

Saving a Copy of a Document
1. Open the document you want to copy.

2. Press Menu  (right softkey) and select File > Save As.

3. Select Name and enter a new name for the file.

4. Select the Folder list, and then select the folder where you want to save the 
file.

5. Select the Type list, and then select the format in which you want to save 
the file.

6. Select the Location list, and then select whether you want to store the file on 
your smart device or an expansion card.

7. Select Save.

Tip: To zoom in or out, open a document, press View, select Zoom, and then 
select the zoom level.
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Formatting Text
1. Open the document you want to format.

2. Highlight the text you want to format.

3. Press Menu  (right softkey) and select Format > Font.

4. Set any of the following options for the highlighted text:

� Font: Sets the typeface.

� Font color: Sets the color.

� Size: Sets the point size. 

� Bold: Indicates whether the text appears normal or thick. 

� Italic: Indicates whether the text appears upright or slanted.

� Underline: Indicates whether the text appears with an underscore.

� Highlight: Indicates whether the text appears with a yellow highlight.

� Strikethrough: Indicates whether the text appears with a line through it. 

5. Press OK  to return to the document.

Formatting Paragraphs and Lists
1. Open the document you want to format.

2. Position the insertion point in the paragraph you want to format.

3. Press Menu  (right softkey) and select Format > Paragraph.

Tip: If a document was previously saved on a computer, any unsupported 
formatting may be lost when you save the file.
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4. Set any of the following options:

� Alignment: Aligns the text with the left, right, or center of 
the paragraph.

� List: Creates a bulleted or numbered list.

� Indentation: Changes the paragraph margins. 

� Left: Sets the left margin for the entire paragraph. 

� Right: Sets the right margin for the entire paragraph.

� Special: Lets you indent the first line or set a hanging indent.

� By: Sets the size of the Special indentation. 

5. Press OK  to return to the document.

Checking Spelling in a Document
1. Open the document you want to check.

2. Press Menu  (right softkey) and select Tools > Spelling.

3. If an unknown or misspelled word is encountered, do one of the following:

� Select the correct word in the list if the word is spelled incorrectly. 

� Select Ignore if the word is spelled correctly. 

� Select Add to add a new word to the spelling dictionary.

Tip: You can also use the Formatting toolbar to create a list and to align text. 
To indent text in lists, you must use the Formatting toolbar. 

Tip: To check the spelling of specific text, highlight it before you select the 
Spelling command.



Section 5B: Increasing Your Productivity 231

Produ
ctivity

Organizing Your Documents

You can rename your documents, move your documents to another folder, and 
move your documents between your smart device and an expansion (storage) 
card.

1. Go to the documents list.

2. Highlight a file.

3. Press Menu  (right softkey) and select Rename/Move.

4. Select Name, and then enter a new name for the document.

5. Select the Folder list, and then select the folder you want to move the 
document to.

6. Select the Location list, and then select Main memory or Storage card.

7. Press OK .

8. Select the Folder list in the upper-left, and then select the folder you want to 
view.

9. Select the Sort By list in the upper-right, and then select the sort method.

Tip: To create a new folder, go to the documents list, select the Folder list in 
the upper-left, and then select Add/Delete. Select New, enter a name for 
the folder, and then press OK.

Tip: When you go to a folder, you can easily search your documents by sorting 
by type. 
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Deleting a Document
1. Go to the documents list.

2. Highlight the document you want to delete.

3. Press Menu  (right softkey) and select Delete.

4. Select Yes.

Customizing Word Mobile
1. Go to the document list.

2. Press Menu  (right softkey) and select Options.

3. Set any of the following options:

� Default template: Sets the default template for new documents.

� Save to: Sets the default location where new documents are stored.

� Display in list view: Sets the types of files that appear in the documents 
list.

4. Press OK .
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PowerPoint Mobile

With PowerPoint Mobile, you can open and view slide show presentations 
created on your computer. Many presentation elements such as slide transitions, 
animations, and URL links are also supported. Microsoft® Office PowerPoint® 
features not supported on your smart device include the following: 

� Notes written for slides. 

� Rearrangement or editing of slides.

� Files created in PPT format earlier than Microsoft PowerPoint 97.

� HTML files in HTM and MHT formats.

Playing a Presentation

1. Press Start  and select Programs.

2. Select PowerPoint Mobile .

3. In the presentation list, highlight the presentation you want to play.

4. Press Center .

Tip: To copy a file from your computer to your device, open My Computer or 
Windows Explorer on your computer, copy the file into the Mobile Device 
folder, and then sync.

Did You 
Know?

You can purchase SDIO presentation modules that let you project your 
PowerPoint Mobile presentations through an LCD projector.
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5. Do any of the following:

� Press Right  to advance to the next slide or Left  to view the previous 
slide. 

� Press Menu  (right softkey), select Go to Slide, and select the slide 
you want to view.

� Select Next or Previous to play animations.

�  Press Menu  (right softkey), select Zoom In, and then select  to 

zoom in or  to zoom out. (To scroll within the current slide, tap and 
drag the slide. To return to the slide show, select .)

� Press Menu  (right softkey) and select End Show.

Setting Presentation Playback Options
1. Open the presentation for which you want to change the settings.

2. Press Menu  (right softkey) and select Show Options.

3. On the Orientation tab, select the orientation you want. (To select the 
orientation that best fits your smart device’s screen, select Default.)

4. Select the Playback tab, and check the Override playback options for all files 
box.

5. Set any of the following options:

� Show without animation: Turns off builds and other animations.

� Show without slide transition: Turns off transition effects between slides. 

Tip: If a presentation is set up as a timed slide show, the slides advance 
automatically. Presentations pause during zooming.



Section 5B: Increasing Your Productivity 235

Produ
ctivity

� Use slide timings, if present: Enables the timings recorded with each slide 
in a presentation. 

� Loop continuously: Advances to the first slide after playing the last slide 
in a presentation. 

6. Press OK .

Tip: To turn the presentation into a continuously looping slide show, check 
both the Use timings, if present, and the Loop continuously boxes.
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Excel Mobile

With Excel Mobile you can create and edit workbooks and templates on your 
smart device. You can also edit workbooks and templates that you create on your 
computer. However, keep in mind that you may lose some of the information 
and formatting when you save the workbook on your smart device.

Note the following formatting considerations: 

� Alignment: Vertical text appears horizontal. 

� Borders: Appear as a single line. 

� Cell patterns: Patterns applied to cells are removed. 

� Fonts and font sizes: The original font is listed on your smart device and 
mapped to the closest font available. Original fonts reappear on your 
computer.

� Number formats: Microsoft® Excel® 97 conditional formatting is displayed in 
number format. 

� Formulas and functions: Unsupported functions are removed, and only the 
returned value of the function appears. Formulas containing the following 
are also converted to values: 

� An array or array argument, for example, =SUM({1;2;3;4}) 

� External link references or an intersection range reference

� References past row 16384 are replaced with #REF! 

Tip: To copy a file from your computer to your device, open My Computer or 
Windows Explorer on your computer, copy the file into the Mobile Device 
folder, and then sync.



Section 5B: Increasing Your Productivity 237

Produ
ctivity

� Protection settings: Most protection features are disabled but not removed. 
However, password protection is removed. You must remove the password 
protection in Microsoft® Office Excel® on your computer before opening the 
file on your smart device.

� Zoom settings: Worksheet-specific zoom settings are not retained. The zoom 
setting applies to the entire workbook. 

� Worksheet names: Names that refer to other workbooks, arrays, array 
formulas, or intersection ranges are removed from the name list, causing 
those formulas to be resolved as “#NAME?” All hidden names are not hidden. 

� AutoFilter Settings: AutoFilters that cause rows to be hidden are supported. Use 
the Unhide command to display hidden rows. Other AutoFilters are removed, 
but you can use the AutoFilter command in Excel Mobile to perform similar 
functions.

� Chart Formatting: All charts are saved as they appear in Excel Mobile. 
Unsupported chart types are changed to one of these supported types: 
Column, Bar, Line, Pie, Scatter, and Area. Background colors, gridlines, data 
labels, trend lines, shadows, 3D effects, secondary axes, and logarithmic 
scales are turned off.

The following features aren’t supported in Excel Mobile and are removed or 
modified when you open a workbook on your smart device:

� Hidden, dialog, and macro sheets. 

� VBA modules. 

� Text boxes.

Tip: For simple calculations, use the Calculator (see“Calculator” on page 221). 
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� Drawing objects and pictures.

� Lists.

� Conditional formats and controls. 

� Pivot table data (is converted to values). 

Creating a Workbook

1. Press Start  and select Programs.

2. Select Excel Mobile .

3. Press New  (left softkey).

4. Highlight a cell where you want to enter text or other information. 

5. Enter the information in the cell, and then press Enter .

6. Repeat steps 4 and 5 to enter the remaining information.

7. Press OK  to save the file.

Tip: When you save a new workbook, it is automatically named and placed in 
the workbook list.

Tip: To insert a symbol, place the insertion point where you want the symbol. 
Press Menu and select Insert > Symbol. Highlight the symbol you want to 
insert, and then select Insert.
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Creating a Workbook From a Template
1. Go to the workbook list. 

2. Select the Folder list in the upper-left, and then select Templates.

3. Open the template you want to use, and enter the information you want to 
include in the template.

4. Press Menu  (right softkey) and select File > Save As.

5. Rename the workbook and move it to the appropriate folder. 
See “Organizing Your Documents” on page 231 for details.

Viewing a Workbook

1. Press Start  and select Programs.

2. Select Excel Mobile .

3. In the workbook list, select the workbook you want to view.

4. Press View  (left softkey), and then select any of the following:

� Full Screen: Shows as much data as possible on the screen. To return to 
the normal view, select Restore in the upper-right. 

� Zoom: Sets the magnification level so that you can easily read the 
worksheet.

� Sheet: Lets you switch to a different worksheet.

Tip: To create a new template, highlight the workbook you want to save as a 
template. Press Menu and select Rename/Move. Select Name, and then 
enter a name for the template. Select the Folder list, and then select 
Templates. Press OK.
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� Split: Divides the window into two scrollable areas. To move the split 
bar, tap and drag it. To remove the split bar, select View > Remove Split.

� Freeze Panes: Locks rows or columns so they remain visible while you 
scroll. Highlight the cell at the juncture you want to lock before you 
select this command. To unlock the rows or columns, select View > 
Unfreeze Panes. 

� Toolbar: Sets whether the toolbar appears onscreen.

� Status Bar: Sets whether the status bar appears onscreen.

� Show: Sets whether headings and scroll bars appear onscreen.

Calculating a Sum
1. Press View  (left softkey) and select Toolbar.

2. Highlight the cell where you want to insert the sum.

3. Select . 

4. Tap and drag the stylus across the cells you want to add. 

5. Press Enter .

Tip: To jump to a cell or region, press Menu and select Edit > Go To. Select Cell 
reference or name and enter the target cell information or select Current 
region. Select OK.

Did You 
Know?

You can also switch worksheets by selecting the sheet list at the bottom 
of the screen.
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Entering a Formula
1. Highlight the cell where you want to enter the formula.

2. Enter an = sign followed by any values, cell references, name references, 
operators, and functions. 
Example: =(B4/25)+100=Revenue-Expenses 

3. Press Enter . 

Inserting a Function
1. Highlight the cell where you want to insert the 

function.

2. Press Menu  (right softkey) and select Insert 
> Function.

3. Select the Category list, and then select the type 
of function you want to insert.

4. Select the Function list, and then select the 
specific function you want to insert.

5. Select OK.

Did You 
Know?

To enter symbols that are not on the keyboard, such as the = sign, press 
Alt and select the symbol from the list.
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Entering a Sequence Automatically
1. Highlight both the cells containing the 

information you want to automate and the 
adjacent destination cells. 

2. Press Menu  (right softkey) and select Edit > 
Fill. 

3. Select the Direction list, and then select the 
direction you want to populate.

4. Select the Fill type list, and then select Series. 

5. Select the Series type list, and then select the type of series you want. If you 
select Date or Number, enter a Step value increment. 

6. Select OK. 

Adding Cells, Rows, and Columns
1. Open the workbook you want to add to.

2. Highlight the area where you want to insert elements.

3. Press Menu  (right softkey) and select Insert > Cells.

4. Select how you want to insert the elements:

� Shift cells right: Inserts a new cell. The highlighted cell and all cells on the 
right move one column to the right.

Tip: Select Autofill as the series type to quickly fill cells with repetitive data 
such as numbers or repeated text. Autofill takes the content of the first 
cell in the highlighted row or column and copies it down or across the 
rest of the selection.
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� Shift cells down: Inserts a new cell. The highlighted cell and all cells 
below it move down. 

� Entire row: Inserts a new row. The entire row in which the highlighted 
cell is located and all rows below it move down.

� Entire column: Inserts a new column. The entire column in which the 
highlighted cells are located and all columns to the right move one 
column to the right.

5. Select OK.

Formatting Cells
1. Open the workbook you want to format.

2. Highlight the cells you want to format.

3. Press Menu  (right softkey) and select Format > Cells.

4. Select any of the following:

� Size: Sets the row height and column width.

� Number: Sets the format for the numbers in the cells.

Tip: To add a new worksheet, press Menu and select Format > Modify Sheets. 
Select Insert, enter a name for the worksheet, and then press OK. To 
change the order of the worksheets, highlight a worksheet you want to 
move, and then select Move Up or Move Down. Press OK to finish.

Tip: To name the highlighted cell or range of cells, press Menu and select 
Insert > Define Name. Enter the name and select Add. Press OK.
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� Align: Sets whether text wraps within the highlighted cells, and sets 
horizontal and vertical alignment position.

� Font: Sets the typeface, color, size, and style attributes.

� Borders: Turns borders on and off for various cell edges, and sets the 
border and background colors.

5. Press OK .

Formatting Rows and Columns
1. Open the workbook you want to format.

2. Highlight the rows or columns you want to format.

3. Press Menu  (right softkey), and then select Format > Row or Format> 
Column.

4. Select any of the following:

� AutoFit: Adjusts the size of the highlighted rows or columns to their 
contents.

� Hide: Hides the highlighted rows or columns.

� Unhide: Displays hidden rows or columns in the highlighted area.

Did You 
Know?

You can adjust the column or row size by tapping and dragging the right 
edge of the column header or the bottom edge of the row header. To 
automatically fit rows and columns to their contents, double-tap the 
lower edge of the row heading or the right edge of the column heading.
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Renaming a Worksheet
1. Open the workbook containing the worksheet you want to rename.

2. Press Menu  (right softkey) and select Format > Modify Sheets.

3. In the Sheets list, highlight the worksheet you want to rename.

4. Select Rename, enter a new name for the worksheet, and then press OK  
twice.

Sorting Information in a Worksheet
1. Highlight the cells you want to sort.

2. Press Menu  (right softkey) and select Tools > Sort.

3. Select the Sort by list, and then select the primary sort column.

4. Check or uncheck the Ascending box to indicate whether you want to sort in 
ascending or descending order.

5. (Optional) Select the Then by lists, and then select second and third level 
sorting options.

6. Check or uncheck the Exclude header row from sort box to indicate if you 
want to sort the header row.

7. Select OK.

Filtering Information in a Worksheet
1. Highlight the cells that contain the information you want to filter.

2. Press Menu  (right softkey) and select Tools > AutoFilter. 
(A list appears at the top of each related column).
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3. Select one of the new lists, and then select a filter. (This hides all rows that 
do not include the selected filter.) 

4. (Optional) Select the other lists, and then select other filters.

Creating a Chart
1. Open the workbook you want to create a chart from.

2. Highlight the cells you want to include in the chart.

3. Press Menu  (right softkey) and select Insert > Chart.

4. Select the type of chart, and then press Next  (right softkey).

5. Confirm the area you want the chart to include, and then press Next  
(right softkey).

6. Select the data layout, and then press Next  (right softkey).

7. Check the boxes to indicate whether the first row and column represent 
labels.

8. Select whether you want the chart to appear as a separate worksheet 
within the current workbook, or as part of the current worksheet. 

9. Press Finish  (right softkey).

Tip: To display all rows again, select the filter list, and then select All. To turn 
off filtering, press Menu and select Tools > AutoFilter again.

Did You 
Know?

You can also create custom filters where you specify comparisons. Select 
the filter list, and then select Custom.
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Formatting or Changing a Chart
1. Open the workbook that contains the chart you want to format.

2. Open the chart.

3. Press Menu  (right softkey) and select Format > Chart.

4. Select any of the following:

� Titles: Sets the title of the chart and headings, whether a legend 
appears, and the placement of the legend.

� Scale: Sets the minimum and maximum scales for charts with an x or y 
axis.

� Type: Sets the chart style. You can use this setting to convert your chart 
to a different format.

� Series: Lets you add, modify, format, or delete related data points 
without affecting the information in your worksheet.

5. Press OK .

Finding or Replacing Information in a Workbook
1. Open the workbook containing the information you want to find.

2. Press Menu  (right softkey) and select Edit > Find/Replace.

3. Select Find what and enter the information you want to find.

4. (Optional) Check the Match case box to find text that matches the 
capitalization in any text you entered in step 3.

5. (Optional) Check the Match whole words only box to find only full words that 
match any text you entered in step 3.
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6. Select Find to locate the first instance of the information you entered in 
step 3, or select Replace and enter the replacement information.

7. Select Next to find the next instance of the information, or select Replace to 
replace it. (To replace all instances of the information, select Replace All.) 

8. When you see a message that Excel Mobile has finished searching, 

press OK .

Organizing Your Workbooks

You can rename your workbooks and move them to another folder and between 
your smart device and an expansion (storage) card.

1. Go to the workbook list.

2. Select a file.

3. Press Menu  (right softkey) and select Rename/Move.

4. Select Name, and then enter a new name for the workbook.

5. Select the Folder list, and then select the folder you want to move the 
workbook to.

6. Select the Location list, and then select Main memory or Storage card.

7. Press OK .

8. Select the Folder list in the upper-left, and then select the folder you want to 
view.

9. Select the Sort By list in the upper-right, and then select the sort method.

Tip: When you go to a folder, you can easily search your documents by sorting 
by type. 
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Deleting Cells, Rows, and Columns
1. Open the workbook containing the elements you want to delete.

2. Highlight the area you want to delete.

3. Press Menu  (right softkey) and select Edit > Delete Cells.

4. Select how you want to remove the elements:

� Shift cells left: Deletes the highlighted cells and moves all cells on the 
right one column to the left. 

� Shift cells up: Deletes the highlighted cells and moves all cells below 
them up. 

� Entire row: Deletes the entire row in which the highlighted cells are 
located, and moves all rows below it up. 

� Entire column: Deletes the entire column in which the highlighted cells 
are located, and moves all columns on the right one column to the left. 

5. Press OK .

Did You 
Know?

Excel Mobile adjusts formulas to reflect the new cell locations. However, 
a formula that refers to a deleted cell displays the #REF! error value.

Tip: To delete a workbook, go to the workbook list and highlight the 
workbook you want to delete. Press Menu and select Delete. Select Yes to 
confirm.
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Customizing Excel Mobile
1. Go to the workbook list.

2. Press Menu  (right softkey) and select Options.

3. Set any of the following options:

� Template for new workbook: Sets the default template for new 
workbooks.

� Save new workbooks to: Specifies where new workbooks are stored.

� Files to display in list view: Sets which types of files appear in the 
workbook list.

4. Press OK .

Tip: To delete a worksheet, press Menu and select Format > Modify Sheets. 
Highlight the worksheet you want to delete, and then select Delete. 
Select Yes, and then press OK to finish.
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Sec tion 6A

Managing Files and Applications

In This Section

� Using Find

� Installing Applications

� Removing Applications

� Setting Synchronization Options

� Sharing Information

� Using Expansion Cards
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Using Find

With the built-in search features on your smart device, you can find information 
quickly:

� Lookup: Helps you find and dial your contacts by name or phone number. (See 
“Dialing by Contact Name” on page 61 for details.)

� Search: Looks through the text in all the applications on your smart device.

� File Explorer: Lets you browse through the files and folders on your smart 
device or an expansion card.

� Global Address Lookup: Enables you to look up names in your online corporate 
address list.

Using Search

Search for files and other items stored in the My Documents folder on your smart 
device or on an expansion card. You can search by file name or by words located 
in the item. For example, you can search for words within notes, appointments, 
contacts, and tasks. 

1. Press Start  and select Programs.

2. Select Search .

3. Select Search for, and then enter the file name, 
word, or other information you want to find. 

4. Select the Type list, and then select the kind of 
information you want to find. 
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5. Press Search  (left softkey). 

6. Use the 5-way to select and view an item from the results of the search.

Exploring Files and Folders

File Explorer lets you browse the contents of folders on your smart device. The 
root folder on your smart device is named My Device. My Device is similar to My 
Computer on your computer. 

1. Press Start  and select Programs.

2. Select File Explorer .

3. Select the Show list in the upper-left, and then select the folder you want to 
explore. 

4.  Do any of the following:

� To open an item, select it. 

� To quickly delete, rename, beam, or email an item, highlight the item, 
press and hold Center  to open the shortcut menu, and then select 
the appropriate command. 

Did You 
Know?

You can also open the Search screen by pressing Option + left Shift.

Did You 
Know?

You can sort the contents of a folder by name, date, size, or type. Select 
the Sort by list in the upper-right, and then select the sort method.
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� To move a file to another folder, highlight the item, press and hold 
Center  to open the shortcut menu, and then select Cut or Copy. Open 
the destination folder, and press and hold Center  to open the 
shortcut menu, and then select Paste.

� To highlight multiple items, tap and drag the stylus. 

Important: Do not delete any files that you cannot identify. These files may be 
required for your smart device to function properly.

Tip: If you’ve looked for an item before, select the Search for list, and then 
select the item in the list. 

Tip: The storage card symbol appears next to the names of files that are 
stored on an expansion card.
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Installing Applications

Your Treo700wx smart device comes with several built-in and ready-to-use 
applications. You can also install any of the additional software included on the 
Getting Started CD, as well as other third-party applications that are compatible 
with Windows Mobile® 5.2 devices, such as business software, games, and more. 
To learn more, go to www.palm.com.

Applications you download to your computer are likely to be in a compressed 
format such as ZIP. If the file is compressed, you need to use a decompression 
utility on your computer, such as Winzip, before you install the application on 
your smart device. 

These instructions tell you how to install basic files onto your smart device. Some 
software uses an installer or wizard to guide you through the process. Consult 
the documentation that came with the software for details.

Did You 
Know?

You can purchase a third-party application that lets you run Palm OS® 
applications on your Treo device.

Tip: If an application does not have a Microsoft Mobile to Market certificate, 
you will see a message indicating that the application is untrusted. If this 
occurs, you can indicate whether you want to continue the installation.

Be sure to select and install Windows Mobile® 5.2.2 Pocket PC Phone 
Edition. Microsoft Windows Mobile 5.2 software for Smartphone is not 
compatible with your Treo device.

http://www.palm.com/
http://
www.palm.com/
http://
www.palm.com/


258 Section 6A: Managing Files and Applications

Installing Applications From the Internet

You can use Internet Explorer Mobile to install Windows Mobile application 
in the CAB file format directly from the Internet. You must use your computer to 
install apps in other file formats.

1. Make sure your phone is on (see “Turning Your Phone On and Off” on 
page 18).

2. Press Start  and select Internet Explorer.

3. Go to the page that contains the link to the application you want 
to download.

4. Press Left  or Right  to highlight the link to the file, and then press Center 
 to start the download process.

5. Press Start  and select Programs.

6. Select File Explorer .

7. Go to the My Documents folder.

8. Tap the file you downloaded to start the installation program.
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Installing Applications From Your Computer

1. Open My Computer or Windows Explorer on your computer. 

2. Copy the application file(s) into the  Mobile Device folder.

3. Connect your smart device to your computer to synchronize and install the 
application(s) on your smart device.

Installing Applications Onto an Expansion Card
1. Insert the expansion card into the expansion card slot (see “Removing and 

Inserting Expansion Cards” on page 269).

2. Open the ActiveSync® window on your computer. 

3. Click Tools and select Explore Device.

4. Double-click My Windows Mobile-Based Device  to open the Mobile Device 

folder.

5. Copy the application file(s) into the Storage Card folder inside the Mobile 
Device folder.

Getting Help With Third-Party Applications

If a you encounter a problem with a third-party application (such as an error 
message), contact the application’s author or vendor. For general troubleshooting 
of third-party applications, see “Third-Party Applications” on page 350.

Before You 
Begin:

To install an application from your computer to your smart device, 
you must first install the ActiveSync software on your computer 
(see “Installing the Desktop Synchronization Software” on page 31).
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Make sure that the third-party application supports 240x240 screen resolution. 
Some older applications have screen-size limitations. Third-party applications 
should also be written for Windows Mobile version 5.2 or later. Programs written 
for earlier versions do not support 5-way navigation or Softkeys and can have 
performance problems. If you can try a free version of the software before 
purchasing it, you can test it first to make sure it works properly.

Tip: Before purchasing a third-party program, try the free version.
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Removing Applications 

To free up storage memory on your smart device, you can remove applications 
that you no longer use. You can remove only applications, patches, and 
extensions that you install; you cannot remove the built-in applications that 
reside in the ROM portion of your smart device.

1. Press Start  and select Settings.

2. Select the System tab, and then select Remove Programs .

3. Highlight the application that you want to remove.

4. Select Remove.

5. Select Yes to confirm deletion.

Tip: Some applications are factory-installed on your smart device and cannot 
be deleted. These are not listed in the Remove Programs list.
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Setting Synchronization Options

Selecting Which Information to Sync

1. Press Start  and select Programs.

2. Select ActiveSync . 

3. Press Menu  (right softkey) and select 
Options.

4. Do any of the following: 

� Check the box next to any items you want to 
synchronize. (If you cannot check a box, you 
might have to uncheck a box for the same 
information type elsewhere in the list.) 

� Uncheck the box next to any items you want to stop synchronizing. 

� Select an item and then select Settings to customize the settings for 
that item. (Settings are not available for all items.)

Synchronizing With Exchange Server

You can sync directly with Exchange Server using a connection to either a wireless 
network or a computer. 

1. Press Start  and select Programs.

2. Select ActiveSync .

Tip: To stop synchronizing with one computer completely, select the 
computer name and then select Delete. 
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3. Press Menu  (right softkey) and select Configure Server. (If you have not 
yet set up a sync with Exchange Server, this says Add Server Source.) 

4. Select Server address, enter the name of the server running Exchange Server, 
and then press Next  (right softkey). 

5. Enter your name, password, and domain, and then press Next  (right 
softkey). (To change the rules for resolving synchronization conflicts, select 
Advanced.) 

6. Check the boxes next to the type of information that you want to 
synchronize with Exchange Server. 

7. Press Finish  (right softkey). 

Synchronizing With Two Computers

You can set up your smart device to synchronize with up to two computers as 
well as Exchange Server. When synchronizing with two computers, the items 
that you synchronize appear on both computers with which they synchronize. 

Did You 
Know?

You can also use the Sync Setup Wizard to set up your smart device to 
synchronize remotely with Exchange Server. This wizard starts when you 
connect your smart device to your computer after installing ActiveSync 
on your computer.

Note: Microsoft® Office Outlook® email can synchronize with only one 
computer.
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For example, if you set up to sync different items with two computers, named C1 
and C2, when you sync Contacts and Calendar on your smart device with both 
computers, you see the following result: 

� The contacts and calendar appointments that were on C1 are now also on C2. 

� The contacts and calendar appointments that were on C2 are now also on C1. 

� The contacts and calendar appointments from both computers are on your 
device. 

Starting and Stopping Synchronization

If ActiveSync is running on your computer and you connect your smart device to 
your computer, synchronization begins automatically. If you ever need to 
manually start or stop synchronization, follow these steps:

1. Connect your smart device to your computer. (See “Connecting Your Treo 
Device to Your Computer (USB)” on page 33. If you are only synchronizing 
wirelessly with Exchange Server, you do not have to connect the device.) 

2. Press Start  and select Programs.

3. Select ActiveSync .

Did You 
Know?

You can also connect your smart device to your computer with an 
infrared (IR) or a wireless connection using Bluetooth® wireless 
technology.

Tip: If synchronization doesn’t start automatically, press Start and select 
Programs. Select ActiveSync and then select Sync to start synchronization. 
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Setting the Synchronization Schedule

You can schedule wireless synchronization to occur automatically at regular 
intervals. If you prefer to synchronize manually, do not turn on these settings.

1. Connect your smart device to your computer. (See “Connecting Your Treo 
Device to Your Computer (USB)” on page 33. If you are only synchronizing 
wirelessly with Exchange Server, you do not have to connect the device.) 

2. Press Start  and select Programs.

3. Select ActiveSync .

4. Press Menu  (right softkey) and select Schedule. 

5. Set any of the following options:

� Peak times: Sets the frequency for high-traffic time periods such as 
when you are at work or when email volume is high.

� Off-peak times: Sets the frequency for low-traffic time periods such as 
late at night. 

� Use above settings while roaming: Sets the frequency while you are 
roaming outside the Nationwide Sprint PCS Network. (To minimize 
roaming charges, uncheck this box and synchronize manually while 
roaming.)

� Send outgoing items immediately: Sets whether items are sent as soon as 
you select Send in the Messaging application, or whether they are held 
until the next synchronization. 

6. Press OK .

Tip: To end synchronization before it completes, select Stop. 
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Tip: The auto shut-off timer resets itself each time you synchronize. If your 
sync interval is shorter than the auto shut-off interval, your smart device 
doesn’t turn off.

Did You 
Know?

Decreasing the sync frequency settings conserves battery power.
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Sharing Information

Your device comes equipped with a variety of options for sharing information, so 
that you can choose the quickest, most convenient way to send your information 
or to receive information from another device.

� When you have a file open in a program such as Notes or PowerPoint Mobile, 
you can easily share a file by pressing Menu and then selecting Send via E-Mail 
or Beam File.

� In Outlook, you can insert a picture or attach a note or other file to an email. 
You can also receive pictures and attachments.

� ActiveSync® enables you to share files with your computer. (You can add or 
remove files directly from the Treo My Documents folder, located in your My 
Documents directory on your computer. These files are updated the next time 
you sync.)

� If you are near someone, you can beam files and applications between your 
smart device and your neighbor’s device using the IR port or Bluetooth® 
wireless technology.

� You can also store files on an expansion card and share the expansion card.
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Using Expansion Cards

The expansion card slot on your smart device enables you to add SD cards and 
MultiMediaCard cards to extend the storage capacity of your smart device. For 
example, SD or MultiMediaCard expansion cards can store the following:

� Pictures 

� Videos

� MP3 audio files

� Email attachments

� Games

� eBooks

� Applications

� Databases

Your smart device is also compatible with many Wi-Fi® SDIO cards. When 
purchasing an SDIO card, make sure the card is compatible with the Treo 700wx.

Expansion cards are sold separately. Your smart device comes with a dummy card 
inside the expansion card slot, to protect the slot. When you do not have a 

Tip: SD cards are faster than MultiMediaCard cards for reading and writing 
information.

Tip: Check with the card manufacturer to confirm compatibility before 
purchasing an SDIO card.
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functioning card inside the slot, reinsert the dummy card to protect the slot 
opening. 

Removing and Inserting Expansion Cards
1. Press down and release the dummy card.

2. After you feel the expansion card slot eject the dummy card, remove the 
card from the slot.

3. To insert an expansion card, hold your smart device with the screen facing 
you and the card with the label facing you. (The notch on the card should be 
in the lower-left corner next to the antenna.)

4. Insert the card into the expansion card slot until you feel it lock into place 
and hear the confirmation tone. 

Tip: We recommend that you purchase preformatted expansion cards. To 
format a card on your own, you need to connect a card reader (sold 
separately) to your computer.
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Opening Applications on an Expansion Card

After you insert an expansion card in the expansion card slot, you can open any of 
the applications stored on the expansion card.

1. Insert the expansion card into the expansion card slot. 

2. Press Start  and select Programs.

3. Select File Explorer.

4. Select the Show list in the upper-left, and then select Storage Card.

5. Select the application you want to open. 

Tip: To run an application on an expansion card, your smart device must have 
enough free space in the internal memory.

Notch
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Saving Files to an Expansion Card

You may find it helpful to automatically save the information on an expansion 
card. For example, when you create new Word Mobile documents, notes, Excel 
Mobile workbooks, pictures, videos, and audio files, you can save them directly to 
an expansion card. (Some applications may not support this feature.)

1. Insert an expansion card into the expansion card slot. 

2. Open the application you want to save the information from.

3. Press Menu  (right softkey) and select Options.

4. Select the Save to list, and then select Storage Card.

5. Press OK .

Moving Information Between Your Smart Device and an Expansion Card
1. Insert an expansion card into the expansion card slot. 

2. Open the application from which you want to move the information.

3. Go to the list view and highlight the item(s) you want to move.

4. Press Menu  (right softkey) and select Rename/Move.

5. Select the Location list, and then select where you want to move the 
information: Storage Card or Main Memory.

6. Press OK .

Tip: If you don’t see the Save to list on the Options screen, look on the other 
tabs (if present). If you still can’t find a Save to list, the application may 
not support this feature.
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Copying or Moving Applications and Files Between Your Smart Device and an 
Expansion Card

1. Insert the expansion card into the expansion card slot. 

2. Press Start  and select Programs.

3. Select File Explorer.

4. Select the file or application you want to copy or move (see “Exploring Files 
and Folders” on page 255).

5. Press Menu  (right softkey) and select Edit > Copy or Edit > Cut.

6. Go to the folder where you want to place the selected item.

7. Press Menu  (right softkey) and select Edit > Paste.

8. Press OK .

Viewing Available Expansion Card Memory

You can view how much space is available on the expansion card that is currently 
in the expansion card slot.

1. Insert the expansion card into the expansion card slot. 

2. Press Start  and select Settings.

3. Select the System tab, and then select Memory .

4. Select the Storage Card tab.

5. Press OK .

Tip: Your applications are usually located in the My Device / Program Files 
folder.
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Exploring Files on an Expansion Card
1. Insert the expansion card into the expansion card slot. 

2. Press Start  and select Programs.

3. Select File Explorer.

4. Select the Show list in the upper-left, and then select Storage Card.

5. Select the folder or files you want to view. 

6. Press OK .

Renaming an Expansion Card

If you change the contents of an expansion card, you may at some point want to 
rename the card to better match its contents.

1. Insert the expansion card into the expansion card slot. 

2. Press Start  and select Programs.

3. Select File Explorer.

4. Select the Show list in the upper-left, and then select My Device.

5. Highlight the current expansion card name (Storage Card by default).

6. Press Menu  (right softkey) and select Rename.

7. Enter a new name for the card.

8. Press OK .
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Tip: Before copying information to or renaming the files or folders on an 
expansion card, or renaming the card itself, make sure the card is not 
write-protected. See the instructions that came with your card for 
details.
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Sec t ion 6B

Customizing Your Smart Device

In This Section

� Today Screen Settings

� System Sound Settings

� Display and Appearance Settings

� Application Settings

� Locking Your Smart Device and Information

� Entering Owner Information

� System Settings

� Connection Settings

� Managing ISP Settings

� Connecting to a VPN

� Purchasing Accessories for Your Device 

Tip: For phone settings, see “Customizing Phone Settings” on page 87.
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Today Screen Settings

Selecting Your Today Screen Background

1. Press Start  and select Settings.

2. On the Personal tab, select Today .

3. On the Appearance tab, check the Use this picture 
as the background box.

4. Select Browse.

5. Select the picture you want to use.

6. Press OK .

Selecting Which Items Appear on Your Today Screen

1. Press Start  and select Settings.

2. On the Personal tab, select Today .

3. Select the Items tab.

4. Check the boxes next to the items you want to 
appear on your Today screen, and uncheck any 
items that you want to hide.

Tip: To change the color theme for your smart device, select a new theme 
from the Appearance tab in Today Settings. 
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5. (Optional) Select Options (if available) to configure the settings for the 
current item.

6. Press OK  to return to Today Settings.

7. Press OK .

Selecting Your Today Screen Search Engine

1. Press Start  and select Settings.

2. On the Personal tab, select Today .

3. On the Search tab, select the Internet search 
engine that appears on the Today screen. (The 
selections are the Sprint search engine [default], 
and Google.)

4. Press OK .

Did You 
Know?

There are lots of third-party plug-ins available for your Today screen. For 
clocks, calculators, MP3 players, weather guides, and much more, visit 
www.palm.com. 

http://www.palm.com/
http://www.palm.com
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System Sound Settings 

In certain situations, such as meetings and theaters, you need to turn off all 
sounds on your smart device. You can immediately silence all sounds on your 
smart device, including phone ringtones, Calendar notifications, and system 
sounds. This does not mute the speaker during phone calls. 

Setting the Ringer Switch

1. Slide the Ringer switch to Sound Mode Off . 

2. To hear all sounds again, slide the Ringer switch to Sound Mode On .

If the Ringer switch is set to no sound, the Ringer setting overrides the sound 
settings and all sounds are turned off, including any music you may be playing. 
Your smart device includes a silent alarm that can vibrate even when the Ringer 
switch is set to Sound Mode Off. 

Sound 
Mode Off

Sound 
Mode On
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When you slide the Ringer switch back to the Sound Mode On position, it restores 
the previous sound settings. For example, if the device ring volume is set to the 
loudest setting and you slide the Ringer switch to Sound Mode Off, you do not hear 
the device ring. When you move the Ringer switch back to Sound Mode On, the 
device ring volume is still set to the loudest setting.

Selecting Sounds & Notifications

1. Press Start  and select Settings.

2. On the Personal tab, select Sounds & Notifications .

3. On the Sounds tab, set any of the following options:

� Events: Turns sounds on/off for system 
warnings and error messages.

� Programs: Turns sounds on/off in the 
applications on your smart device. 

� Notifications: Turns alarms and reminders on/
off in the applications on your smart device.

� Screen taps: Turns sounds associated with 
tapping the screen on/off, and sets the 
volume level when this sound is turned on.

� Hardware buttons: Turns sounds associated with pressing buttons on/
off, and sets the volume level when this sound is turned on.
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4. Select the Notifications tab and set any of the following options:

� Event: Specifies which action you want to 
change the settings for. (The remaining 
options vary based on the action you select.)

� Play sound: Lets you turn the sound on/off for 
the selected event. (To select a different 
sound, select the list to the right of this 
setting, and then select a different sound. To 
preview the sound, select Play .)

� Repeat: Indicates whether the sound plays 
more than once, if turned on.

� Display message on screen: Indicates whether a notification message 
appears onscreen for the selected event.

� Vibrate: Indicates whether your smart device vibrates to notify you 
about the selected event.

5. Press OK .

Tip: To record, preview, delete, and send sounds on your smart device, select 
the Manage tab. To record a sound, press Menu and select New Sound. To 
play a sound, select it and press Play. To delete a sound, highlight it and 
press Backspace. To send a sound, highlight it, press Menu, and select Send 
Sound.
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Display and Appearance Settings

Adjusting the Brightness

1. Press Option , and then press . 

2. Press Left  and Right  to adjust the brightness.

3. Press OK .

Changing the Text Size

1. Press Start  and select Settings.

2. Select the System tab, and then select Screen .

3. Select the Text Size tab. 

4. Press Left  and Right  to adjust the text size.

5. Press OK .

Tip: If text looks rough around the edges, open the Screen Settings screen
and select the Clear Type tab. Check the Enable Clear Type box, and then 
press OK.
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Setting Display Formats

1. Press Start  and select Settings.

2. Select the System tab, and then select Regional 

Settings .

3. On the Region tab, select a region from the list. 
(The region selection sets the default format 
settings.)

4. (Optional) Select any of the following tabs to 
customize the format settings:

� Number: Sets the decimal symbol and number of decimal places, the 
digit grouping symbol and group size, list separators, negative number 
sign symbol and format, leading zero display, and measurement system 
(metric versus U.S.).

� Currency: Sets the currency symbol and position, the decimal symbol 
and position, digit grouping symbol and group size, and negative 
number format.

� Time: Sets the time style, separators, and AM and PM symbols.

� Date: Sets the short date style, separators, and long date style.

5. Press OK .
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Aligning the Screen

Occasionally, your screen can move out of alignment, causing the wrong feature 
to activate when you tap the screen. If this occurs, you need to align your smart 
device screen.

1. Press Start  and select Settings.

2. Select the System tab, and then select Screen .

3. On the General tab, select Align Screen. 

4. Tap the screen where indicated.

5. Press OK .

Changing the System Color Scheme

1. Press Start  and select Settings.

2. Select the Personal tab, and then select Today .

3. On the Appearance tab, select a theme in the list.

4. Press OK .

Tip: You can also set the background for your Today screen (see “Selecting 
Your Today Screen Background” on page 276).



284 Section 6B: Customizing Your Smart Device

Application Settings

Arranging the Start Menu

You can select which applications appear in the top 
level of the Start menu. You can still access the 
remaining applications by selecting Programs from the 
Start menu, and then selecting the application’s icon.

1. Press Start  and select Settings.

2. On the Personal tab, select Menus .

3. Check the boxes next to the applications you 
want to see in the Start menu. 

4. Press OK .

Reassigning Buttons

Buttons Settings lets you select which applications are 
associated with many of the buttons and key 
combinations on your smart device.

1. Press Start  and select Settings.

2. On the Personal tab, select Buttons .

3. On the Program Buttons tab, highlight the button 
or key combination you want to change in the 
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Buttons list. The hardware buttons are mapped to the following button 
numbers:

� Start  = Start Menu.

� OK  = OK/Close.

� Option  + Phone/Talk  = Internet Explorer.

� Option  + Start  = Calendar.

� Option  + OK  = Task Manager.

� Side button = Windows Media.

4. Select the Assign a program list, and then select the application you want to 
assign to the button or key combination you selected in step 3.

5. Press OK .

Setting Up Voice Commands

Voice commands enable you to use speech to execute some commands on the 
Start menu and the Programs menu. 

1. Assign the Side button to Voice Command. (See “Reassigning Buttons” on 
page 284 for details.)

2. Press Start  and select Settings.

3. On the Personal tab, select Voice Command.

4. Select Enable.

5. Select the items you want to enable. If an item is highlighted and the 
Options box is active, select the Options box to choose the features you want 
enabled for the highlighted item.
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Using Voice Commands
1. Set the Ringer switch at the top of your device to Sound Mode On.

2. Hold your device about nine inches away from your mouth, and then press 
and release the Voice Command button. (A tone plays and a microphone icon 
appears at the top of your screen.) 

3. In a clear voice say the command. For example:

� To access Help, say, “Help.” (After Voice Command finishes speaking, a 
microphone icon appears at the top of your screen. Say your answer. For 
example, say, “General” to access general Help topics.)

� To access your Calendar, say, “Start Calendar.”

� To access your music, say, “Start Windows Media.” (After Voice 
Command finishes speaking, a microphone icon appears at the top of 
your screen. Say your answer.)

Tip: You can also use the Sprint Voice commands to place calls. (See “Making a 
Call With Sprint PCS Voice Command” on page 79).

Tip: You can interrupt during a question by pressing the Voice Command 
button. Once the microphone icon is visible you may say your answer.
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Setting Input Options

1. Press Start  and select Settings.

2. On the Personal tab, select Input .

3. Select the Word Completion tab and set any of the following options:

� Suggest words when entering text: Indicates 
whether word suggestions appear as you 
enter text. (You can also specify how many 
letters you want to enter before a suggestion 
appears, how many suggestions you want to 
see, and whether a space appears after you 
insert a suggested word.)

� Replace text as you type: Indicates whether the 
text you type adds to existing text or replaces 
it. (This is similar to the Insert function on a computer keyboard.)

Tip: To enter a suggested word, simply tap it. 
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4. Select the Options tab and set any of the following options:

� Voice recording format: Sets the format in 
which you save voice notes.

� Default zoom level for writing: Sets the initial 
size of text entered using onscreen writing 
methods.

� Default zoom level for typing: Sets the initial 
size of text entered using the keyboard.

� Capitalize first letter of sentence: Sets whether 
the first letter of a sentence automatically 
appears in uppercase, without pressing one 
of the Shift keys.

� Scroll upon reaching the last line: Sets whether the display automatically 
scrolls when you select the last line of visible information.

5. Press OK .
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Locking Your Smart Device and Information

Your smart device includes several features that help you protect your smart 
device from inadvertent use and keep your information private. The built-in 
security software lets you use your smart device for emergency calls, such as 
dialing 911, even if it is locked.

� Keyguard: Manually disables all buttons and the screen’s touch-sensitive 
feature to prevent accidental presses in your briefcase or pocket.

� Auto-Keyguard and touchscreen lockout: Automatically enables Keyguard after 
a period of inactivity and lets you disable the screen’s touch-sensitive feature 
during an active call.

� Phone Lock: Requires a lock code to make calls.

� System password lock: Requires a password to see any information on your 
smart device.

Using Keyguard

By default, your keyboard locks so that you don’t accidentally press buttons or 
activate screen items while your smart device is in a pocket or bag.

� To disable Keyguard, press Center .

Tip: To avoid accidentally pressing onscreen buttons while you’re holding 
your smart device up to your ear to speak, you can disable the screen’s 
touch-sensitive feature during active calls. When the screen’s touch-
sensitive feature is disabled, you must use the 5-way navigator to access 
items on the screen.
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� To manually turn on Keyguard when your smart device screen is on, press 

Option  and Power/End .

Using Auto-Keyguard and Touchscreen Lockout

Auto-Keyguard lets you automatically lock the keyboard after a period of 
inactivity.

1. Press Start  and select Settings.

2. On the Personal tab, select Keyguard .

3. Set any of the following options:

� Auto-Keyguard: Sets the period of inactivity 
that passes before the keyboard 
automatically locks or before the auto-
keyguard feature is disabled.

� Disable touchscreen: Indicates whether the 
screen’s touch-sensitive feature is enabled 
during a call. 

4. Press OK .

Did You 
Know?

If you’re using a headset or hands-free device and your device is in a 
pocket or bag, you can manually turn on Keyguard during a call to prevent 
accidental key presses. Press Option and Power/End to manually turn on 
Keyguard.
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Using Phone Lock

You can lock your smart device to prevent unauthorized use of your account.

1. Press Start  and select Settings.

2. On the Personal tab, select Phone .

3. Select the Security tab and set any of the 
following options:

� Auto-lock: Sets whether your smart device 
locks automatically and when this occurs.

� Change Lock Code: Lets you assign or change 
the lock code used to unlock your smart 
device. (Your default lock code is the last four digits of your phone 
number. If you change the lock code, select OK to accept your new code.)

4. Press OK  to finish.

Tip: When your phone is locked, you must enter a lock code to place calls, 
except for emergency numbers and Sprint Customer Service (*2).

Tip: When Phone Lock is on, you can unlock your phone by going to the Today 
screen, entering your lock code, and then selecting Enter. You do not need 
to enter your password to answer a call.
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Using System Password Lock

To protect your personal information, you can lock the system so that you need to 
enter your password to access any of your information or use other features of 
your smart device. 

1. Press Start  and select Settings.

2. On the Personal tab, select Lock .

3. On the Password tab, check the Prompt if device 
unused for box to turn on the password feature.

4. Select the first list, and then select how long a 
period of inactivity must pass before you are 
prompted to enter a password to unlock the 
system.

5. Select the Password type list, and then select a 
format for your password.

Important: If you lock your system, you must enter the exact password to unlock it. If 
you enter an incorrect password, you are given another chance. Each 
time an incorrect password is entered, you are given progressively longer 
time periods between your chances to enter the password. If you forget 
the password, you need to perform a hard reset to resume using your 
smart device. Performing a hard reset deletes all the entries in your smart 
device. However, you can restore all previously synchronized information 
the next time you sync (see “Synchronizing Information—The Basics” on 
page 27). In addition, your device might not re-establish a Sprint PCS 
Vision session after a hard reset. To manually establish a new Sprint PCS 
Vision session, open the browser to access a Web site.
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6. Select Password, tap the onscreen keyboard  icon, and enter your 

password. (Then tap the onscreen keyboard  icon.)

7. Select Confirm, tap the onscreen keyboard  icon, and enter the password 

again. (Then tap the onscreen keyboard  icon.)

8. (Optional) Select the Hint tab and enter a hint to help you recall 
your password.

9. Press OK .
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Entering Owner Information

You can enter personal information that you want to associate with your smart 
device, such as your name, company name, and phone number. You can also set 
whether you want this information to appear when you turn on your smart 
device. If you lose your smart device, this feature can help the person who finds it 
return it to you.

1. Press Start  and select Settings.

2. On the Personal tab, select Owner Information .

3. On the Identification tab, enter any of the contact 
information you want to include.

4. Select the Notes tab and then enter any 
additional text you want to include.

5. Select the Options tab and check the boxes to 
indicate which information (if any) you want to 
appear on the screen when you turn on your smart device. 

6. Press OK .

Tip: You can also display your Owner Information on your Today screen. See 
“Selecting Which Items Appear on Your Today Screen” on page 276 for 
details.
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System Settings

Setting the Date and Time

Clock & Alarms Settings lets you set the time zone, time, and date for your home 
location and a location that you visit.

1. Press Start  and select Settings.

2. Select the System tab, and then select Clock & Alarms .

3. On the Time tab, select Home.

4. Select the first list, and then select the time zone 
for your home location.

5. Select the hour, and then press Up  or Down  
to increase or decrease the hour setting. (Repeat 
this process for the minutes, seconds, and AM/
PM settings.)

6. (Optional) Select Visiting and set the information 
for a location that you visit often.

7. Press OK .

8. If prompted, select Yes to accept your changes.

Tip: To set the display format for the date and time, see “Setting Display 
Formats” on page 282.
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Setting System Alarms

System alarms let you set alarms that are not associated with a task or 
appointment. For example, you can use your smart device as an alarm clock when 
you travel, or set alarms to remind you when it’s time to take medication or pick 
up the kids. 

1. Press Start  and select Settings.

2. Select the System tab, and then select Clock & 

Alarms .

3. Select the Alarms tab. 

4. Check a box to turn on that alarm.

5. Select the description next to the box you 
checked, and enter a description for the alarm.

6. Select the days of the week you want the alarm to go off. (You can select 
multiple days for each alarm.)

7. Select the time you want the alarm to go off, and then press OK .

8. Select , check the boxes to select how you want the alarm to go off, and 

then press OK .

9. Press OK  to finish.

10. If prompted, select Yes to accept your changes.

Tip: To change the alarm sound, select the alarm sound icon, select the Play 
Sound list, and then select the alarm sound you want to use.
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Managing Identity Certificates

Your smart device may include preinstalled certificates. Certificates are digital 
documents that are used to authenticate and exchange information on 
networks. Certificates can be issued for a user, a device, or a service. 

1. Press Start  and select Settings.

2. Select the System tab, and then select Certificates .

3. Select any of the following:

� Personal: Displays certificates that establish your identity when you log 
in to a secured network, such as a corporate network. 

� Root: Displays certificates that identify the computers, such as servers, 
that you connect to. (These certificates help prevent unauthorized users 
from accessing your smart device and information.)

4. Press OK  to finish.

Enabling Error Reporting

Error Reporting sends information that helps diagnose application errors for 
devices running Windows Mobile® software. When an error is detected, a text file 
is created. You can review the file and choose whether you want it delivered to 
technical support. The information is used by programming groups at Microsoft 
for quality control and is not used for tracking individual users or installations for 
any marketing purpose. The information that is collected is technical information 
about the state of your system when the error occurred. No documents (or any 

Tip: To delete a certificate, tap and hold the certificate in the list, and then 
select Delete from the shortcut menu.
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information contained in them) are intentionally sent with the report. To ensure 
further security, the report is transmitted by means of a secure connection and is 
kept confidential and anonymous in a limited-access database. 

If your smart device is connected to your computer when you send the error 
report, you are not billed for sending error reports—provided your computer is 
connected to the Internet. If you use the Sprint network to send an error report, 
data transfer charges apply. 

1. Press Start  and select Settings.

2. Select the System tab, and then select Error Reporting .

3. Select whether you want to enable or disable error reporting.

4. Press OK  to finish.

Setting Up a GPS Device

If you purchased an optional Global Positioning System (GPS) receiver, your 
smart device can show your exact location on a map. 

1. Press Start  and select Settings.

2. Select the System tab, and then select GPS .

Tip: This error-reporting method meets the privacy regulations of the 
European Union (EU) as well as the Fair Information Practice Principles of 
the Federal Trade Commission. To view the Fair Information Practice 
Principles, visit the Federal Trade Commission Web site at www.ftc.gov/
reports/privacy3/fairinfo.htm.

http://www.ftc.gov/reports/privacy3/fairinfo.htm
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3. On the Programs tab, select the GPS program port list, and then select the 
port for applications to use to access GPS information. (This port must also 
be selected in your GPS application’s configuration settings.)

4. Select the Hardware tab.

5. Select the GPS hardware port list, and then select the port to which your GPS 
receiver is connected. (This must be a different port from the one you set in 
step 3 as your program port. To connect to the GPS device using a Bluetooth 
connection, you must first set up a partnership between the two devices. 
See “Setting Up a Bluetooth Connection” on page 161.)

6. Select the Access tab and check the Manage GPS automatically box. This 
setting lets more than one application simultaneously access your GPS 
information.

7. Press OK  to finish.

Viewing Memory Usage

1. Press Start  and select Settings.

2. Select the System tab, and then select Memory .

3. Select any of the following tabs:

� Main: Displays the amount of memory assigned to your applications 
and information, as well as the amount of memory in use versus the 
available memory.

� Storage Card: Displays the amount of memory available on an expansion 
card that is inserted into the expansion slot on your smart device.



300 Section 6B: Customizing Your Smart Device

� Running Programs: Lists the applications that are in use on your smart 
device. (To switch to an application, highlight it and select Activate. To 
close an application, highlight it and select Stop. To close all open 
applications, select Stop All.)

4. Press OK  to finish.

Viewing and Optimizing Power Settings

1. Press Start  and select Settings.

2. Select the System tab, and then select Power .

3. On the Battery tab, view the power remaining in your battery. 

4. Select the Advanced tab and set whether your smart device turns off 
automatically after a specified period of inactivity. (You can assign different 
intervals for battery power and external power.)
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5. Press OK  to finish.

Tip: To conserve additional battery power, adjust the display backlight 
setting. Press Start and select Settings. Select the System tab, and then 
select Backlight. On the Battery Power tab, set whether the display 
backlight turns off automatically after a period of inactivity.



302 Section 6B: Customizing Your Smart Device

Connection Settings

Turning Wireless Services On/Off 

1. Press Start  and select Settings.

2. Select the Connections tab, and then select 
Wireless Manager.

3. Turn your smart device’s wireless features on/off. 
(Select All to turn all wireless features on/off.)

4. Press OK  to finish.

You can also turn wireless services on and off by tapping the signal-strength icon 

 at the top of the screen and then selecting Wireless Manager. 

Note: The Wi-Fi selection appears only if a Wi-Fi card is installed in your smart 
device. You must purchase and install a third-party Wi-Fi card to use this 
feature.

Tip: To change the settings for one of the displayed wireless features, press 
Menu and select the wireless feature you want to change.

Tip: Turning off the Bluetooth® feature may improve your Wi-Fi card 
performance. To turn the Bluetooth feature off, go to your Today screen, 
tap the Bluetooth icon, and then uncheck the Turn on Bluetooth box.
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Setting Up a Wi-Fi® Connection

Many corporate organizations and public environments, such as coffee shops, 
airports, and libraries, offer access to a Wi-Fi network. A Wi-Fi network is a 
wireless local area network (WLAN) based on the 802.11 standard. When you 
purchase an optional Wi-Fi SDIO card, you can use your smart device’s built-in 
software to set up a Wi-Fi connection and quickly connect your smart device to a 
Wi-Fi network when you’re within range of an accessible Wi-Fi network.

Some Wi-Fi networks are known as open networks because they broadcast their 
name (SSID) and do not require a password. Other Wi-Fi networks broadcast their 
name but do require a password. Networks that do not broadcast their name are 
known as closed networks. Follow the instructions for the type of network you 
want to connect to.

Important! Depending on where you are on a network and certain coverage 
conditions, you might experience interruptions with your phone 
operation while using a Wi-Fi card. Palm recommends that you turn off 
the phone radio when using any Wi-Fi card or remove the Wi-Fi card 
when not in use to ensure that you can always make and receive phone 
calls. For EMERGENCY calls, always remove the card from your smart 
device to ensure optimal connectivity.

Note:  See “Important Safety Information” on page 361 for additional guidance 
on using a Wi-Fi card with your Treo device.

Key Term: SSID The name that identifies a Wi-Fi network. If a network does not 
broadcast its SSID, you must get the SSID from the system administrator 
in order to connect to the network.



304 Section 6B: Customizing Your Smart Device

Connecting to a Network That Broadcasts Its Name

Wi-Fi networks in public places often broadcast their network name. Your smart 
device automatically attempts to detect some network settings, so you can 
connect to this type of network with minimal configuration.

To connect to a network that broadcasts its name, complete the following steps:

1. Wake up your smart device’s screen (see “Waking Up the Screen and Turning 
It Off” on page 19).

2. Insert the Wi-Fi card into the expansion slot (see “Removing and Inserting 
Expansion Cards” on page 269).

3. If the Multiple Networks Detected dialog box appears, select the network you 
want to connect to.

4. When the New Network Detected dialog box appears, select the type of 
network you want to connect to.

5. Press Connect  (left softkey) to connect to the network.

6. If prompted, enter the password provided by the system administrator.

Did You 
Know?

When you are browsing the Internet or performing another Wi-Fi activity, 
you can answer a call without interrupting that activity.

Tip: The wired equivalent privacy (WEP) encryption method is enabled by 
default and may interfere with your ability to connect to a network that 
broadcasts its name. See “Connecting to a Closed Network” on page 305 
to learn how to enable or disable WEP encryption.
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Connecting to a Closed Network

Since closed networks have additional security features, your smart device 
cannot detect the network’s settings; you must obtain the settings from the 
system administrator and enter the settings manually. You can also use these 
steps to manually create a connection with an open network.

1. Wake up your smart device’s screen (see “Waking Up the Screen and Turning 
It Off” on page 19), and then insert the Wi-Fi card into the expansion slot 
(see “Removing and Inserting Expansion Cards” on page 269).

2. Tap Wi-Fi  in the title bar.

3. Select the Settings link.

4. Select Network Cards .

5. Select Add New.

6. On the General tab, set the following:

� Network name: Specifies the SSID provided by 
the system administrator.

� Connects to: Specifies whether this 
connection connects to the Internet or to 
Work. (You may need to select Work to access 
a corporate intranet.)

� This is a device-to-device (ad-hoc) connection: 
Indicates whether you’re connecting to 
another device or to an access point (network).

Key Term: Wi-Fi access point (Also called a hotspot.) A network device with an 
antenna that provides wireless connections to a larger network.
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7. Select the Network Key tab, and then set the following:

� Authentication: Sets the method used to 
identify devices that connect to the network.

� Open: Indicates that the network uses 
open authentication.

� Shared: Indicates that the network uses 
shared authentication.

� WPA: Indicates that the network is a WPA 
network that uses 802.1x protocols.

� WPA-PSK: Indicates that the network is a 
WPA network that requires a pre-shared key (password).

� Data Encryption: Sets the encryption method. (The options in this list 
vary based on your Authentication setting.)

� Disabled: Turns data encryption off.

� WEP: Turns on the wired equivalent privacy encryption method.

� TKIP: Turns on the temporal key integrity protocol encryption method. 
(This method is often used to encrypt WPA and WPA-PSK 
connections.)

� The key is automatically provided: Indicates whether you need to specify 
the Network key and Key index provided by your system administrator, or 
whether the network provides this information. The availability of these 
options varies based on your Authentication and Data Encryption 
settings.
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8. Select the 802.1x tab, and then set the following 
if available (the settings vary based on your 
settings on the other tabs and on the supported 
features of your Wi-Fi SDIO card):

� Use IEEE 802.1x network access control: Lets 
you set these parameters if required by the 
network.

� EAP type: Specifies the extensible 
authentication protocol type.

9. Press OK .

Selecting a Wi-Fi Network

After you set up a Wi-Fi connection, it’s easy to connect to that network. If you 
have access to multiple Wi-Fi networks, you can select which network you want 
to connect to. 

1. Wake up your smart device’s screen (see “Waking Up the Screen and Turning 
It Off” on page 19), and then insert the Wi-Fi card into the expansion slot 
(see “Removing and Inserting Expansion Cards” on page 269).

2. Tap Wi-Fi  in the title bar.

3. Select the Settings link.

Did You 
Know?

You can conserve battery power by removing the Wi-Fi card or turning off 
a Wi-Fi connection when you are not planning to use it for an extended 
period.



308 Section 6B: Customizing Your Smart Device

4. Select Network Cards .

5. Highlight the network you want to connect to.

6. Press and hold Center  to open the shortcut menu, and then select 
Connect.

Tip: Insert the Wi-Fi card into your smart device to automatically connect to 
the Wi-Fi network you connected to most recently if it is available.
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Managing ISP Settings

Your smart device is already set up to connect to the Internet using a high-speed 
data connection on the Sprint network. To connect to the Internet, simply start 
Internet Explorer Mobile. 

For special situations, such as connecting to your ISP (Internet service provider) or 
a remote access server (RAS), you can set up another connection. Before you 
begin, obtain the following information from your ISP or system administrator: 

� ISP server phone number or access point.

� Username.

� Password.

1. Press Start  and select Settings.

2. Select the Connections tab, and then select Connections .

3. On the Tasks tab, select Manage existing connections.

4. Select the Modem tab. 

5. Highlight the connection you want to view or change, and then select Edit, 
or to create a new connection, select New.

6. Follow the onscreen instructions to edit or create the connection.
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Connecting to a VPN

If you want to use your smart device to access your corporate email account or 
other files on your corporate server, you may need to set up a VPN (virtual private 
network). A VPN enables you to log in to your corporate server through the 
company’s firewall (security layer). 

You need to set up a VPN to access a corporate server in either of the following 
two situations:

� Your company’s wireless local area network (LAN) is outside the firewall.

� Your company’s wireless LAN is inside the firewall, but you are accessing the 
network from outside the firewall (for example, from a public location or at 
home). 

Check with your company’s system administrator to see if a VPN is required for 
accessing the corporate network. If you need a VPN, you must purchase and 
install a third-party VPN client to use this feature.

Before you begin setting up a VPN, ask your system administrator for the 
following information:

� Your username and password.

� Your server’s domain name.

� Your server’s TCP/IP settings. 

� Your server’s host name or IP address.

Did You 
Know?

A common cause of sync problems is the presence of protective software, 
such as VPNs or firewalls, on your computer or network. See “ActiveSync 
Does Not Respond to Sync Attempt” on page 334.
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1. Install your third-party VPN client (see “Installing Applications” on 
page 257). 

2. Press Start  and select Settings.

3. Select the Connections tab, and then select Connections .

4. On the Tasks tab, select Add a new VPN server connection.

5. Follow the onscreen instructions for entering the settings provided by your 
corporate system administrator.

Setting Up a Proxy Server

1. Press Start  and select Settings.

2. Select the Connections tab, and then select Connections 

3. On the Tasks tab, select Set up my proxy server.

4. Check both the boxes near the top of the screen. 

5. Select Proxy server and enter the proxy server name. 

Tip: To manually start a data connection on the Sprint network or another 
network, go to Connections Settings. On the Tasks tab, select Manage 
existing connections. Tap and hold the connection you want to start, and 
then select Connect from the shortcut menu. 

VPN servers may require that you install specific VPN software 
(sold separately) on your device. Go to www.palm.com/us/support/
treo700wxsprint for more information.

Tip: To change settings such as the port number, proxy server type, or 
credentials, select Advanced.

http://www.palm.com/us/support/treo700wxsprint
http://www.palm.com/us/support/treo700wxsprint
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6. Press OK .

Ending a Data Connection

If your service plan includes minutes-of-use fees for data connections, you can 
reduce costs by ending the data connection when you’re finished browsing the 
Web.

1. Use the stylus to tap the data arrows  or  on the title bar.

2. Select Disconnect from the shortcut menu.

Note: Setting a proxy server may prevent you from accessing some Sprint PCS 
Vision Web pages.
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Purchasing Accessories for Your Device

These and other accessories are available from your local Sprint Store or at 
www.palm.com. For more information, you can also call the Sprint PCS Accessory 
Hotline at 800-974-2221 or visit www.sprint.com. Next-day delivery is available in 
select areas. 

� Vehicle Power Charger
Charges your device in your vehicle using the car lighter socket.

� Replacement Battery
Serves as a backup battery if your primary battery becomes drained, is 
charging, or has reached the end of its useful life.

� USB Sync Cable
Provides an extra cable (your device comes with one USB sync cable). 

� USB Docking Cradle
Provides a convenient and elegant desktop solution for synchronizing 
information, charging your device with any USB-enabled PC computer, and 
charging a second battery. 

� Extra AC Charger
Provides an extra 100 - 240 volt AC charger for your device.

� International Travel Adapters
Provides snap-on adapters for continental Europe, the United Kingdom, and 
Australia. For use with the Extra AC Charger only.

� Leather Side Case With Belt Clip
Clips to your belt or bag for quick access and protection for your device.

� Stylus
Provides a replacement or spare stylus for your device.

http://www.palm.com
http://www.sprint.com
http://www.sprint.com
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Transferring Information From Another Device

For information on transferring your information from a previous Windows 
Mobile® device or from a Palm OS® device to your new Treo700wx smart device, 
visit www.palm.com/us/support/treo700wxsprint.

If you have questions about Windows Mobile, you can also go to the Microsoft 
Windows Mobile Web site (http://www.windowsmobile.com).Search for Palm 
devices or Pocket PCs for information. 

Did You 
Know?

You can purchase a third-party application that lets you run Palm OS® 
applications on your Treo device.

Important: To prevent your smart device from malfunctioning, do not use a backup 
utility to transfer your information from another device to your new 
smart device. In addition, do not use a backup utility to back up and 
restore your information if you update your device’s operating system.

http://www.palm.com/us/support/treo700wxsprint
http://www.windowsmobile.com
http://www.windowsmobile.com
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Trouble Installing the Desktop Software?

The Getting Started CD installs the software and drivers that let you synchronize 
with Microsoft® Office Outlook® for Windows. You can also use the CD to install 
the Outlook software if it is not already on your device. You should install and 
open Outlook before you install or use ActiveSync.

If you want to synchronize with a different personal information manager (PIM), 
you must install a third-party solution. Contact the PIM’s author or vendor to 
learn if software is available for your Treo device.

1. Shut down your computer, and then turn it on again.

2. On your computer, click Start > Control Panel > Add or Remove Programs.

3. Remove ActiveSync if it is on your computer.

4. Quit any active applications, including virus scanners and Internet security 
applications.

5. Make sure you’re installing the version of the software that came with your 
smart device on the Getting Started CD. (Other versions may not work with 
this smart device.)

6. Make sure your computer profile includes administrator rights to install 
software. (In large organizations, these are usually granted by the system 
administrator.)
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Resetting Your Smart Device

Performing a Soft Reset

A soft reset is similar to restarting a computer. If your smart device is not 
responding or you have trouble synchronizing with your computer, a soft reset 
may help.

1. Use one hand to press the Battery Door Release and use the other hand to 
slide the battery door downward to remove it from your smart device.

2. Use the stylus tip to gently press the reset button on the back of your smart 
device.

3. Wait for the progress bar on the Treo logo screen to fill before continuing to 
use your smart device. (If the phone or Bluetooth signals were on before a 
reset, these signals automatically turn on after the reset.)
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Performing a Hard Reset

A hard reset erases all personal information, such as appointments, contacts, and 
tasks, as well as programs you have added, such as third-party software on your 
smart device. Never do a hard reset without first trying a soft reset. You can 
restore previously synchronized information the next time you sync. 

Review the following important information before performing a hard reset:

� Synchronize to restore your Outlook data, such as Outlook email, Calendar, 
Contacts, Notes, and Tasks. You can use a backup and restore solution (make 
sure it’s an application that’s approved by Palm) to restore configurations and 
preferences such as speed-dials, SMS entries, call log information, and 
personal settings.

� Some third-party applications do not create a backup on your computer when 
you synchronize. If you do a hard reset, you may lose information in these 
applications and you need to reinstall the application on your device after the 
hard reset. Please contact the developer to find out if your information is 
backed up during synchronization.

� When you synchronize after a hard reset, the source folder in My Documents 
changes from Treo My Documents to WM_your name.

� Your device might not re-establish a Sprint PCS Vision session after a hard 
reset. To manually establish a new Sprint PCS Vision session, open the Web 
browser to access a Web site.

Tip: You can also do a soft reset by unplugging your device from a power 
source (if connected) and then removing the battery and reinserting it.
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A hard reset can tell you whether a problem stems from your smart device or 
from an application installed on it. If you do not experience the problem after you 
perform a hard reset, the problem may be related to software you installed. See 
“Third-Party Applications” on page 350 for suggestions on diagnosing third-party 
software issues.

1. Use one hand to press the Battery Door Release and use the other hand to 
slide the battery door downward to remove it from your smart device.

2. If the screen is off, press Power/End  to wake up the screen. 

3. While pressing and holding Power/End , use the tip of the stylus to 
gently press  and hold the reset button on the back of your smart device.

4. Continue pressing and holding both buttons until the “Erase all data?” 
prompt appears. 

5. Press Up  to confirm the hard reset.

6. Wait for the progress bar on the Treo logo screen to fill before continuing to 
use your smart device.

7. (Optional) Sync your smart device with your computer to restore your 
previously synchronized information. (Connect your smart device to your 
computer, press Menu  (right softkey), and then select Programs > 
ActiveSync > Sync. If you use a backup utility, you may also need to restore a 
backup to recover additional information and settings.)
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Replacing the Battery

Your smart device comes with a replaceable battery. Be sure to use a replacement 
battery from Palm that is compatible with theTreo700wx smart device. 

1. Press Power/End  to turn off the screen.

2. Use one hand to press the Battery Door Release and use the other hand to 
slide the battery door downward to remove it from your smart device.

3. Place a finger in the notch between the stylus and the battery and lift the 
battery up at a 45-degree angle.

4. Align the battery contacts with the phone contacts inside the battery 
compartment. 

5. Insert the battery into the compartment at a 45-degree angle, pressing it 
into place. (Slide the battery door onto the back of the smart device until it 
clicks into place.)

6. Wait for the screen to turn on, and then enable the network time or set the 
date and time when prompted.

Did You 
Know?

Your device stores all your information even when you remove the 
battery.
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Tip: Be sure to dispose of your old battery in an environmentally responsible 
and legal way. In some areas, disposal in household or business trash is 
prohibited.

Battery Door 
Release

Notch

Phone Contacts

Battery Contacts



Section 7A: Help 325

H
elp

Performance

The Applications Are Running Slower Than Usual

1. Press Start  and select Settings.

2. Select System, and then select Memory .

3. Select Running Programs. 

4. Select Stop All to close all your open applications.

5. Press OK .

If the previous steps don’t fix the problem, try doing a soft reset (see “Performing 
a Soft Reset” on page 320). If the problem persists, follow these steps to turn off 
the Voice Command setting, if it is enabled:

1. Press Start  and select Settings. 

2. Select the Personal tab, and then select Voice Command .

3. Uncheck the Enabled box.

4. Press OK .

Tip: Be sure that third-party applications are compatible with Windows 
Mobile version 5.2 or later. Applications written for earlier versions can 
have performance problems. If you can try a free version of the software 
before purchasing it, you can test it first to make sure it works properly.
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Screen 

The Screen Appears Blank
1. When the time period specified in Backlight Settings expires, the screen 

dims; one minute later, the screen automatically turns off. (Press any key 
except Power/End to wake up the screen. Pressing Power/End hangs up the 
call.)

2. Look closely at the screen. If you can see a dim image, try adjusting the 
screen brightness (see “Adjusting the Brightness” on page 281).

3. If that doesn’t work, perform a soft reset (see “Performing a Soft Reset” on 
page 320).

4. If that doesn’t work, connect your smart device to the AC charger (see 
“Charging the Battery” on page 13) and perform a soft reset again.

5. If that doesn’t work, perform a hard reset (see “Performing a Hard Reset” on 
page 321).

Tip: Make sure that third-party applications support 240x240 screen 
resolution. Some older applications have screen-size limits. 
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The Screen Doesn’t Respond Accurately to Taps or Activates Wrong Features
1. Make sure there is no debris trapped under the edges of the screen.

2. Press Start  and select Settings. 

3. Select the System tab, and then select Screen . 

4. On the General tab, select Align Screen.

5. Follow the onscreen instructions to align the screen.

6. Press OK .

Tip: To find carrying cases that protect the screen, and other useful 
accessories, visit www.palm.com

http://
www.palm.com/
http://
www.palm.com/
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Network Connection

Signal Strength Is Weak
1. If you’re standing, move about 10 feet in any direction.

2. If you’re in a building, move near a window. Open any metal blinds.

3. If you’re in a building, move outdoors or to a more open area.

4. If you’re outdoors, move away from large buildings, trees, or electrical wires.

5. If you’re in a vehicle, move your smart device so that it’s level 
with a window.

My Smart Device Won’t Connect to the Wireless Network
1. Try the preceding suggestions for weak signals.

2. Turn off your device and turn it on again (see “Turning Your Phone On and 
Off” on page 18).

3. Perform a soft reset (see “Performing a Soft Reset” on page 320).

4. Depending on where you are on a network and certain coverage conditions, 
you might experience interruptions with your phone operation while using 
a Wi-Fi card. (Palm recommends that you turn off the phone radio when 
using any Wi-Fi card or remove the Wi-Fi card when not in use to ensure 
that you can always make and receive phone calls. For EMERGENCY calls, 
always remove the card from your smart device to ensure optimal 
connectivity.)

Tip: Become familiar with low coverage areas where you live, commute, work, 
and play, so you know when to expect signal strength issues.
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My Smart Device Seems to Turn Off by Itself

If a system error and reset occur, the phone automatically turns on if it was on 
before the reset. However, if your smart device can’t determine if your phone was 
on before the reset, it does not automatically turn on the phone (see “Turning 
Your Phone On and Off” on page 18).

I Can’t Tell If Data Services Are Available

The following icons appear in the title bar to indicate whether data services are 
available:

Key Term: 1xRTT (Single carrier [1x] radio transmission technology): A wireless 
technology that can provide fast data transfer and Internet access with 
average speeds of 60-80Kbps and bursts up to 144Kbps. 

Key Term: EVDO (Evolution Data Optimized): A wireless broadband technology that 
is designed for very high-speed data transfer with average download 
speeds of 400-600Kbps, capable of reaching speeds up to 1.8Mbps, and 
upload speeds up to 156Kbps.

 or The Sprint Mobile Broadband (EVDO) or Sprint PCS Vision 
(1xRTT) network is within range. You can make or receive 
calls or open a data connection.

 or 
Your phone is connected to the Sprint Mobile Broadband 
or Sprint PCS Vision network, but you are not actively 
transmitting data. You can still make or receive calls.
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My Smart Device Won’t Connect to the Internet

Your smart device supports Sprint PCS Vision (1xRTT) or Sprint Mobile Broadband 
(EVDO) wireless data networks. To connect to the Internet, you must subscribe to 
data services with Sprint. 

� Contact Sprint to verify that your subscription plan includes data services and 
that these services have been correctly activated. Sprint should also be able 
to tell you if there are any outages in your location. 

� Press and hold Power/End  to turn off your phone. Then press and hold the 
same button to turn it back on again.

� Perform a soft reset (see “Performing a Soft Reset” on page 320).

� Confirm that data services are correctly configured on your smart device:

 or 
Your phone is on and a Sprint Mobile Broadband or 
Sprint PCS Vision data connection is active. If a mobile 
broadband data connection is active, you can still make 
or receive calls. When you make or receive a call, the data 
transmission is automatically interrupted. If a Sprint PCS 
Vision data connection is active, you can still make calls, 
but you cannot receive calls (incoming calls go to 
voicemail). When you make a call the data transmission is 
automatically interrupted.

Your smart device is connected to a computer or network 
which is providing a data connection.

A data connection is not available or the phone is turned 
off (the wireless connection is off).
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1. Press Start  and select Settings. 

2. Select the Connections tab, and then select Connections . 

3. On the Tasks tab, select Manage existing connections.

4. If Sprint PCS appears in the list, press OK . If not, contact Sprint for 
assistance.

I Can’t Send or Receive Text Messages
� Make sure your phone is on (see “Turning Your Phone On and Off” on 

page 18).

� Contact Sprint to verify that your plan includes messaging services, that 
these services have been correctly activated, and that they are available at 
your location (Sprint should be able to tell you if messaging services have 
been experiencing transmission delays).

� If possible, contact the recipient of the message, and make sure the receiving 
device can handle the type of message you’re sending.

� If a text message arrives but does not display a notification, perform a soft 
reset (see “Performing a Soft Reset” on page 320).

I Can’t Make or Receive Calls Using a Hands-Free Device With Bluetooth® 
Wireless Technology

Verify all of the following:

� The Turn on Bluetooth box is checked in Bluetooth Settings.

� Your Bluetooth device is charged and turned on.

� Your smart device is within range of the hands-free device. Bluetooth range is 
up to 30 feet in optimum environmental conditions, which include the 



332 Section 7A: Help

absence of the following: obstacles, radio interference from nearby electronic 
equipment, and other factors.

� The Bluetooth Settings screen is closed.

� You are away from other devices using the 2.4 GHz radio frequency, such as 
cordless phones, microwaves, and Wi-Fi® equipment. If this is impossible, 
move the phone closer to the hands-free device.

� The device specifications are compatible with your device.

I Lost the Connection Between My Smart Device and My Bluetooth Headset

1. Press Start , and then select Settings. 

2. Select the Connections tab, and then select Bluetooth. 

3. Select the Devices tab.

4. Select your headset name from the list.

5. In Partnership Settings, make sure the Hands Free option box is checked.

6. Select Save.

7. Highlight the headset name.

8. Press and hold Center  to open the shortcut menu, and then select Set as 
Hands-Free. 

9. Test your headset by making or receiving a call.
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If the headset still doesn’t work, delete the existing partnership and create a new 
one. To delete the partnership:

1. Press Start , and then select Settings. 

2. Select the Connections tab, and then select Bluetooth. 

3. Select the Devices tab.

4. Highlight the headset device name.

5. Press and hold Center  to open the shortcut menu, and then select 
Delete.

6. Create a new partnership (see “Setting Up a Bluetooth Connection” on 
page 161).

Did You 
Know?

You can go to the Windows Web site for more information at 
www.windowsmobile.com. 

http://www.windowsmobile.com


334 Section 7A: Help

Synchronization (ActiveSync® Software)

Synchronization lets you back up the information on your smart device onto your 
computer. If you ever need to perform a hard reset or otherwise erase all your 
information on your smart device, you can synchronize your smart device with 
your computer to restore the information. To make sure you always have an up-
to-date backup of your information, synchronize frequently.

Before you attempt to synchronize, make sure you’ve installed the desktop 
synchronization software from the Getting Started CD.

ActiveSync Does Not Respond to Sync Attempt

As you complete the following steps, synchronize after each step. If the 
synchronization is successful, you do not need to complete the remaining steps. 

1. Verify that the USB sync cable is securely connected at all points (see 
“Connecting Your Treo Device to Your Computer (USB)” on page 33).

2. Look for the ActiveSync icon  at the top of your smart device’s screen and 

the ActiveSync icon  in the taskbar on your computer to make sure the 
ActiveSync software is running on your computer. 

3. Double-click the ActiveSync icon  in your taskbar. (From the File menu, 
select Connection Settings. Make sure the Allow USB connections box is 
checked, and then click Connect.)

4. Perform a soft reset (see “Performing a Soft Reset” on page 320).

5. Restart your computer and make sure ActiveSync is running.
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6. If problems persist and you’re synchronizing through a USB hub, try 
connecting the sync cable to a different USB port or directly to your 
computer’s built-in USB port. 

7. If you’re already synchronizing through a built-in USB port on the front of 
your computer, move the sync cable to a USB port on the back of your 
computer (if your computer has USB ports in both places). 

8. Uninstall the desktop software that came with your smart device, and then 
insert the Getting Started CD that came with your smart device and repeat 
the installation process.

9. Switch to the USB serial synchronization method. Some firewall software 
will not allow the default USB synchronization model (RNDIS) to operate 
properly. If this is the case, then switching to a USB serial synchronization 
method will allow ActiveSync to work properly.

� Press Start  and select Programs.

� Select UsbSwitch .

� Press OK  to dismiss the confirmation message.

10. Verify with your computer hardware vendor that your operating system 
supports your internal USB controller.

Did You 
Know?

A common cause of sync problems is the presence of protective software, 
such as VPNs or firewalls, on your computer or network. See “ActiveSync 
Does Not Respond to Sync Attempt” on page 334.
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Synchronization Finishes But Information Doesn’t Appear Where It Should
� With the included software, your smart device can synchronize with the root 

folders of Contacts, Calendar, Tasks, and Notes. If you want to synchronize 
with a global Exchange Address Book, you must copy the addresses to your 
local Contacts list in Microsoft Office Outlook. Right-click the addresses and 
select Add to Personal Address Book. 

� Microsoft Office Outlook subfolders and public folders are not accessible with 
the included software. You may want to use a third-party solution instead.

� If you’re trying to sync offline, be sure to set your Microsoft Office Outlook 
Calendar, Contacts, Notes, and Tasks to be available offline.

� If you’re still having problems, try the following:

1. Make sure you’re synchronizing with the intended desktop personal 
information manager (PIM). The Getting Started CD lets you synchronize 
with Microsoft Office Outlook for Windows. If you use a different PIM, you 
need to install third-party software to synchronize. Consult the company 
that makes the PIM for more information.

2. Open ActiveSync on your computer, and make sure the necessary 
synchronization settings are set to synchronize the files.

3. Uninstall the ActiveSync software, reboot your computer, and then insert 
the Getting Started CD that came with your smart device and repeat the 
installation process.

Tip If you are synchronizing to an Exchange Server and you’re unable to 
change your lock settings, check with your system administrator to find 
out if a systemwide locking policy is in place.
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Synchronization Starts But Doesn’t Finish
1. Make sure that you installed the desktop software that came with 

your smart device. If you’re not sure whether this software is installed, 
reinstall it. 

2. If you’re trying to sync offline, be sure to set your Microsoft Office Outlook 
Calendar, Contacts, Notes, and Tasks to be available offline.

My Media Files Won’t Sync
1. Make sure you have Windows Media Player 10 installed on your computer.

2. Reinstall your synchronization software from the Getting Started CD that 
came with your smart device. Media file synchronization fails if you 
installed the synchronization software before you installed Windows Media 
Player 10.

My Appointments Show Up in the Wrong Time Slot After I Sync
1. Make sure that you installed the desktop software that came with 

your smart device. If you're not sure whether this software is installed, 
reinstall it. 

2. Open Microsoft Office Outlook and correct the wrong entries.

3. Manually enter any information you’ve added to your smart device since 
the last time you synchronized.

4. Synchronize your phone and your computer.
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5. Disable local network time. By default your smart device synchronizes the 
date, time, and time zone with Sprint network whenever your phone is on 
and you are inside a coverage area. You can disable this option in Clock & 
Alarms Settings by selecting More, and then unchecking the Enable local 
network time box. See “Setting the Date and Time” on page 295 for more 
information.

You should now be able to assign time zones to your events without 
encountering this problem.

My Scheduled Sync Doesn’t Work

By default, a scheduled sync does not work while you are roaming. This is to 
prevent roaming charges on your account. If roaming charges are not a concern, 
follow these steps to continue your sync schedule while roaming:

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu  (right softkey) and select Schedule.

4. Check the Use above setting when roaming box.

5. Press OK .

An Alert Tells Me That ActiveSync Encountered a Problem on the Server

There is a temporary problem with the server or the server may be temporarily 
overloaded. Try again later, and if the problem persists, contact your system 
administrator.
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An Alert Tells Me That There Is Not Enough Free Memory to Sync My 
Information

ActiveSync ran out of storage space. Try the following:

1. Go to Memory Settings and close all running programs (see “Closing 
Applications” on page 52 for details).

2. If the problem persists, see “Making Room on Your Smart Device” on 
page 352 for suggestions of other ways to free up space on your device.

An Alert Tells Me That the Server Could Not Be Reached

Your device had to wait too long to connect to Exchange Server. The connection 
may have been lost, the server may be temporarily overloaded, or the server may 
have encountered an internal error. Check your Exchange Server name and proxy 
server settings (see “Synchronizing With Exchange Server” on page 262), and try 
again later.

An Alert Tells Me That ActiveSync Encountered a Problem With [Item Type] [Item 
Name]

There is an error synchronizing a single item. This error can usually be corrected 
only by removing the item that caused the error. If you sync again to see if the 
error persists, be aware that items causing this type of error are skipped and do 
not show up again. 

An Alert Tells Me That My Account Information Could Not Be Detected

When you set up the Exchange Server sync options, the credentials page was left 
blank. Correct the credentials (see “Synchronizing With Exchange Server” on 
page 262), or set up your device to sync only with a computer, and try to sync 
again. 
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An Alert Tells Me the Device Timed Out While Waiting for Credentials

The Exchange Server credentials screen was left open too long. Re-enter the 
Exchange Server credentials, and try to sync again.

My Today Screen Settings Are Not Restored After a Hard Reset

Settings such as the background image and plug-in choices are not backed up 
during synchronization, so they can’t be restored after a hard reset. If you use a 
backup utility, you may be able to restore a backup to recover your Today screen 
settings and other additional information.

I Can’t Synchronize Using a Bluetooth Connection

Before you begin, make sure your computer is equipped with Bluetooth® wireless 
technology, either built-in or through a Bluetooth card. Make sure that the PC’s 
Bluetooth setting is discoverable.

1. On your PC, right-click on the gray ActiveSync icon in the Windows system 
tray, and select Connection Settings. 

2. Check Allow connections to one of the following, and then select Bluetooth. 

3. On your smart device, go to your Today screen, and then tap Bluetooth .

4. Check the Turn on Bluetooth box to turn on your smart device’s Bluetooth 
feature.

5. Press OK .

6. Press Start  and select Programs.

7. Select ActiveSync .

8. Press Menu  (right softkey) and select Connect via Bluetooth.
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9. If this is the first time you’re making a Bluetooth connection to this 
computer, follow the onscreen prompts to set up a Bluetooth partnership 
with this computer. 

10. Select Sync.

11. When synchronization has finished, press Menu  (right softkey) and 
select Disconnect Bluetooth. 
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Email

I Have Problems Using My Account

Occasionally you may experience problems using an email account after you set 
it up. If you followed the account setup procedure and are experiencing problems 
using the account, verify that the account complies with your email provider’s 
requirements by following these steps:

� Verify both your password and your username for your email account.

� Some wireless service providers require you to be on their network to use 
your email account. If this is the case, be sure to use your provider's network 
as the connection type for the account.

� Some wireless service providers have other requirements specific to their 
service. For example, Yahoo! requires you to set up POP mail forwarding for 
your Yahoo! account to download email messages to your smart device. 
Check with your service provider to see if any provider-specific requirements 
exist.

� Service provider settings frequently change. If your email account was 
working but you are currently experiencing problems, check with your service 
provider to see if any of the account settings have changed.

Note: The following troubleshooting tips apply to the Outlook application 
only. If you are using GoodLink™ as your email application, refer to the 
documentation included with that application for troubleshooting tips.
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I Have Problems Sending and Receiving Email

Short periods of time when email is unavailable are common due to server 
problems or poor wireless coverage. If you have problems sending or receiving 
mail for an extended period of time, check with your ISP or email service provider 
to verify that the service is working properly, and check with Sprint Customer 
Service for outage information in your area.

Auto Sync Is Not Working

If Auto Sync is occurring and you turn your device off or the connection to your 
email service provider is disconnected, the Auto Sync fails. 

� Check the synchronization schedule to make sure that Auto Sync is set to 
occur at the expected day and time (see “Setting the Synchronization 
Schedule” on page 265 for details).

� Press Start , select Programs, and then select ActiveSync . 

� Press Menu  (right softkey) and select Configure Server. (Make sure the 
verify password setting is on. This is required for over-the-air 
synchronization.)

I Have Problems Sending Email

If you are able to receive email messages but cannot send them, try these steps, 
in turn:

� Make sure your ISP or email provider allows you to access email on a smart 
device. Some providers do not offer this option at all; other providers require 
an upgrade to access email on a smart device.

� Turn on ESMTP. Many services require authenticated access, or ESMTP, to use 
their SMTP servers. 
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� Press Start , select Programs, and then select ActiveSync . 

� Press Menu  (right softkey) and select Configure Server. (Make sure the 
SSL box is checked.)

� Enter the name of a different outgoing mail server for sending mail. Many 
ISPs, such as cable companies, require that you have an Internet connection to 
their network to send email through their servers. In this case, you can almost 
always receive email from these accounts, but if you want to send email, you 
must send it through another server.

I Have Problems Synchronizing Messages on My Smart Device With Messages 
on My Computer

Make sure you have chosen the same settings for the account on both your smart 
device and your computer. For example, if the account is set up on your smart 
device to use the POP protocol, check the ActiveSync settings on your computer to 
make sure that POP is selected as the protocol for that account.

My vCard or vCal Email Attachment Isn’t Forwarding Correctly

Microsoft Office Outlook provides several features that work with email client 
software on a Windows computer. For these features to work correctly, the email 
client software must be properly set up. Follow these steps to check the settings:

1. Click Start on your computer, and then select Settings.

2. Select Control Panel.

3. Select Internet Options, and then click the Programs tab.

4. Make sure that the email field is set to the correct email client software. 

5. Click OK.
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6. Start the email client software and make sure it is configured as the default 
MAPI client. (Consult the documentation for your desktop email application 
for more information.)

When I Sync With My Exchange Server My Information Is Not Downloading to 
My Smart Device

Check with your system administrator to obtain the name of the mail server that 
offers you wireless access to the corporate mail system. If you cannot obtain the 
name of this server (some companies do not give it out, because they do not want 
wireless access to their servers), you cannot use ActiveSync to synchronize with 
the Exchange Server. You can also check the following setting:

1. Press Start  and select Programs. 

2. Select ActiveSync . 

3. Press Menu  (right softkey) and select Configure Server. 

4. Make sure the SSL box is checked.
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Web

I Can’t Access a Page

First, make sure you have Internet access: Open Internet Explorer Mobile and try 
to view a Web page you’ve loaded before. To ensure that you’re viewing the page 
directly from the Internet, press Menu  (right softkey) and select Refresh. 
After confirming your Internet connection, try to view the page in question again. 
If it comes up blank, press Menu  (right softkey) and select Refresh.

If you’re still having trouble, the page may contain elements that are 
not supported by Internet Explorer Mobile, such as Flash, Shockwave, VBScript, 
WML script, and other plug-ins.

Some Web sites use a redirector to their true home page (for example, if you 
enter the address http://www.palm.com/support it may resolve to http://
www.palm.com/us/support). If Internet Explorer Mobile can’t follow the redirect, 
try using a desktop browser to see the landing page of the redirector, and enter 
that address in Internet Explorer Mobile.

An Image or Map Is Too Small on My Smart Device Screen

Internet Explorer Mobile has several viewing modes: One Column, Default, 
Desktop, and Full Screen. Switch to Desktop to see the full-size image (see 
“Viewing a Web Page” on page 150).
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A Secure Site Refuses to Permit a Transaction

Some Web sites don’t support certain browsers for transactions. Please contact 
the site’s Webmaster to make sure the site allows transactions using Internet 
Explorer Mobile.

Tip: Your smart device can open your email application when you select an 
email address on a Web page. If nothing happens when you select the 
link, try setting up your email application first.
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Camera

If your smart device does not have a built-in camera, the information in this 
section about taking pictures does not apply to you. 

Here are some tips for taking good pictures with the built-in camera:

� Clean the camera’s lens with a soft, lint-free cloth.

� Take pictures in bright lighting conditions. Low-light images may be grainy, 
due to the sensitivity of the camera.

� Hold the camera as still as possible. Try supporting your picture-taking arm 
against your body or a stationary object, such as a wall.

� Keep the subject of the pictures still. Exposure time is longer with lower light 
levels, so you may see a blur.

� For best results, verify that you have the brightest light source coming from 
behind you, lighting the subject’s face. Avoid taking indoor pictures with the 
subject in front of a window or light.

� Make sure the subject is at least 18 inches away from the camera to ensure 
good focus.

Remember that when you synchronize, your Camera images are stored in the 
C:\Documents and Settings\<Username>\My Documents\Treo My Documents folder 
on your hard drive (see “Viewing Pictures and Videos on Your Computer” on 
page 187).
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The Camera Preview Image Looks Strange

Some third-party applications overwrite your smart device’s color settings with 
their own 8-bit color settings. This can affect the Camera Preview Mode. Delete 
third-party applications one by one until the preview image improves.

Did You 
Know?

Pictures are 16-bit color. Resolution settings range from 1280 x 1024 to 
160 x 120 pixels (1.3 megapixels to VGA). Video resolution settings range 
from 352 x 288 to 176 x 144 pixels. You can change the resolution setting 
by pressing Menu (right softkey) and selecting Resolution (still images) or 
Quality (video).
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Third-Party Applications

Sometimes, third-party applications can cause conflicts on your smart device. 
Third-party applications that modify wireless features may affect your device’s 
performance and may require extra troubleshooting. Use caution when installing 
the following types of applications:

� Ringtone managers.

� Caller ID applications.

� Instant messaging.

� Applications that modify when your phone or data connections turn on or off 
and how your phone behaves.

If you recently installed an application and your smart device seems to be stuck, 
try the following: 

1. Perform a soft reset (see “Performing a Soft Reset” on page 320).

2. Make sure the third-party application is compatible with the Windows 
Mobile version 5.2 operating system on your device.

3. Delete the most recently installed application from your smart device (see 
“Removing Applications” on page 261).

4. If the problem persists, perform another soft reset.

Tip: Remember that not all third-party applications were written with the 
Treo device keyboard and 5-way navigator in mind. You may encounter 
strange behavior or errors in these applications if you use the keyboard 
and 5-way navigator.
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5. If possible, synchronize or use a backup utility to back up your most recent 
information.

6. Perform a hard reset (see “Performing a Hard Reset” on page 321).

7. Synchronize or restore your backup to restore the information in your built-
in applications.

8. If the problem is resolved, begin reinstalling your third-party applications 
one at a time.

9. If the problem recurs, delete the last application you installed and report 
the problem to its developer.

Getting More Help

Contact the author or vendor of any third-party software if you require further 
assistance. Sprint does not provide technical support for applications that are not 
built into your Treo700wx smart device.
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Making Room on Your Smart Device

If you store a large number of records, or install many third-party applications, 
the internal memory on your smart device may fill up. Here are some common 
ways to clear space on your smart device:

� Camera: Large images take up a lot of memory. Move images to an expansion 
card or delete images from your smart device (see “Viewing Pictures and 
Videos on Your Computer” on page 187).

� Messaging: Email attachments can consume excessive memory. Move 
attachments to an expansion card, or delete large files from your smart 
device (see “Managing Your Messages” on page 131). You may also want to 
empty the deleted items folder.

� Internet: If you save links to pages you’ve visited in Internet Explorer Mobile, 
you may want to clear all recent pages (see “Customizing Your Internet 
Explorer Mobile Settings” on page 157).

� Third-party applications: You can delete infrequently used applications or 
move them to an expansion card (see “Copying or Moving Applications and 
Files Between Your Smart Device and an Expansion Card” on page 272). 

Also, remember that your smart device includes an expansion card slot, and that 
you can store applications and information on expansion cards. However, you 
still need free memory on the smart device itself to run applications from an 
expansion card.
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Voice Quality

Is the Other Person Hearing an Echo?
� Try decreasing the volume on your smart device to avoid coupling 

or feedback on the other person’s end. This applies to both the speakerphone 
and to the handset earpiece.

� Position the smart device closer to your ear to prevent sound leaking back to 
the microphone. Keep your hand away from the microphone hole, which is on 
the lower-right side of your smart device.

� If you’re using Speakerphone mode with your smart device lying on a flat 
surface, try turning the smart device face-down (screen facing the surface). 

Are You Hearing Your Own Voice Echo?

Ask the other person to turn down their volume or to hold the device closer to 
their ear.

Is Your Voice Too Quiet on the Other End?

Be sure to hold the bottom of the smart device, or the hands-free microphone, 
close to your mouth. 

Check the signal strength indicator. If the signal is weak, try to find an area with 
better coverage.
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Glossary

1xEV-DO (Evolution Data Optimized): A wireless broadband technology (also 
known as EVDO) that is designed for very high-speed data transfer with average 
download speeds of 400 to 700Kbps and that is capable of reaching speeds up to 
a theoretical maximum of 2.4Mb/s, and upload speeds up to 156Kb/s. The Sprint 
Mobile Broadband Network uses 1xEV-DO technology.

1xRTT: A standard of wireless Internet connectivity that allows for persistent data 
connections as long as you are actively using your data connection. The average 
data transmission rate is about 70Kb/s, although theoretical limits are 
153.6Kb/s. With Sprint PCS Vision plans, you pay a monthly rate for unlimited 
data transfer and you don’t pay for connection time.

ActiveSync®: The technology that exchanges and updates the information on your 
smart device with the information on your computer.

Alt (alternative) : A keyboard key. Press Alt  and then press a letter on the 
keyboard to access variations such as international characters and symbols.

Auto-off interval: The time of inactivity that passes before the screen on your 
Treo700wx smart device turns off. The wireless features on your smart device are 
unaffected by this setting.
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Beam: The process of sending or receiving an entry or application using the 
infrared port on your Treo700wx smart device. 

Bluetooth® wireless technology: Technology that enables devices such as smart 
devices, wireless phones, and computers to connect wirelessly to each other so 
that they can exchange information over short distances. 

Desktop software: A PIM application for computers, such as Microsoft Outlook, 
that helps you manage your personal information and keep your personal 
information synchronized with your smart device.

Dial-up networking: Wireless technology that enables you to convert your device 
into a wireless modem so that you can access the Internet from your computer.

Direct Push Technology: A two-way wireless delivery method used between 
Microsoft Exchange 2003 with SP2 (Service Pack 2) servers and a smart device 
with Windows Mobile® 5.2 with MSFP (Messaging and Security Feature Pack). 
Direct Push Technology enables features such as Tasks Over The Air (OTA), and
IP-based push updating of Outlook information (Email, Calendar, Contacts, and 
Tasks).

Global Address List (GAL): An online address book for Microsoft Exchange Server 
2003 upgraded to Service Pack 2. The GAL contains names, email addresses, and 
other information, and is created and maintained by your Exchange Server 
administrator. 

GoodLink™ Applications software: An optional secure wireless messaging 
application allowing push synchronization with your Microsoft Outlook server.

Infrared (IR): A way of transmitting information using light waves. The IR port on 
your Treo700wx smart device lets you transfer information between other IR 
devices within a short radius.



Section 7B: Glossary 357

G
lossary

Lithium Ion (Li-Ion): The rechargeable battery technology used in the Treo smart 
devices. 

Mobile Broadband Network: An advanced wireless data network using the fastest 
commercially available wireless network technology (EVDO) to deliver 
broadband-like transfer speeds for your data connections. 

My Mobile Devices: The component on your Windows computer that enables 
you to install applications and other information on your smart device.

Option : The keyboard button that lets you access the alternative feature that 
appears above the letter on each key.

Partnership: Two Bluetooth devices—for example, your device and a hands-free 
device—that can connect because each device finds the same passkey on the 
other device. Once you form a partnership with a device, you don’t need to enter 
a passkey to connect with that device. Partnership is known on some devices as 
paired relationship, pairing, trusted device, or trusted pair.

Phone as Modem: The feature that enables your device (when connected to the 
Sprint PCS Vision network) to be used as a high-speed modem for your computer, 
using a wired (USB sync cable) connection.

Phone Off: When your phone is off, your device is not connected to any wireless 
network. You can still use the organizer and other features.

Phone/Talk : The button on your smart device that provides quick access to 
your Today screen. 

PIM (personal information manager): A genre of software that includes applications 
such as Microsoft Outlook, Palm® Desktop software, Lotus Notes, and ACT! PIMs 
generally store contacts, schedules, tasks, and memos. 
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SMS (Short Messaging Service): The service that exchanges short text messages 
almost instantly between wireless devices. These messages can usually include 
up to 160 characters. Treo smart devices can send and receive text messages 
while you are on a voice call.

Sprint PCS Vision: The next generation of Mobile Internet access that enables 
you to check your email and browse the Web.

SSID: The name that identifies a Wi-Fi network. If a network does not broadcast 
its SSID, you must get the SSID from the system administrator in order to connect 
to the network.

Start : The menu on your smart device from which you can open all 
applications.

Username: The name associated with your smart device that distinguishes it from 
other Windows Mobile devices. When you first synchronize your smart device, 
you are asked to give it a username. 

Wi-Fi access point: A network device with an antenna that provides wireless 
connections to a larger network. Also called a hotspot.

Windows Mobile: The operating system of your Treo700wx smart device. 
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Sec tion 8A

Important Safety Information

In This Section

� General Precautions

� Maintaining Safe Use of and Access to Your Device

� Using Your Phone With a Hearing Aid Device

� Caring for the Battery

� Radiofrequency (RF) Energy

� Static Electricity, ESD, and Your Device

� Owner’s Record

� User’s Guide Proprietary Notice

This guide contains important operational and safety information that will help you 
safely use your Treo™ 700wx smart device. Failure to read and follow the 
information provided in this guide may result in serious bodily injury, death, or 
property damage.
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General Precautions

There are several simple guidelines for operating your device properly and 
maintaining safe, satisfactory service. 

� Hold the device with the antenna over your shoulder.

� Try not to hold, bend, or twist the device’s antenna.

� Don’t use the device if the antenna is damaged.

� Speak directly into the microphone. 

� Avoid exposing your device and accessories to rain or liquid spills. If your 
device does get wet, immediately turn the power off and remove the battery. 

� Although your device is quite sturdy, it is a complex piece of equipment and 
can be broken. Avoid dropping, hitting, bending, or sitting on it. 

� Any changes or modifications to your device not expressly approved in this 
document could void your warranty for this equipment and void your 
authority to operate this equipment. 

Note: For the best care of your device, only Sprint authorized personnel should service 
your device and accessories. Failure to do so may be dangerous and may void 
your warranty.
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Maintaining Safe Use of and Access to Your Device

Do Not Rely on Your Device’s Phone for Emergency Calls 

Wireless phones such as the one on your Treo device operate using radio signals, 
which cannot guarantee connection in all conditions. Therefore you should never 
rely solely upon any wireless phone for essential communication (for example, 
medical emergencies). Emergency calls may not be possible on all cellular 
networks or when certain network services and/or phone features are in use. 
Check with your local service provider for details.

Using Your Phone While Driving 

Talking on your phone while driving (or operating the phone without a hands-
free device) is prohibited in some jurisdictions. Laws vary as to specific 
restrictions. Remember that safety always comes first.

Following Safety Guidelines

To operate your device safely and efficiently, always follow any special 
regulations in a given area. Turn your device’s phone off in areas where use is 
forbidden or when it may cause interference or danger.

Tip: Purchase an optional hands-free accessory at your local Sprint Store, or call the  
Sprint PCS Accessory Hotline at 1-800-974-2221 or by entering #222 on your 
Treo700wx smart device.
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Using Your Device’s Phone Near Other Electronic Devices

Most modern electronic equipment is shielded from radiofrequency (RF) signals. 
However, RF signals from wireless phones may affect inadequately shielded 
electronic equipment.

RF signals may affect improperly installed or inadequately shielded electronic 
operating systems and/or entertainment systems in motor vehicles. Check with 
the manufacturer or their representative to determine if these systems are 
adequately shielded from external RF signals. Also check with the manufacturer 
regarding any equipment that has been added to your vehicle.

Consult the manufacturer of any personal medical devices, such as pacemakers 
and hearing aids, to determine if they are adequately shielded from external RF 
signals.

Turning Off Your Phone Before Flying

Turn off your phone before boarding any aircraft. To prevent possible interference 
with aircraft systems, the U.S. Federal Aviation Administration (FAA) regulations 
require you to have permission from a crew member to use your phone while the 
plane is on the ground. To prevent any risk of interference, FCC regulations 
prohibit using your phone while the plane is in the air.

Note: Always turn off the phone in health care facilities and request permission 
before using the phone near medical equipment.
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Turning Off Your Phone in Dangerous Areas

To avoid interfering with blasting operations, turn your phone off when in a 
blasting area or in other areas with signs indicating that two-way radios should 
be turned off. Construction crews often use remote-control RF devices to set off 
explosives.

Turn your phone off when you’re in any area that has a potentially explosive 
atmosphere. Although it’s rare, your phone and accessories could generate 
sparks. Sparks can cause an explosion or fire, resulting in bodily injury or even 
death. These areas are often, but not always, clearly marked. They include:

� Fueling areas such as gas stations.

� Below deck on boats.

� Fuel or chemical transfer or storage facilities.

� Areas where the air contains chemicals or particles such as grain, dust, or 
metal powders.

� Any other area where you would normally be advised to turn off your vehicle’s 
engine.

Restricting Children’s Access to Your Device

Your Treo device is not a toy. Do not allow children to play with it; they could hurt 
themselves and others, damage the device and/or its phone, or make calls that 
increase your Sprint PCS invoice.

Note: Never transport or store flammable gas, flammable liquid, or explosives in the 
compartment of your vehicle that contains your phone or accessories.
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Using Your Phone With a Hearing Aid Device

Your Treo™ 700wx smart device is compliant with the FCC Hearing Aid 
Compatibility (HAC) requirements. For additional HAC information, including the 
HAC rating of this product, please go to www.palm.com/treoHAC.

Your device has been tested for hearing aid device compatibility. When some 
wireless phones are used near some hearing devices (hearing aids and cochlear 
implants), users may detect a buzzing, humming, or whining noise. Some hearing 
devices are more immune than others to this interference noise, and phones also 
vary in the amount of interference they generate.

The wireless telephone industry has developed ratings for some of their wireless 
phones, to assist hearing device users in finding phones that may be compatible 
with their hearing devices. Not all phones have been rated. Phones that have 
been rated will have an “M3” or “M4” rating on the box. Your Treo700wx smart 
device phone has an M3 rating.

The M3/M4 ratings do not guarantee successful interoperation between your 
phone and a hearing aid device. Results will vary depending on the level of 
immunity of your hearing device and degree of your hearing loss.

The more immune your hearing aid device is, the less likely you are to experience 
interference noise from your wireless phone. Hearing aid devices should have 
ratings similar to those of phones. Ask your hearing healthcare professional for 
the rating of your aids. Most new hearing aids have at least an M2 immunity 

Note: Phones rated M3 or M4 meet FCC requirements and may generate less 
interference to hearing devices than phones that are not labeled. M4 is the 
better/higher of the two ratings. 

http://www.palm.com/treoHAC
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level. Add the “M” ratings of your hearing aid and your phone to determine 
probable usability:

� Any combined rating equal to or greater than six offers best use.

� Any combined rating equal to five is considered normal use.

� Any combined rating equal to four is considered usable.

Thus, if you pair an M3 hearing aid with an M3 phone, you will have a combined 
rating of six for “best use.”

Sprint further suggests you experiment with multiple phones (even those not 
labeled M3 or M4) while in the store to find the one that works best with your 
hearing aid device. Should you experience interference after purchasing your 
phone, promptly return it to the store. With the Sprint 14 Day Risk Free 
Guarantee you may return the phone within 14 days of purchase for a full refund.

Getting the Best Hearing Device Experience With Your Treo 700wx Smart Device
To further minimize interference: 

� There is usually less interference on the microphone setting than on the 
telecoil setting.

� Set the phone’s screen and keyboard backlight settings to ensure the 
minimum time interval. See “Viewing and Optimizing Power Settings” on 
page 300 for instructions.

� Position the phone so that the antenna is farthest from your hearing aid.

� Move the phone around to find the point with the least interference.
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Protecting Your Battery

The guidelines listed below help you get the most out of your battery’s 
performance.

� Recently there have been some public reports of wireless phone batteries 
overheating, catching fire, or exploding. It appears that many, if not all, of 
these reports involve counterfeit or inexpensive, aftermarket-brand batteries 
with unknown or questionable manufacturing standards. Sprint is not aware 
of similar problems with Sprint PCS Treo devices resulting from the proper 
use of batteries and accessories approved by Sprint or the manufacturer of 
your phone. Use only Sprint- or manufacturer-approved batteries and 
accessories found at Sprint Stores or through your device’s manufacturer, or 
call 1-866-343-1114 to order. They’re also available at www.sprint.com — 
click the Wireless link under Personal, and then click Accessories under Shop the 
PCS Store Online. Buying the right batteries and accessories is the best way to 
ensure they’re genuine and safe.

� In order to avoid damage, charge the battery only in temperatures that range 
from 32° F to 113° F (0° C to 45° C).

� Don’t use the battery charger in direct sunlight or in high humidity areas such 
as the bathroom.

� Never dispose of the battery by incineration.

� Keep the metal contacts on top of the battery clean.

� Don’t attempt to disassemble or short-circuit the battery.

� The battery may need recharging if it has not been used for a long period of 
time.

http://www.sprint.com
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� It’s best to replace the battery when it no longer provides acceptable 
performance. It can be recharged hundreds of times before it needs replacing.

� Don’t store the battery in high temperature areas for long periods of time. It’s 
best to follow these storage rules:

� Less than one month:
-4° F to 140° F (-20° C to 60° C)

� More than one month:
-4° F to 113° F (-20° C to 45° C)

Disposal of Lithium Ion (Li-Ion) Batteries

To avoid being burned, do not handle a damaged or leaking Li-Ion battery. 

For safe disposal options of your Li-Ion batteries, contact your nearest Sprint 
authorized service center.

Special Note: Be sure to dispose of your battery properly. In some areas, the 
disposal of batteries in household or business trash may be prohibited.
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Understanding How Your Phone Operates

Your phone is basically a radio transmitter and receiver. When it’s turned on, it 
receives and transmits radiofrequency (RF) signals. When you use your phone, the 
system handling your call controls the power level. This power can range from 
0.006 watts to 0.2 watts in digital mode.

Knowing Radiofrequency Safety

The design of your Sprint PCS Treo device complies with updated NCRP standards 
described below.

In 1991–92, the Institute of Electrical and Electronics Engineers (IEEE) and the 
American National Standards Institute (ANSI) joined in updating ANSI’s 1982 
standard for safety levels with respect to human exposure to RF signals. More 
than 120 scientists, engineers and physicians from universities, government 
health agencies and industries developed this updated standard after reviewing 
the available body of research. In 1993, the Federal Communications Commission 
(FCC) adopted this updated standard in a regulation. In August 1996, the FCC 
adopted a hybrid standard consisting of the existing ANSI/IEEE standard and the 
guidelines published by the National Council of Radiation Protection and 
Measurements (NCRP).
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Body-Worn Operation

To maintain compliance with FCC RF exposure guidelines, if you wear a handset 
on your body, use the Sprint-supplied or -approved carrying case, holster, or other 
body-worn accessory. If you do not use a body-worn accessory, ensure the 
antenna is at least 7/16 inch (1.5 centimeters) from your body when 
transmitting. Use of non-Sprint-approved accessories may violate FCC RF 
exposure guidelines. 

For more information about RF exposure, visit the FCC Web site at www.fcc.gov. 

Specific Absorption Rate (SAR) for Wireless Phones

The SAR is a value that corresponds to the relative amount of RF energy absorbed 
in the head of a user of a wireless handset.

The SAR value of a phone is the result of an extensive testing, measuring, and 
calculation process. It does not represent how much RF the phone emits. All 
phone models are tested at their highest value in strict laboratory settings. But 
when in operation, the SAR of a phone can be substantially less than the level 
reported to the FCC. This is because of a variety of factors including its proximity 
to a base station antenna, phone design, and other factors. What is important to 
remember is that each phone meets strict federal guidelines. Variations in SARs 
do not represent a variation in safety. 

All phones must meet the federal standard, which incorporates a substantial 
margin of safety. As stated above, variations in SAR values between different 
model phones do not mean variations in safety. SAR values at or below the 
federal standard of 1.6 W/kg are considered safe for use by the public. 

http://www.fcc.gov
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The highest reported (FCC) SAR values of the Treo™ 700wx smart device by Palm 
are:

FCC Radiofrequency Emission

This phone meets the FCC Radiofrequency Emission Guidelines and is certified 
with the FCC as:

FCC ID number: O8FJIMI. 

More information on the phone’s SAR can be found from the following 
FCC Web site: 
https://gullfoss2.fcc.gov/prod/oet/cf/eas/reports/GenericSearch.cfm.

Maximum SAR Values CDMA Cellular CDMA PCS

Held to Ear 1.26 (W/Kg) 1.26 (W/Kg)

Body-Worn 1.01 (W/Kg) .55 (W/Kg)

https://gullfoss2.fcc.gov/prod/oet/cf/eas/reports/GenericSearch.cfm
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Static Electricity, ESD, and Your Device

Electrostatic discharge (ESD) can cause damage to electronic devices if discharged 
into the device, so you should take steps to avoid such an occurrence.

Description of ESD

Static electricity is an electrical charge caused by the buildup of excess electrons 
on the surface of a material. To most people, static electricity and ESD are nothing 
more than annoyances. For example, after walking over a carpet while scuffing 
your feet, building up electrons on your body, you may get a shock—the 
discharge event—when you touch a metal doorknob. This little shock discharges 
the built-up static electricity.

ESD-Susceptible Equipment

Even a small amount of ESD can harm circuitry, so when working with electronic 
devices, take measures to help protect your electronic devices, including your 
Palm® device, from ESD harm. While Palm has built protections against ESD into 
its products, ESD unfortunately exists and, unless neutralized, could build up 
to levels that could harm your equipment. Any electronic device that contains an 
external entry point for plugging in anything from cables to docking stations is 
susceptible to entry of ESD. Devices that you carry with you, such as your device, 
build up ESD in a unique way because the static electricity that may have built up 
on your body is automatically passed to the device. Then, when the device is 
connected to another device such as a docking station, a discharge event can 
occur. 
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Precautions Against ESD

Make sure to discharge any built-up static electricity from yourself and your 
electronic devices before touching an electronic device or connecting one device 
to another. The recommendation from Palm is that you take this precaution 
before connecting your device to your computer, placing the device in a cradle, or 
connecting it to any other device. You can do this in many ways, including the 
following: 

� Ground yourself when you’re holding your wireless device by simultaneously 
touching a metal surface that is at earth ground. For example, if your 
computer has a metal case and is plugged into a standard three-prong 
grounded outlet, touching the case should discharge the ESD on your body.

� Increase the relative humidity of your environment.

� Install ESD-specific prevention items, such as grounding mats.

Conditions That Enhance ESD Occurrences

Conditions that can contribute to the buildup of static electricity in the 
environment include the following:

� Low relative humidity.

� Material type (The type of material gathering the charge. For example, 
synthetics are more prone to static buildup than natural fibers like cotton.)

� The rapidity with which you touch, connect, or disconnect electronic devices.

While you should always take appropriate precautions to discharge static 
electricity, if you are in an environment where you notice ESD events, you may 
want to take extra precautions to protect your electronic equipment against ESD.
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Owner’s Record

The model number, regulatory number, and serial number are located on a 
nameplate inside the battery compartment. Record the serial number in the 
space provided below. This will be helpful if you need to contact us about your 
phone in the future.

Model: Sprint Mobile Broadband Smart Device Treo™ 700wx by Palm 

Serial No.: 

User’s Guide Proprietary Notice

CDMA Technology is licensed by QUALCOMM Incorporated under one or more of 
the following patents:

4,901,307   5,109,390   5,267,262   5,416,797   

5,506,865   5,544,196   5,657,420   5,101,501   

5,267,261   5,414,796   5,504,773   5,535,239   

5,600,754   5,778,338   5,228,054   5,337,338   

5,710,784   5,056,109   5,568,483   5,659,569   

5,490,165   5,511,073 

User’s Guide template version 5B (October 2005)
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Sec t ion 8B

Specifications

Radio CDMA 800 (Digital Cellular), 1900 (PCS), and 1400(GPS)

EVDO and 1XRTT

Phone features Personal speakerphone

Hands-free headset jack 
(2.5 mm, 3-barrel connector)

Microphone mute option

TTY compatible 

3-way calling

Processor technology Intel XScale™ processor, 312MHz

Expansion SD/MultiMediaCard/SDIO card slot

Battery Rechargeable Lithium Ion

Removable for replacement

3.5 hours full charge time

Operating system Windows Mobile® 5.2.2 Pocket PC Phone Edition

Camera 
(not included on all 
smart devices)

Still image capture resolution: 1280 x 1024, 1.3 megapixel

Automatic light balance

Size 5.08 in x 2.28 in x 0.89 in (129mm x 58mm x 22.5mm) with antenna

Weight 6.4 ounces (180 grams)

Connectivity Infrared (1.2 compliant)

Bluetooth® wireless technology (1.2 compliant)
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Display Touch-sensitive LCD screen (includes stylus)

65,536 colors (16-bit color)

User-adjustable brightness

Keyboard Built-in QWERTY keyboard plus 5-way navigator

Backlight for low lighting conditions

Included software Today/Phone 
(includes Speed Dial and Dial Pad)

Messaging (text and email)

Internet Explorer Mobile (Web 
browser)

Camera

Pictures & Videos

Windows Media Player Mobile

File Explorer

Contacts

Calendar

Tasks

Notes

Calculator

ActiveSync

Direct Push Technology

Excel Mobile

Word Mobile

PowerPoint Mobile

Pocket MSN

Solitaire

Bubble Breaker

Voice Command

Quick Tour

Search

Terminal Services

Picsel PDF Viewer 

Cubis (available on Getting 
Started CD)

Sprite Backup (available on 
Getting Started CD)

System 
requirements

Windows 2000 or XP with USB port. Later versions may also be 
supported

Some wireless features require Microsoft 2003 Exchange Server with 
Service Pack 2
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Operating and 
storage temperature 
range

32°F to 104°F (0°C to 40°C)

5% to 90% RH
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Index
Numerics
1xEV-DO (EVDO) technology 355
1xRTT data networks 330
1xRTT network icons 329
1XRTT protocol 355
3G2 files 187, 190
5-way navigator 6, 7, 40, 43, 350
802.1x page (Network 

Authentication) 307
911 calls 95, 289
911 phone calls 94

A
About screen 107
AC charger 9, 12, 13, 313
accented characters 49
Access page 299
accessing

alternate characters 48
applications 51, 284
calculator 221
corporate email accounts 310, 345
Dial Pad 65
email 135
field lists 46
File Explorer 112, 255, 258, 273
information 53, 297
instant messages 136

menu items 44, 45
On Demand information 109
on-device help 55
Outlook folders 336
personal accounts 25, 56
personal information 25
Phone Settings screen 22
Quick Tour 55
secure Websites 297, 347
shortcut menus 45, 308, 332, 333
speed dial buttons 63
spreadsheet templates 239
Sprint PCS Vision services 107
Sprint Web site 56
Tasks entry bar 216
the Internet 309, 330
Today screen 60, 357
voicemail 24, 70
voicemail messages 24
Web pages 149, 153, 346

accessories 268, 313, 327
account passwords 25
accounts 24, 25

accessing corporate 310, 345
getting help with 55
preventing unauthorized use of 291, 

297
See also Sprint PCS Vision accounts
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setting up email 121–122
synchronizing 124
troubleshooting 342

Accounts page 127
activating items on screen 7, 43
activating Treo smart device 5, 20
active calls

See also phone calls
adding a second 74
adjusting volume for 89
ending 21, 72, 74
managing 71, 74

ActiveSync icons 35, 101
ActiveSync software 28, 29, 35, 140, 263, 

334, 345
options 262

ActiveSync technology 355
adapters 313
Add Contact prompt 72
Add Server Source command 141
Add Server Source prompt 263
Add to Favorites command 153
adding

a second call 74
accessories 268, 313
applications to Start menu 284
appointments 207, 208
attachments to email 124, 255
bulleted or numbered lists 230
caller ID pictures 202

connections 309, 311
contacts 72, 202
document templates 227, 232
email messages 123
expansion cards 268
favorites links 153
files to playlists 195
folders 231
notes 202, 215, 217
passwords 24, 25
signatures 132
speed dial buttons 80
spreadsheets 236
tasks 214
untimed events 208

Address Book 78
address book 133, 145
Address page 133, 145
addresses

adding email 123, 145, 203
entering message 128
messaging options for 133
multiple recipients 129
selecting email 43

adjusting screen brightness 281
adjusting volume

device ringer 7
Advanced Encryption Standard 118
Advanced page (Power Settings) 300
advancing slides 234, 235
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AES (Advanced Encryption Standard) 118
After calls from numbers… setting 90
Agenda View (calendar) 206
alarm 10
alarm clock 296
alarm sounds 296
alarms

events and 209
setting system 296
setting vibrating 280
tasks and 215
turning on and off 279

Alarms page 296
albums 179
alert tones. See ringtones
aligning the screen 283
alignment settings

documents 230
spreadsheets 236

Allow cookies setting 158
Allow USB connections check box 334
Alt key 47, 355
alternate characters 49
alternate characters list 49, 50
alternate phone numbers 63
animated images 187
animation 233, 234
anniversaries 208
Answer button 67
answering phone 24

answering service. See voicemail
answering the phone 67, 75
antenna 10
Appearance page 276, 283
applications

See also third-party applications
accessing help for 55
associating with buttons 284
battery life and 15
closing 32, 52, 300
copying 272
customizing 284–288
deleting 261, 352
displaying 300
downloading 258
error reporting for 297
included with smart device 378
installing 257–259, 350
losing information in 321
moving to expansion cards 272
opening 51, 270, 358
phone conversations and running 71, 

72
reinstalling 321
running from expansion cards 270, 

352
storing 352
transferring information from 30
troubleshooting 325
turning sounds on or off for 279
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viewing main menus 44
viewing memory usage for 299

appointments 210
See also events
adding 207
appearing in wrong time slots 337
deleting 212
entering multiple 207
hiding 210
marking as private 210
reminders for 209, 213
scheduling repeating 208
viewing 206

Appointments page 213
Area code setting 204
arrow icons (navigator) 40
Assign a program list 285
assistance 25, 57
attachments

See also email
adding 124, 255
downloading 125
embedded objects in 126
freeing internal memory and 352
opening 125
receiving 125
storing 126, 134
troubleshooting 344

audio 68, 186, 191
See also media files; music

audio accessories 85
authentication 307
Authentication list 306
auto shut off timer 266
Auto Sync, troubleshooting 343
auto-completion options 287
AutoCorrect command 184
Autofill setting 242
AutoFilter command 245
AutoFilter settings (spreadsheets) 237
auto-keyguard feature 289, 290
Auto-Keyguard settings 290
Auto-lock settings 291
automated invoicing information 56
auto-off interval 355

B
back view (device) 8
backgrounds 174, 183, 198, 276
backing up information 321
backlight (keyboard) 47, 301
Backspace key 43, 47
backup utilities 318, 322, 340
backups, restoring 322, 340
basics ii, 20, 27
battery

Bluetooth connections and 163
charging 13–14
conserving power for 301
consumption factors 15
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disposing of 324
inserting 11
maximizing life of 15
replacing 12, 313, 323
specifications for 377
viewing remaining power for 300
viewing status of 13, 14, 101

battery door release 8, 11
battery icon 14
Battery Power page 300
battery status icons 101
battery-charge indicators 13
battery-ready indicator 14
Beam… command 163, 168
beaming 163, 167–169, 255, 356
belt clip 313
billing information 107
birthdays 208
Bluetooth devices

compatibility with 160
connecting to 160–162, 163, 166
discovery setting for 164
phone calls and 86
sending and receiving information 

over 163, 164
synchronizing with 165
troubleshooting 331, 332

Bluetooth feature 160, 161
Bluetooth icon 102, 160
Bluetooth Settings screen 163

Bluetooth status indicator 102
Bluetooth technology 356
BMP files 187
Bold setting 229
border glow highlight 42
borders 236
Brightness command 176
brightness icons (camera) 176, 178
brightness, adjusting 176, 178, 281
broadband connections 113
browsing files and folders 254, 273
built-in applications 55, 261, 378
built-in camera. See camera
built-in camera. See camera
bulleted lists 230
bullets 225
buttons

activating menus and 44
assigning voice commands to 285
associating with applications 284
calculator 222
creating speed dial 80
disabling 289
editing speed dial 82
on 5-way navigator 40
opening applications and 51
reassigning 7, 284–285
selecting or activating 42
turning sounds on or off for 279

Buttons page 198
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Buttons Settings page 284

C
calculations 221, 237, 240
Calculator application 221
calculator buttons 222
Calculator icon 221
calendar

accessing 135
adding meeting requests 210
adding special events 208
displaying 206
removing events 212
setting alarms for 209
setting options for 212
unavailable time slots on 211

Calendar application
adding contacts and 203
customizing 212–213
managing schedules with 207–212
selecting views 206
starting 206
synchronizing with 30
untimed events in 208

calendar views 206
call forwarding 76
Call Log 65
Call Log command 65
call waiting 75, 96
call waiting notification window 75

callback number 129
caller ID applications 350
caller ID blocking 73
caller ID pictures 89, 174, 202
calling cards 57
calling Sprint Customer Service 25, 56
calls. See phone calls
camera

See also pictures
battery life and 15
capturing videos with 177–178
freeing internal memory and 352
location of built-in 8
specifications for 377
taking pictures 174–176
troubleshooting 348–349

Camera icon 175
Camera page 186
Camera Preview Mode 349
camera settings 185–186
Cancel Bluetooth command 86
capitalization 48, 288
Caps Lock 48
capture resolution 377
carrying cases 327
case-sensitive searching 227, 247
cautions iii, 9
cell patterns 236
Center button (navigator) 40
Center/Select button 6, 7
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certificates 152, 297
Certificates page 297
Change passcode button 291
changing

alarm sounds 296
connections 309
contacts 203
date and time settings 295
information 27, 247
lock codes 291
passwords 25
picture or video resolution 176, 178, 

349
speed dial buttons 82
text 227, 239
text size 281

character sets 157
characters

capitalizing 48, 288
entering 48, 287
phone calls and 70, 81
text messages and 128, 129
typing alternate 49

charge indicator light 13
charger cable 13
charger jack 13
chargers (optional) 313
charging

smart device 12
Charging battery icon 14

charging connector 9, 13
charging the battery 13–14
Chart command 246, 247
charts 237, 246, 247
chat rooms 55
check boxes 42
Clear Cookies setting 158
Clear History setting 157
Clear Now Playing command 196
Clear Type setting 281
Clock & Alarms Settings page 295, 296
closed networks 303, 305
closing

applications 32, 52, 300
lists in fields 46
menus 45
screens 42

closing Internet connections 112
collect calls 57
color settings 349
color themes 276, 283
colors 283
command buttons 286
commands 286

See also menus; specific command
company lists 64
company names 64, 203
comparisons 246
completed tasks 214, 215
compressed files 257
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computers
installing from 259
synchronizing with 27, 28, 263
system requirements 31

Conference button 75, 76
conference calls 74, 75
Confidential setting 211
Configure Server command 263
Configure Wireless Network page 305
configuring

data services 330
Exchange Server 263
TTY devices 90
wireless networks 305

configuring Sprint PCS Vision 
services 106

Connect command 311
Connect via Bluetooth command 165, 

340
Connect via IR command 169
connecting

to a headset 162
to Bluetooth devices 160–162, 163, 

166
to data service providers 309
to hands-free car kit 162
to mobile networks 328
to the Internet 309, 330
to VPNs 310–311
to Wi-Fi networks 304, 305, 307

connecting smart device 33
connecting to power sources 14
connection icons 99, 107, 330
Connection Manager 111
connections

accessing Internet and 111, 356
adding 309, 311
changing 309
closing 112
customizing 302–312
ending 312
manually starting 311
PCs and 33, 111
precautions for 374
removing Bluetooth 163
Sprint PCS Vision services 107
synchronizing information and 28
synchronizing over infrared 169
troubleshooting 328–332
TTY devices and 93
unavailable 330

Connections Settings page 309, 311
connectivity 377
conserving battery power 301
consumption (battery) 15
contacts

adding 72, 202
addressing to 123, 128
alternate numbers 65
alternate phone numbers for 63
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assigning ringtones to 81, 89, 181, 202
changing 203
displaying 203
entering multiple 202
linking speed dial buttons to 80
looking up 61
personalizing 89
removing 204
saving information for 72
selecting communication method 

for 62
sending meeting requests to 210
viewing details list for 62

Contacts application
customizing 204
managing contact information 

with 202–204
starting 202
synchronizing with 30

Contacts list 61, 62
context-sensitive menus 45
continuous playback (slides) 235
cookies 158
Copy command 156, 182, 221, 228, 272
copying

applications 272
items in folders 256
numbers 221
phone numbers 65, 66
pictures and videos 182

text 156, 228
copyrighted items 180
corporate mail systems 310, 345
corporate servers 310, 345
coverage area 99, 328
coverage maps 56
CPUs

connecting to 33, 111
creating

appointments 207, 208
bulleted or numbered lists 230
caller ID pictures 202
connections 309, 311
contacts 72, 202
documents 224, 226
email messages 123
favorites links 153
folders 231
notes 217, 218
passwords 24, 25
playlists 195
signatures 132
speed dial buttons 80
spreadsheets 236
tasks 214
templates 227, 232, 239
text messages 128
untimed events 208
video ringtones 181
workbooks 238
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cropping pictures 184
Currency page 282
currency symbols 282
current call. See active calls
Customer Service (Sprint) 25, 56
customer support 55
Customize the playlists… check box 191
customizing

applications 284–288
Calendar 212–213
camera 185–186
connections 302–312
Contacts application 204
dates and time 295
display settings 281–283
Excel Mobile 250
format settings 282
Internet Explorer 157
Media Player Mobile 197
Messaging application 133
Notes application 220
phone 87–95
system settings 295–302
system sounds 278
Tasks application 216
Today screen 276–277
voicemail system 82
Word Mobile 232

Cut command 182, 228
cutting. See deleting

D
daily schedules 206
data 238, 242, 321

See also information
data connection icons 99, 107
Data Encryption settings 306
data formats 282
data service providers 309, 330
data services 96, 329
data settings 94
data transfer 329
date formats 282
Date page 282
dates 242, 282, 295

See also calendar
Day View (calendar) 206
day-planner formats 206
decimal places 282
decimal symbols 282
decompression utility 257
default format settings 282
default lock code 291
default password 25
default template 232
default zoom level 288
defined names (spreadsheets) 243
Delete Appointment command 212
Delete Cells command 249
Delete command 132, 232, 249
Delete Contact command 204
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Delete Files setting 157
Delete Task command 216
Deleted Items folder 132, 134
deleting

applications 261, 352
Bluetooth connections 163
certificates 297
contacts 204
directory services 146
documents 232
events 212
favorites links 154
files 256
items from playlists 195
items in folders 255
messages 131, 132, 133
notes 220
pictures 184
sounds 89
speed dial buttons 83
tasks 216
text 43
workbooks 249
worksheets 250

Desktop Software 5, 28, 29, 32, 111, 140, 
201, 214, 217, 257, 319, 334, 335, 336, 
337

desktop software 356
See also applications

Device Setup Wizard 191

devices
beaming to 167
configuring TTY/TTD 90
electrostatic discharge and 373
identifying 164, 306
physically-impaired disabilities and 93
setting up GPS 298
troubleshooting 331

diagnostic information 297
Dial Pad 65, 66
Dial Pad command 65
dial pad tones 90
Dial Preferences screen 91
dialing 21, 61–66, 74, 81, 91
Dialpad setting 90
dial-up networking 356
digit grouping 282
digital networks 96
Direct Push Technology 356
Directory Assistance 57
directory service 133, 145
Disable touchscreen check box 290
Disconnect Bluetooth command 166, 

341
Disconnect command 312
discoverable setting 164
Dismiss button 69
display

See also screen
customizing 281–283
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scroll settings for 288
specifications for 378

display formats 282
Display message on screen check 

box 280
display. See screen
displaying

alternate characters 49
animated images 187
appointments 206
available applications 51
calendar 206
contacts 62, 203
daily schedules 206
documents 225
events 208, 211
items in folders 231, 248
memory usage 299
menus 44
notifications 280
pictures 179, 187
power settings 300
space on expansion cards 272, 299
spreadsheets 236, 237
status information 7, 99
tasks 216
videos 179, 187
Web pages 150, 156
wireless settings 302

docking cradle 313

document file types 224, 232
documentation ii, 4
documents

See also Word Mobile application
creating 224, 226
deleting 232
displaying 225
finding and replacing operations 

in 227
moving or copying operations in 228
opening 226
organizing 231
saving 226, 228, 232
setting margins for 230
spell-checking 230

documents list 232
down arrow in fields 46
Down button (navigator) 40
downloading

applications 258
attachments 125
email 345
files 155
images 155, 187
ringtones 87
Sprint PCS Connection Manager 111

drafts 124
drawing 217
drivers 319
dummy expansion card 268, 269
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E
EAP type setting 307
earpiece 6, 7
eBooks 15
echoes 353
Edit command 184
Edit Speed Dial command 82, 83
editing. See changing
electrostatic discharge 373–374
email

accessing 135
adding attachments 124, 255
addressing 123, 145, 203
creating messages for 123
dialing from 64
entering contact information 

and 203, 210
getting from corporate servers 310, 

345
messaging options for 133
priority settings for 124
receiving attachments with 125
selecting addresses 43
sending 124
synchronizing 117, 135
troubleshooting 342–345

email accounts
setting up 121–122
setting up multiple accounts 122
synchronizing 124

troubleshooting 342
E-mail application 30
email client software 344
email message icons 131
embedded images 126
emergency calls 95, 289
emergency numbers 291
emergency phone calls 94
Empty battery icon 15
Empty Deleted Items command 132
Enable local network time check box 338
Encoding setting 157
encryption 152, 306
End Conference button 75
End Show command 234
ending active calls 21, 72, 74
ending data connections 312
ending playback 193
endnotes 225
entering

alternate characters 49
data in spreadsheets 238, 242
information 27, 287
lock codes 291
numbers on calculator 221
owner information 294
passwords 121, 292
phone numbers 66

Erase all data? prompt 322
erasing. See deleting
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error messages 279
error reporting 297–298
Error Reporting page 298
errors 297, 329
ESD (electrostatic discharge) 373–374
EVDO icons 329
EVDO networks 330
EVDO technology 355
event icons 213
Event settings 280
events

categorizing 211
creating 208, 209
deleting 212
hiding 210
marking as sensitive 210
reminders for 209, 213

Events check box 279
Excel applications 237
Excel Mobile application

customizing 250
display settings for 239
formatting considerations for 236
overview 236
searching in 247
starting 238

Excel Mobile icon 238
Exchange Address Book 336
Exchange mail servers 117

Exchange Server accounts 29, 31, 117, 
140, 262, 345

exiting applications 52, 300
expanding lists in fields 46
expansion card slot 10, 268, 377
expansion cards

adding applications 259
displaying available space on 272, 299
freeing memory and 352
inserting 269
moving items to 231, 248, 271, 272
opening items on 270
removing 269
renaming 273
saving items on 271
searching on 254, 256
storing attachments on 126, 134
transferring to 191, 194
types supported 268

extensible authentication protocol 307
extensions (phone) 81
external power sources 300
Extra Digits button 70, 81
Extra Digits text box 81

F
factory-installed applications 55, 261, 

378
FAQs 56
Favorites buttons. See Quick Keys
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Favorites command 154
favorites links 153, 154
features 55
fields

accessing lists for 46
scrolling through 41

File Explorer 254, 255, 273
File Explorer icon 112, 255, 258
file lists 256
file names 226, 228, 231
file types 190, 224, 232
files 254, 310, 352

caution for deleting 256
filtering information 204, 245
filtering tasks 216
financial information 110
Find/Replace command 227, 239, 247
finding

information 53, 247, 254
Sprint PCS Vision user names 107
text 227

firewalls 310
first letter capitalization 48, 288
folder names 231
folders

accessing Outlook 336
adding documents to 228
arranging pictures and videos in 182
browsing 254, 273
creating 231

displaying contents 231, 248
moving items to 231, 248
opening items in 255
organizing Web favorites in 153, 154
sorting contents 231, 248, 255

Font color setting 229
Font command 229
Font setting 229
fonts 225, 229, 236
footers 225
footnotes 225
forgetting passwords 292, 293
formatting

charts 247
paragraphs and lists 229
spreadsheet cells 243–244
system information 282
text 229

Formatting toolbar 230
formulas 236, 241, 249
forwarding

email 344
messages 127
phone calls 76

forwarding codes (phone) 77
freeing memory 261, 352
frequently asked questions 56
front view (device) 6
Fully charged battery icon 14
functions (spreadsheets) 236, 241



396 Index

G
GAL (Global Address List) 356
games 15
Get Good icon 135
getting started ii, 20, 27
Getting Started CD 5, 28, 29, 32, 111, 140, 

201, 214, 217, 257, 319, 334, 335, 336, 
337

GIF files 187
Global Address List 146, 356
Global Positioning System (GPS) 298
Glossary 355
Go to Slide command 234
GoodLink application 117, 135, 356
GPS devices 298
GPS Settings page 298

H
Hands Free check box 162
handset speaker 7
hands-free car kit 84, 162
hands-free devices 84, 160

connecting to 9
hanging indents 230
hanging up phone 72, 74
hard resets 292, 321
hardware 4
Hardware buttons box 279
Hardware page 299
headers 225

headset 84–85, 162
headset button 84
headset jack 9
headsets 9
hearing disabilities 90
hearing-impaired services 93
heat sources 16
help 25, 55, 56, 317, 351
Help command 55
Help screen 55
hiding

appointments 210
events 210
speed dial buttons 63
Tasks entry bar 216

Highlight setting 229
highlighting

alternate characters 49
items in lists 46
items on screen 41, 42
menu items 45
multiple items 256
text 43, 229

high-speed connections 113
hints (passwords) 293
History command 156
History list 156, 157
Hold button 71, 74
home locations 295
Home Page setting 157
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Hotmail accounts 136
HotSync cable 313
HotSync cradle 313
hypertext links. See links

I
icons 99

data services 329
email 131
events 213
signal-strength 18, 302
synchronization 35

Ignore with text message command 67
IM messaging 116, 136
image files 187
images 126, 155, 346, 349, 352

See also pictures
IMAP accounts 117, 120, 126
inactivity 290, 300
Inbox 131
Indentation setting 230
indented lists 225
indenting text 230
indicator light 6, 7, 13
information

accessing 25, 53, 297
backing up 321
changing 27, 247
entering 27, 287
filtering 204, 245

losing 321
moving 271, 272
protecting 25, 289, 292
receiving automated invoicing 56
restoring 322
saving 271
searching for 53, 227, 247, 254
sorting 245
storing 268, 352
synchronizing 27, 265, 334
transferring 318, 356
updating 27, 355

infrared port. See IR port
infrared transmissions 28, 169, 356
infrared-enabled devices 10
Input Settings page 287
inserting battery 11
Installation CD 5, 28, 29, 32, 111, 140, 

201, 214, 217, 257, 319, 334, 335, 336, 
337

installation, troubleshooting 322, 350
installing

applications 257–259, 350
Palm desktop software 5
Sprint PCS Connection Manager 111
VPN clients 310
Windows drivers 319

instant messages 116, 136, 350
interference 166
internal memory 261, 352
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international travel adapters 313
Internet 309, 330
Internet Connection Speed setting 198
Internet connections

accessing 111, 356
closing 112

Internet Explorer Mobile 149–158, 309, 
346

invoicing information 56
IR port 10, 167, 356
ISP settings 309
Italics setting 229
items

accidentally activating 289
highlighting 41, 42
moving through 41
opening shortcut menus for 45, 308, 

332, 333
selecting for Today screen 276
selecting or activating 7, 43, 46

Items page 276

J
JPEG files 187

K
Key index setting 306
keyboard

accessing alternate characters on 48
dialing from 61

displaying alternate characters list 
for 49

entering text from 48–49
locking 289, 290
scrolling with 41
selecting menu items from 44
setting key combinations for 284
specifications for 378
third-party applications and 350

keyboard backlight 47, 301
Keyguard 289
Keyguard Settings page 290
Known Caller setting 88

L
language-impaired services 93
LANs 310
large files 352
Late Breaking News & Photos 

selection 109
LCD projector 233
leading zeros 282
LED display 7
Left button (navigator) 40
Legacy Pocket Word files 225
lens (camera) 8
liability 2
libraries (media) 194
Library command 192, 193, 194
Library list 192



Index 399

In
dex

Library screen 192, 198
light. See indicator light
Li-Ion battery 357

See also battery
links

freeing internal memory and 352
media files and 194
selecting or activating 42
text messages and 127
troubleshooting 347

list separators 282
List setting 230
Listen button 69
listening to

media files 85, 190
voicemail messages 69

lists
accessing 46
closing 46
creating 225, 230
formatting 229
highlighting items 41, 46
scrolling through 41
selecting items 43, 46

local area networks 310
locating

Sprint PCS Vision user names 107
locating information 53, 247, 254
Location Privacy icon 95, 101
Location Privacy setting 95

location-specific information 95, 282, 
295, 298

lock codes 20, 289, 291
Lock icon 150, 180
locking

spreadsheet rows and columns 240
the keyboard 289, 290
Treo smart device 289, 291

logging in to
corporate servers 310
secure Websites 297

Long tones setting 90
lookup feature 61, 254
losing

information 321
passwords 292, 293
Treo smart device 35, 294

low coverage areas 328
low lighting conditions 47
lowercase letters 48

M
magnification. See zoom settings
mail servers 310, 345
main menus 44
Make this device discoverable 

setting 164
Manage existing connections 

setting 311
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Manage GPS automatically check 
box 299

maps 56, 110, 298, 346
margins 230
Match case box 227, 247
Match whole words only check box 227, 

247
maximizing battery life 15
measurement units 282
media files

creating playlists for 195
formats for 190
linking to 194
playing 192
transferring 191, 194
updating 194

media libraries 194
Media Player Mobile

customizing 197
overview 190
starting 192, 198

media players 15
meeting requests 126, 209, 213
memory buttons 222
Memory page 157
Memory Settings page 299
memory usage 299
memory, freeing 261, 352
memos. See messages; notes
Menu button 44

menu items, selecting 44, 45
menus 44, 45, 308, 332, 333
Menus page 284
Message page 133
messages

See also multimedia messages; text 
messages; voice notes

adding signatures 132
addressing 128
creating email 123
deleting 131, 132, 133
dialing from 64
displaying status of 131
forwarding 127
invalid characters and 129
listening to 69
phone calls and 72
rearranging 131
receiving notifications for 129, 331
saving as drafts 124
selecting multiple 131

messaging
troubleshooting 331

Messaging application
accessing 123, 128
adding contacts and 203
customizing 133
freeing internal memory and 352
overview 116

messaging applications 350
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Messaging icon 128
Messaging list 132
messaging services 331, 358
microphone 9, 71, 186
microphone icon 286
Microsoft Excel 237
Microsoft Exchange 2003 Server

Direct Push Technology 356
Microsoft Exchange Server. See Exchange 

Server
Microsoft Outlook. See Outlook
microwaves 166
mirror 8
Missed call setting 88
mobile accounts 55, 291
Mobile Broadband Network 357
mobile devices

getting help with 55
mobile networks 328
mobile phone numbers 203
Mobile to Market certificates 257
model numbers 375
modems 111–113, 356, 357
Modify Sheets command 245
monitoring signal strength 99
Month View (calendar) 206
most recently dialed numbers list 65
mouthpiece 9
moving

documents to folders 231

information 271, 272
pictures and videos 182
speed dial buttons 83
text 228
workbooks 248

moving around the screen 40–42
MP3 files 190
MSN Hotmail 136
MSN Messenger Contacts list 136
Multi-connector port 9
MultiMediaCard expansion cards 268
MultiMediaCards 10
multi-phone accounts 25
Multiple Networks Detected dialog 

box 304
multiple recipients 129
music 68, 89, 191, 192

See also media files
Mute 71
My Device folder 255
My Documents folder 254
My Mobile Devices folder 357
My Pictures folder 175, 177
My Playlists category 195
My Text command 124, 129
My Text phrases 124, 128, 129

N
names 358

Sprint PCS Vision accounts and 107
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naming
document files 226, 228, 231
folders 231
groups of pictures 186
speed dial buttons 80
workbooks 238, 248
worksheets 243

Nationwide Sprint PCS Network 96
navigating the screen 40–42
navigator 7
navigator. See 5-way navigator
negative numbers 282
Network Cards icon 305, 308
network connections 96, 303, 328–332
Network Key page 306
Network key setting 306
Network page 197
Network Selection pick list 97
New Appointment command 207
New Network Detected dialog box 304
New Sound command 89
New Speed Dial command 80
news information 109
No Service message 99
notes

adding tasks and 215
creating 217, 218
entering contacts and 202
removing 220
saving 220

Notes application 217, 220
Notes icon 217
Notes list 219
Notes page 202
notification screens 69, 75, 129
notifications

Bluetooth devices and 164
displaying on screen 280
downloading sounds 87
messages and 129, 331
previewing ringtones 88
selecting 279
setting ringtones for 87
silencing sounds for 278
voicemail and 69

Notifications check box 279
Notifications page 87, 280
Now Playing playlist 195
Now Playing screen 195
number pad 21
Number page 282
number sign symbol 282
numbered lists 230
numbers

See also phone numbers
entering 48, 221
formatting 236, 242, 282

O
Off Hold button 71



Index 403

In
dex

offline synchronization 336, 337
Off-peak times setting 265
OK button 6, 7
On Demand categories 110
On Demand feature 108–110
On Demand icon 108, 109, 110
On Demand screen 109, 110
On Demand Service 108
on-device help. See help
one-touch message access 24
online address book 133, 145
online forums 55
online services 106
online support 55
open networks 303, 305
opening

applications 51, 270, 358
attachments 125
calculator 221
characters list 49
Dial Pad 65
documents 226
File Explorer 112, 255, 258, 273
Help screen 55
items in folders 255
Outlook folders 336
Phone Settings screen 22
Quick Tour 55
shortcut menus 45, 308, 332, 333
templates 239

Today screen 60
Web pages 149, 153, 346

operating system (Treo smart 
device) 318, 377

operating systems (PCs) 31
operating temperatures 379
Operator Services 57
Option button 41, 357
Option key 47, 49
Option Lock 49
optional passwords 25
options 45, 46, 56, 211
Options page 288
organizer features 15
orientation (slides) 234
Orientation page 234
Outbox 124, 131
Outlook

accessing 135
accessing folders for 336
client software and 344
downloading from 126
entering appointments in 207
entering contacts in 202
installing drivers for 319
synchronizing with 147

overdue tasks 215
owner information 294
Owner Information page 294
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P
page breaks 225
paired relationships. See partnerships
Palm Desktop software

installing 5
Palm Powered devices 34, 318
Paragraph command 229
paragraph formatting 229
Partial battery icon 15
partnerships

defined 357
passkeys 162
Password Settings page 292
passwords 121, 142, 289, 292

accessing voicemail and 24
changing 25
creating 24, 25

Paste command 156, 182, 221
patches 261
patterns in workbooks 236
PCs

connecting to 33, 111
PCS service plans. See Sprint PCS Vision 

accounts
PCS Voice Command service. See Sprint 

PCS Voice Command service
PCs. See computers
Peak times setting 265
performance 325
personal accounts 25, 56

personal address book 78
personal information 25, 292, 294, 356
personal information manager 336
Personal setting 211
Personal Settings page 87, 276, 277, 284, 

285, 294
phone

See also phone calls; smart device
accessing directory assistance for 57
accessing operator assistance for 57
adjusting volume 21, 89
advanced features 74–77
answering 24, 67, 75
customizing 87
dialing preferences for 91
disabling touch-sensitive feature 

for 289
downloading ringtones for 87
enabling as modem 111–113
getting forwarding codes for 77
hanging up 7, 72, 74
Internet connections and 113
not activated 20
overview 60, 61
previewing ringtones 88
roaming and 96–98
running applications and 71, 72
silencing ringer 67, 278
specifications for 377
TTY devices for 93
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turning off 21
turning on and off 7, 18
waking up screen for 71

Phone application
opening 7

phone as modem features 357
Phone button 7
phone calls

emergency services for 94
ending 72, 74
entering extra digits for 70, 81
forwarding 76
hands-free devices and 160
making 61, 71, 74, 78
placing on hold 71
receiving 24, 67, 71
sending to voicemail 67
setting ringtones for 87
setting up conference sessions for 75
troubleshooting 331

Phone dialog box 64
phone headset 84–85
phone headsets 9
phone lock feature 289, 291
phone numbers

adding to messages 129
assigning prefix to 91
assigning to speed dial buttons 80
checking 22
copying 65, 66

dialing 21, 61–66, 74, 81
entering manually 66
redialing most recent 65
saving 72–73
selecting 43

Phone Off
357

Phone Off message 99
Phone Settings page 70, 90, 94, 95, 97
Phone Settings screen 22
Phone/Talk button 6, 21, 357
Phone/Talk icon 61
phone-off icon 18
phone-to-computer connections 111
picture files 187
picture speed dial buttons 63, 80
pictures

as backgrounds 183, 276
as screensaver 185
assigning to contacts 89
changing resolution 176, 184, 349
creating caller ID 202
defaults for 174
deleting 184
editing 184
naming groups of 186
on phone without camera 174
organizing 182
previewing 349
saving 186
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sending 180
setting default size 186
taking 8, 175–176
troubleshooting 348
viewing 179, 187

Pictures & Videos application 175, 177
PIM applications 336, 356, 357
Play button 192
Play Slide Show command 179
Play sound check box 280
Play Sound list 296
playback icons 82, 192
Playback page 197, 234
Playback screen 197
playback, ending 193
playing

media files 192
presentations 233, 235
sounds 89, 186
voice notes 218
voicemail messages 69

playlist files 191
playlists 191, 195
PNG files 187
Pocket MSN application 136
POP accounts 117, 120
ports 10
ports. See IR port; USB ports
power adapter 9, 13, 313
Power Settings page 300, 302

power sources 14
Power/End button 6, 7
PowerPoint Mobile application 233–235
PowerPoint Mobile icon 233
precautions iii, 9, 374
preferences

dialing 91
roaming 97

preferences, setting. See customizing
prefixes (phone numbers) 91
Premium Services 25
Preparing Vision Services dialog box 106
presentations 233, 234

See also PowerPoint Mobile application
previewing

pictures 349
sounds 88, 280

priority levels 214
Priority list 124
privacy settings 95
private appointments or events 210
Private setting 210
processor 377
Program Buttons page 284
Programs check box 279
Programs page (GPS Settings) 299
Programs screen 51
programs. See applications; software
projectors 233
protected spreadsheets 237
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protecting
expansion card slot 268
information 289
Treo 700 smart device 289–294

protecting personal information 25
proxy servers 311
PSAPs (public safety answering 

points) 94
public safety answering points 94
punctuation marks 48
purchasing accessories 313
purchasing batteries 12
purchasing Premium Services 25
push

Direct Push Technology 356
push synchronization 135

Q
Quality command 178
Quick Keys 63, 80
Quick Tour 55
quitting applications 52, 300

R
radio 377
RAS connections 309
reassigning buttons 7
Receive all incoming beams check 

box 164

receiving
attachments 125
beamed information 168
email 343
meeting requests 126
text messages 129

Receiving Data message 168
receiving phone calls 24
rechargeable battery. See battery
recipients, sending to multiple 129
Record button 220
recording

ringtones 89
videos 177–178
voice notes 218, 288

recording toolbar 218
records 168
recurring appointments. See repeating 

appointments
redialing phone 65
redirector (Websites) 346
Region page 282
regional settings 282, 295
Regional Settings page 282
regulatory numbers 375
reminders

events and 209, 213
system alarms and 296
tasks and 215, 216
turning on and off 279
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remote access server 309
remote synchronization 263
Remove Programs icon 261
Remove Programs page 261
removing

applications 261, 352
Bluetooth connections 163
certificates 297
contacts 204
directory services 146
documents 232
events 212
expansion cards 269
favorites links 154
files 256
items from folders 255
items from playlists 195
messages 131, 132, 133
notes 220
pictures 184
sounds 89
speed dial buttons 83
tasks 216
text 43
workbooks 249
worksheets 250

Rename command 273
Rename/Move command 227, 231, 239, 

248, 271

renaming
documents 231
expansion cards 273
items in folders 255
workbooks 248
worksheets 245

Repeat check box 280
Repeat command 193
repeat patterns 208
repeating appointments 208
repeating current song 192
repeating sounds 280
repeating tasks 215
Replace All setting 227, 248
replacement stylus 313
replacing

information 247
text 227
the battery 323

replacing batteries 12, 313
reset button 320
resetting Treo 700 smart device 292, 320, 

321
resolution 174, 349
Resolution command 176
restoring information 322
restoring sound settings 279
retrieving voicemail 70
Return key 47
reverse type 43
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revision marks 225
Right button (navigator) 40
right-click menus 45
Ring tone list 88
Ring type list 88
ringer

adjusting volume 7
ringer switch 10, 278
ringer volume 89
ringer, silencing 67, 278
ringtone IDs 89
ringtone managers 350
ringtones

assigning to contacts 81, 89, 181, 202
creating video 181
downloading 87
previewing 88
selecting 87
silencing 278

roaming 88, 96, 98, 265
Roaming icon 96
Roaming message 99
Roaming Preferences command 97
Roaming Preferences screen 97
Roaming setting 88
ROM updates 318
rotating pictures 184, 185
Running Programs screen 52, 300

S
safety guidelines 361
safety information iii
Save As command 228
Save password check box 121, 141
Save to Contact Ring Tone 

command 181
Save to Drafts command 124
Save to list 271
saving

documents 226, 228, 232
information 271
notes 220, 288
phone numbers 72–73
pictures and videos 186
workbooks 236, 238, 250

Schedule command 265
schedules

adding items to 207, 208, 210, 214
managing 207–212
organizing events for 211
removing events 212
removing tasks 216
sorting tasks on 216
unavailable time on 211
viewing daily 206

scheduling synchronization 265
screen

accessories for 327
activating items on 7, 43
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adjusting brightness 281
aligning 283
backgrounds for 183, 276
disabling touch-sensitivity for 289
moving around on 40–42
selecting items on 7, 43
setting appearance of 276, 283
troubleshooting 326
turning off 16, 300
turning on and off 7
waking up 19, 71

Screen taps check box 279
screens, returning to previous 42
screensavers 185
scroll arrows 41
scroll bar 42
scrolling 41, 211, 234, 288
SD cards 10
SD expansion cards 268
SDIO cards 10
SDIO expansion cards 268
Search dialog box 254
search engine settings 277
Search for list 256
Search icon 254
Search page 277
searching

documents 227
spreadsheets 247
Web pages 53, 150

searching for files 254, 256
searching for information 53, 227, 247, 

254
searching for signal 16
Secure Digital cards 10
secure Websites 297, 347
security 289–294, 297
security certificates 152
Security page 158
security software 289
self-portrait mirror 8, 175
Send outgoing items… setting 265
Send Sound command 89
sending

copyrighted items 180
email 124, 343
meeting requests 210, 213
pictures 180
text messages 67, 129
videos 180

Sent folder 133
serial numbers 375
Service Pack 2 356
service plans 5
Services page 70, 94, 95, 97
Set as Today Background command 183
setting alarm clock 296
sheet list 240
Shift key 47, 48
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Short Messaging Service. See SMS 
messaging

Short tones setting 90
shortcut icons 51
shortcut menus 45
Show alphabetical index setting 204
Show Biz selection 110
Show contact names only setting 204
Show list 179
Show Options command 234
Shuffle command 193
Side button 7
side button 6
signal

monitoring strength 99
sending and receiving 10

signal, searching for 16
signal strength 99, 328
signal-strength icon 18, 302
signatures 132
silencing all sounds 278
silencing ringer 67, 278
silent alarm 278, 280
single carrier radio transmission 329
Size setting 229
sketching 217
Skins page 198
Skip Pass Code feature 24
Slide Show page 185
slide show toolbar 179

slide shows 179, 185, 235
slide timings setting 235
slider 42
slides 179
smart device

See also Treo 700 smart device
caution for resetting 321
charging 12
disabling touch-sensitivity for 289
freeing space on 261, 352
getting help with 55
locking 289, 291
losing 35, 294
low light and 47
monitoring status 99–102
not responding 320, 350
not turning on 329
third-party applications and 349, 350
unlocking 291, 292

smart device. See Treo smart device
SMS messaging 116, 358
soft resets 12, 320
softkeys 6
software 5

See also applications
hard resets and 321
included with smart device 378

Software Installation 5, 28, 29, 32, 111, 
140, 201, 214, 217, 257, 319, 334, 335, 
336, 337
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songs. See music
Sort by list 245, 255
Sort command 245
sorting

folder items 231, 248, 255
History list items 156
information 245
pictures and videos 182
tasks 216

Sound Mode positions 278
sounds

changing alarm 296
customizing system 278
playing 89, 186
previewing 88, 280
recording 89
selecting 279
setting Dialpad 90
setting ringtone 87
turning off 278, 280

Sounds & Notifications page 87, 279
Sounds page 279
SP2 356
Space key 47
spare battery 12
speaker 7, 9, 190
speakerphone 9, 71
speakers 7
special characters. See alternate 

characters

special occasions 208
specifications 377
speech-impaired services 93
speed dial buttons 63, 80–83
Speed Dial Options command 83
Spell Check command 124, 129
spell-checking 124, 129, 230
Spelling command 230
split bar 240
Sports selection 110
spreadsheet templates 236, 239, 250
spreadsheets

See also Excel Mobile application; 
workbooks

changing order of worksheets 243
creating 236
displaying 236, 237
entering data in 238, 242
filtering in 245
searching 247
sorting in 245

Sprint 411 57
Sprint Customer Service 25, 55, 291
Sprint PCS Accessory Hotline 313
Sprint PCS Connection Manager 111
Sprint PCS Operator Services 57
Sprint PCS Service 17
Sprint PCS Service Plan 106
Sprint PCS Vision 358
Sprint PCS Vision accounts 25, 96, 106
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Sprint PCS Vision data networks 330
Sprint PCS Vision home page 106
Sprint PCS Vision icons 329
Sprint PCS Vision Service 107
Sprint PCS Vision user names 107
Sprint PCS Voice Command service 78–

79, 96
Sprint PCS Web page 56
Sprint status message 99
Sprint Web page 55
SSID 358
Start button 6, 7, 51
Start menu 51, 284, 358
starting

Calendar application 206
Contacts application 202
data connections 311
Excel Mobile 238
Internet Explorer 106, 150
Media Player Mobile 192, 198
Notes application 217
Pictures & Videos application 175, 

177
PowerPoint Mobile 233
Quick Tour 55
synchronization 264
Tasks application 108, 109, 110, 214
Word Mobile 226

static 373–374
status icons 131

status icons (phone) 99
status information 7, 99
stereo adapters 85, 190
stereo headphones 190
stereo headsets 9
Still image compression level setting 186
stock ticker 110
Stocks selection 110
Stop command 193
stopping playback 193
stopping synchronization 264
Storage Card page 272, 299
Storage Card setting 270, 271
storage card symbol 256
storage cards. See expansion cards
Storage page 134
storage temperatures 379
storing

applications 352
attachments 126, 134
document files 228
information 268, 352
passwords 142
workbooks 248

Strikethrough setting 229
stylus 10, 313
sub-account passwords 25
support 25, 56
support information 55
Symbol command 238
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symbols 48, 81, 238
sync cable 34, 335
sync conflicts 142
sync connector 9
Sync Setup Wizard 263
synchronization

scheduling 265
setting options for 262
starting 264
troubleshooting 320, 334–338, 344

synchronization icons 35
synchronization software 28, 35, 139
synchronizing

dates and time 338
email accounts 124
information 27, 265, 334
offline 336, 337
over Bluetooth connections 165
over infrared connections 169
playlists 191
remotely 263
Web files 157
wirelessly 160
with Exchange Server 29, 262
with multiple computers 263

synchronizing email 117, 135
system alarms 296
system errors 329
system locks 289, 292
system requirements 31, 378

System Settings page 282, 283, 297, 298, 
299

system sounds 278
system warnings 279

T
tables in documents 225
tabs, scrolling through 41
taking pictures 8, 175–176, 348
tapping 10, 40, 43, 279, 327
tasks

adding 214
deleting 216
displaying 216
marking as completed 215
marking as sensitive 215
setting reminders for 215, 216

Tasks application
customizing 216
filtering options for 216
starting 108, 109, 110, 214
synchronizing with 30

Tasks entry bar 215, 216
Tasks icon 214
Tasks list 216
TDD devices 93
technical assistance 55, 351
technical support 25, 56
telecommunications devices 93
temperature range 379
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templates
documents 226, 232
spreadsheets 236, 239, 250

temporal key integrity protocol 
(TKIP) 306

tentative appointments 207
text

aligning 230
changing 227, 239
copying 156
correcting 124, 129, 230
deleting 43
entering 48–49, 287
finding and replacing 227
formatting 229
highlighting 43, 229
moving or copying 228
resizing 281
searching for 53, 227
selecting 43
word-processing features for 224

text fields 41
text messages

See also messages
addressing 128
creating 128
links in 127
phone numbers in 64
receiving 129
sending 67, 129

troubleshooting 331
Text Size page 281
Text Speed Dial button 81
text speed dial buttons 63, 80
Text Telephone devices 93
themes 276, 283
third-party applications

5-way navigator and 40, 350
accessing Outlook folders and 336
freeing internal memory and 352
getting help with 259
installing 257
losing 321
synchronizing information and 36, 

319
troubleshooting 321, 349, 350

third-party phone calls 57
third-party vendors 36, 319
Thumbnail View 176, 178
Thumbnails button 178
time formats 282
Time page 282, 295
time settings 295
time zones 295
Today screen 53, 60, 357

customizing 183, 276–277
Today Settings page 276, 277
tones. See ringtones; sounds
top view (device) 10
touchscreen. See screen
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touchscreen lockout 289, 290
touch-sensitive feature 289
transferring

information 318, 356
media files 191, 194

transferring calls to voicemail 24
transition effects (slides) 234
Transparency level list 183
travel adapters 313
Treo 700 device

features of 55
online support for 55
specifications for 377

Treo 700 smart device
See also smart device
compatibility with third-party 

vendors 36, 319
resetting 292, 320, 321
turning on and off 18

Treo smart device
activating 5, 20
as wireless modem 356
components on 6, 8, 10
components shipped 4
connecting to power sources 13
monitoring status of 99–102
setting up service for 17, 25

troubleshooting 317
trusted devices. See partnerships
trusted pairs. See partnerships

TTY devices 90, 93, 94
TTY/TDD settings 90, 93
Turn on Bluetooth check box 161
turning keyboard backlight on and off 47
turning off beeps and alarms 10
turning off call forwarding 77
turning off screen 16, 300
turning off system sounds 278
turning on alarms 296
turning on indicator light 14
turning phone on and off 18
TV Guide 110
Typing mode 220

U
unanswered calls 24
unauthorized users 24, 291, 297
unavailable connections 330
unavailable time slots 211
underlining text 225, 229
Unknown Caller setting 88
unlocking

smart device 291, 292
spreadsheet rows and columns 240

unread messages 131
unretrieved voicemail 69
untimed events 208
Up button (navigator) 40
Update Library command 194
updates (smart device) 56
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updating
information 27, 355
media files 194
operating system 318

uppercase letters 48, 288
URLs 193, 233
USB connector 9
USB docking cradle 313
USB hub 335
USB ports 34, 335
USB sync cable 9, 33, 34, 313, 335
Use above settings while roaming 

setting 265
user discussion groups 55
user names

Sprint PCS Vision accounts and 107
usernames 358

V
vCal attachments 344
vCard attachments 344
vehicle power adapter 313
Vibrate when… check boxes 88, 280
vibrating alarm 278, 280
video files 187
Video Mode command 177
Video page 186, 197
video ringtones 181
videos

adding sounds 186

adjusting volume for 89
changing resolution 178, 349
defaults for 177
limiting length 186
on phones without camera 174
organizing 182
recording 177–178
saving 186
sending 180
viewing 179, 187

View Recording Toolbar command 218
viewing

alternate characters 49
animated images 187
appointments 206
available applications 51
calendar 206
contacts 62, 203
daily schedules 206
documents 225
events 208, 211
items in folders 231, 248
memory usage 299
menus 44
notifications 280
pictures 179, 187
power settings 300
space on expansion cards 272, 299
spreadsheets 236, 237
status information 7, 99
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tasks 216
videos 179, 187
Web pages 150, 156
wireless settings 302

virtual private networks. See VPN 
connections

Voice Command buttons 286
Voice Command service. See Sprint PCS 

Voice Command service
voice mail buttons 82
Voice mail setting 88
voice notes 218, 288
voice privacy icon 101
Voice Privacy setting 95
voice quality 353
voice recording formats 288
voicemail

accessing 24
customizing 82
entering passwords for 24
getting help with 56
playing 69
roaming and 96
sending calls to 67
setting ringtones for 88
setting up 24, 69
troubleshooting 90

voicemail account 24, 25
voicemail controls 82
Voicemail icon 69

Voicemail Pass Code feature 24
voicemail systems 24, 69
volume

device ringer 7
Volume button 6, 7, 89
volume, adjusting 21, 89
VP icon 101
VPN clients 310
VPN connections 126, 310–311

W
waking up screen 19, 71
wallpaper 174
warnings iii, 9, 279
Weather selection 110
Web browsing 150, 152
Web links. See links
Web pages

accessing 149, 153, 346
clearing links to 352
copying from 156
dialing from 64
display options for 150
downloading items from 155, 258
playing media files from 193
returning to recently viewed 152, 156
searching 53, 150
security settings for 158
setting as home 157
signing onto Sprint PCS 56
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troubleshooting 346
viewing 150, 156

Web search field 53, 150
Web-based email 117

See also Internet connections
Websites

connecting to 149
ending connections 312
logging into secure 297
problems accessing secure 347

Week View (calendar) 206
WEP networks 306
Wi-Fi access point 358
Wi-Fi connections 303–308
Wi-Fi icon 305
Wi-Fi network cards 268
Wi-Fi routers 166
Wi-Fi SDIO cards 303
Windows Media Player. See Media Player 

Mobile
Windows Mobile 358
wireless features 15, 302
wireless modems 356
wireless networks 303, 305
Wireless page 302
wireless phones 166
wireless synchronization 160
WLANs. See wireless networks
WMA files 190
WMV files 187, 190

Word Completion page 287
word matching 227, 247
Word Mobile application 224–232
Word Mobile icon 226
word-processing features 224, 225
workbook list 238, 250
workbooks

See also Excel Mobile application; 
spreadsheets

adding calculations 240
adding cells, rows, and columns 242
adding charts 246, 247
adjusting column and row size 244
creating 238
defining filters for 246
deleting 249
display options for 239
formatting options for 243–244
formulas in 241, 249
functions in 241
moving around in 240
naming 238, 248
organizing 248
removing cells, rows, and 

columns 249
replacing information in 247
saving 236, 238, 250
searching 247
setting default template for 250

worksheet names 237
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worksheets 240, 243, 245, 250
See also spreadsheets; workbooks

WPA networks 306
WPA-PSK connections 306
Writing mode 220

Y
Year View (calendar) 206

Z
ZIP codes 108
ZIP files 257
Zoom command 176
zoom icons (camera) 176
zoom icons (presentations) 234
Zoom In command 234
zoom settings 237, 239, 288


	Treo 700wx by Palm User Guide
	Section 1: Setting Up Your Smart Device and Your Computer 1
	1A. Setting Up Your Treo™ 700wx Smart Device 3
	1B. Setting Up Service 17
	1C. Synchronizing Information-The Basics 27

	Section 2: Your Treo™ 700wx Smart Device 37
	2A. Learning the Basics of Your Smart Device 39
	2B. Using Your Device’s Phone Features 59

	Section 3: Using Sprint PCS Vision and Other Wireless Connections 103
	3A. Sprint PCS Vision-The Basics 105
	3B. Using Email and Messaging 115
	3C. Using Exchange ActiveSync 139
	3D. Browsing the Web 149
	3E. Using Infrared and Bluetooth® Wireless Technology 159

	Section 4: Your Portable Media Device 171
	4A. Working With Your Pictures and Videos 173
	4B. Windows Media Player Mobile 189

	Section 5: Your Mobile Organizer 199
	5A. Using Your Device’s Organizer Features 201
	5B. Increasing Your Productivity 223

	Section 6: Managing Your Information and Settings 251
	6A. Managing Files and Applications 253
	6B. Customizing Your Smart Device 275

	Section 7: Resources 315
	7A. Help 317
	7B. Glossary 355

	Section 8: Safety and Specifications 359
	8A. Important Safety Information 361
	8B. Specifications 377


	Welcome to Sprint
	How to Use This Guide
	Setting Up Your Treo™ 700wx Smart Device
	What You Need
	Your New Treo 700wx Smart Device
	Inserting the Battery
	Charging the Battery

	Setting Up Service
	Turning Your Smart Device On/Off
	Making Your First Call
	Setting Up Your Voicemail
	Creating Sprint PCS Account Passwords

	Synchronizing Information-The Basics
	Synchronization Methods
	Installing the Desktop Synchronization Software
	Connecting Your Treo Device to Your Computer (USB)
	Synchronizing With a USB Connection
	Synchronizing With Third-Party Applications

	Learning the Basics of Your Smart Device
	Moving Around the Screen
	Using the Keyboard
	Opening and Closing Applications
	Using Your Today Screen
	Where to Learn More

	Using Your Device’s Phone Features
	Phone Overview
	Making Calls
	Receiving Calls
	Using Voicemail
	Managing Active Calls
	More Ways to Manage Calls
	Using Sprint PCS Voice Command
	Defining Speed Dial Buttons
	Using a Phone Headset
	Customizing Phone Settings
	Controlling Your Roaming Experience
	Checking Signal Strength and Phone Status

	Sprint PCS Vision-The Basics
	Getting Started With Sprint PCS Vision
	Accessing Sprint PCS Vision
	Personalizing Your Service With On Demand
	Using Your Device’s Phone as a Modem

	Using Email and Messaging
	About Email and Messaging
	Getting Started With Email
	Which Email Application Should I Use?

	Setting Up an IMAP or POP Email Account
	How Do I Get Started?

	Sending and Receiving Email
	Sending and Receiving Text Messages
	Managing Your Messages
	Customizing Your Messaging Settings
	Using GoodLink™ Wireless Messaging
	Using Pocket MSN

	Using Exchange ActiveSync
	Setting Up an Exchange Server Account
	Setting a Sync Schedule With an Exchange Server
	Using an On-line Address Book

	Browsing the Web
	Viewing a Web Page
	Working With Favorites
	Working With Web Pages
	Customizing Your Internet Explorer Mobile Settings

	Using Infrared and Bluetooth® Wireless Technology
	Connecting to Devices With Bluetooth® Wireless Technology
	Beaming Information With IR

	Working With Your Pictures and Videos
	Taking Pictures and Videos
	Viewing a Picture or Video
	Sending a Picture or Video
	Creating a Video Ringtone
	Organizing Pictures and Videos
	Using a Picture as the Today Screen Background
	Editing a Picture
	Customizing Your Camera Settings
	Viewing Pictures and Videos on Your Computer

	Windows Media Player Mobile
	Transferring Media Files to Your Smart Device
	Playing Media Files on Your Smart Device
	Working With Libraries
	Working With Playlists
	Customizing Windows Media Player Mobile

	Using Your Device’s Organizer Features
	Contacts
	Calendar
	Tasks
	Notes
	Calculator

	Increasing Your Productivity
	Word Mobile
	PowerPoint Mobile
	Excel Mobile

	Managing Files and Applications
	Using Find
	Installing Applications
	Removing Applications
	Setting Synchronization Options
	Sharing Information
	Using Expansion Cards

	Customizing Your Smart Device
	Today Screen Settings
	System Sound Settings
	Display and Appearance Settings
	Application Settings
	Locking Your Smart Device and Information
	Entering Owner Information
	System Settings
	Connection Settings
	Managing ISP Settings
	Connecting to a VPN
	Purchasing Accessories for Your Device

	Help
	Transferring Information From Another Device
	Trouble Installing the Desktop Software?
	Resetting Your Smart Device
	Performance
	Screen
	Network Connection
	Synchronization (ActiveSync® Software)
	Email
	Web
	Camera
	Third-Party Applications
	Making Room on Your Smart Device
	Voice Quality

	Glossary
	Important Safety Information
	General Precautions
	Maintaining Safe Use of and Access to Your Device
	Using Your Phone With a Hearing Aid Device
	Caring for the Battery
	Radiofrequency (RF) Energy
	Static Electricity, ESD, and Your Device
	Owner’s Record
	User’s Guide Proprietary Notice

	Specifications
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


